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1 Introduction

Welcome to DigiTerra Explorer Reference Guide

This Reference Guide is designed to be an in-depth resource regarding DigiTerra™ Explorer. It
provides a description of the DigiTerra™ Explorer tools, commands, paneles and context menus. It
also includes information about supported data formats and detailed information about supported
projections. This guide is a comprehensive documentation for

o Field staffs who use DigiTerra Explorer to do their daily job

o GIS professionals who prepare data for field staffs through customization and data preparation

to define the 
o Dedicated reseller partners who wish to customize DigiTerra Explorer to a specific

application for their clients

About DigiTerra Explorer

DigiTerra Explorer is a mobile mapping and an entry-level GIS software. Helps you in data collection
and updating existing data in the field work with the high performance.

o Windows based (standalone out-of-the-box) field mapping and data collection software not only

for GIS professionals
o Supports many mobile devices and handhelds

o Displays a variety of vector, raster and tabular data

o Native read/write support for industry-standard vector layer formats (SHP, MIF, DXF, DGN, BNA)

o Read of CADRG, MrSID, ECW, JP2, geoTIFF and other various raster data

o Read/write support for SQLite file geodatabases

o WMS (Web Map Services) support for consuming online datasources

o Integrated Dropbox client

o GPS/GNSS receiver and other external sensors integration: laser rangefinders, external/built-in

cameras, cable locators
o On-the-fly datum conversion from GPS input to the projected map view, database of 16000

projections can be expanded by user
o Rich GIS toolbox to maintain and verify existing data

o Advanced capabilities to run data analysis & make better decisions

o Can be customized without programming (code dictionary, menus, unique data capture forms,

data field default values)
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2 Getting Started

In this topic you can learn about the followings:

System requirements
Installation
o Mobile

o Desktop

Software update
Registration

2.1 System requirements

DigiTerra Explorer 7 Mobile version

Recommended minimum hardware
Operating system
o Windows Mobile® version 5.x or newer

o Windows® Embedded Handheld 6.x

Processor type: ARM, XScale, or OMAP
Processor speed: 400 MHz or faster
Memory: 32 MB RAM
Input/output
o SD Card / micro SD card slot

o USB port

Display
o Color touch screen (240 x 320 pixels or larger),

o Suitable for outdoor viewing
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DigiTerra Explorer 7 Desktop version

Required Software components
Dropbox desktop client: https://www.dropbox.com/downloading?os=win
Microsoft ActiveSync 4.5: http://www.microsoft.com/en-us/download/details.aspx?id=15
or
Mobile Device Center 6.1
o http://www.microsoft.com/en-us/download/details.aspx?id=14 - 32-bit

o http://www.microsoft.com/en-us/download/details.aspx?id=3182 - 64-bit

Microsoft .NET Framework 4.5: http://www.microsoft.com/en-us/download/details.aspx?
id=30653
Microsoft .NET Framework 3.5 (Windows XP): http://www.microsoft.com/en-us/download/
details.aspx?id=21
Run As compatibility on Windows XP: http://support.microsoft.com/kb/294676

Supported Operating Systems
o Windows 8, Pro, Enterprise, Home Premium (32-bit and 64-bit)

o Windows 7 Ultimate, Enterprise, Professional, Home Premium (32-bit and 64-bit SP1)

o Windows Vista (32-bit and 64-bit)

o Windows XP Professional Edition (32-bit SP3 and 64-bit SP2)

2.2 Installation

The current topic describes the installation of DigiTerra Explorer, with specific steps for installation
on SD Card, with CAB file and on the Desktop computer. This guide is divided into two parts -
included here as a single complete reference.

1. "Mobile" topic documents the necessary steps to install the software on SD Card from a ZIP
archive and directly to the mobile device from CAB file

2. The second part of the installation topic continues with steps for installing DigiTerra Explorer on
the Desktop.

For information on upgrades, please also refer to Online software update topic.

2.2.1 Mobile

This topic contains information relevant to SD Card and CAB file based installation scenarios.
Installing DigiTerra Explorer is only a few-step process.

System Requirements

Please see the topic "System Requirements" for the Mobile requirements to run DigiTerra Explorer.

Complete the following steps to install or manually
update the software

https://www.dropbox.com/downloading?os=win
http://www.microsoft.com/en-us/download/details.aspx?id=15
http://www.microsoft.com/en-us/download/details.aspx?id=14
http://www.microsoft.com/en-us/download/details.aspx?id=3182
http://www.microsoft.com/en-us/download/details.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=30653
http://www.microsoft.com/en-us/download/details.aspx?id=21
http://www.microsoft.com/en-us/download/details.aspx?id=21
http://support.microsoft.com/kb/294676
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on the SD Card

1. Download and unpack "DigiTerra Explorer 7 Mobile for SD Card" ZIP file: 
DTEXPV7MobilePack.zip

2. Then copy it into root of an empty SD Card; in case of updating manually your SD Card you must
overwrite all existing files on it

3. Find Autorun.exe in the "\\SD Card\2577" folder and tap on it to start the installation
4. Wait until DigiTerra Explorer configuring itself, then press OK and follow the instructions on the

screen
5. Once the installation will be completed you may be start the application with its shortcut on the

Today panel or among the Programs

DigiTerra Explorer 7 Mobile for SD Card: http://digiterraexplorer.com/
downloads/DTEXPV7MobilePack.zip

from CAB file

1. Download "DigiTerra Explorer 7 Mobile CAB installer" CAB file: DTEXPV7MobilePack.CAB
2. Copy it to your device either using Microsoft Active Sync or the new Windows Mobile Device

Center. You can pick where you want to place it.
3. After copying the file over to your device, open the folder, tap it with your stylus or hit the OK key

and it will begin the installation process. Follow the instructions that will appear.
4. Wait until DigiTerra Explorer configuring itself, then press OK and follow the instructions on the

screen
5. Once the installation will be completed you may be start the application with its shortcut on the

Today panel or among the Programs

DigiTerra Explorer 7 Mobile CAB installer: http://digiterraexplorer.com/
downloads/DTEXPV7MobilePack.CAB

When manually updating the installed software, please uninstall the previous
version first at Start menu > Settings > System > Remove Programs then you
can install the new one.

Video tutorial

Please also have a look at the installation of DigiTerra Explorer mobile version in this video tutorial

http://digiterraexplorer.com/downloads/DTEXPV7MobilePack.zip
http://digiterraexplorer.com/downloads/DTEXPV7MobilePack.zip
http://digiterraexplorer.com/downloads/DTEXPV7MobilePack.CAB
http://digiterraexplorer.com/downloads/DTEXPV7MobilePack.CAB
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below:

Installing DigiTerra Explorer 7 on
mobile

Application Shortcuts

on the Today panel

among the Programs

More details can be found about this topic at: http://forum.digiterra.hu/
viewtopic.php?f=60&t=306

2.2.2 Desktop

This topic contains information relevant to SD Card and CAB file based installation scenarios.
Installing DigiTerra Explorer is only a few-step process.

System Requirements

Please see the topic "System Requirements" for the Desktop requirements to run DigiTerra
Explorer.

Complete the following steps to install or manually
update the software

on the Desktop

http://forum.digiterra.hu/viewtopic.php?f=60&t=306
http://forum.digiterra.hu/viewtopic.php?f=60&t=306
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1. Install Microsoft ActiveSync® (for Windows XP) or Windows Mobile Device Center (for Windows
Vista or Windows 7, 8 ) on your desktop PC if you intend to use DigiTerra Explorer on a

Desktop computer as a registered1 software via the Mobile software. Installation of the
software above also required if you want to establish a synchronization connection between your
desktop PC and the Windows Mobile/Embedded handheld.

2. Download "DigiTerra Explorer 7 Desktop Installer" EXE file: DTEXPV7DesktopSetup.exe
3. Double click on the downloaded file and it will begin the installation process. Follow the

instructions that will appear.
4. Wait until DigiTerra Explorer configuring itself, then press OK and follow the instructions on the

screen
5. Once the installation will be completed you may be start the application with its shortcut on the

Desktop or in the Start menu

1 The mobile device holds the license key. You need to install and activate the software on the
mobile device prior to installing the Desktop software because the Desktop software inherits the
license from the mobile device.

DigiTerra Explorer 7 for Desktop: http://digiterraexplorer.com/downloads/
DTEXPV7DesktopSetup.exe

When manually updating the installed software, please uninstall the previous
version first at Start menu > Control Panel > Programs > Programs and Feature
> Uninstall or change a program then you can install the new one.

2.3 Software update

There are two ways to update DigiTerra Explorer

1. From the web (downloading the latest installer)
2. Using DigiTerra Explorer Software Update Service

See below for instructions on how to update.

Update from the web by downloading the latest installer

You can update DigiTerra Explorer (desktop or mobile) at any time. Visit http://digiterraexplorer.com/
free-trial to determine the current software distribution version.
 
Compare the current distribution to the version displayed on your device or desktop under the “Help
> About" dialog. If the distribution version is newer, you can download and install it using the same
method as an initial installation.

http://digiterraexplorer.com/downloads/DTEXPV7DesktopSetup.exe
http://digiterraexplorer.com/downloads/DTEXPV7DesktopSetup.exe
http://digiterraexplorer.com/free-trial
http://digiterraexplorer.com/free-trial


14 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

Using DigiTerra Explorer Software Update Service

The Software Update Service will check DigiTerra web service for updates, check the version and
then compare this information to DigiTerra web service to see if there is a newer release.

You can use the built-in DigiTerra Explorer Software Update service to look for and install updates on
your device. To get started, simply connect your device to the Internet and open Settings > System
tab to check the status of the service. If the [ ] Automatically check for updates at startup
checked DigiTerra Explorer displays a message box when a new update available. This check-box is
checked as default.

Check for updates at startup option

  

When the Software Update message box appears on the screen tap on/click on  Download & Install
now  and  follow the instructions.

Software Update message box
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Updating in progress...

All necessary information can also be found about the DigiTerra Software Update
Service at: http://forum.digiterra.hu/viewtopic.php?f=60&t=307

http://forum.digiterra.hu/viewtopic.php?f=60&t=307
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2.4 Registration

DigiTerra Explorer is a competitive, map-centric application, available in 3 editions: Basic, Advanced
and Professional. Each edition offers different functions to meet the individual needs of different user
requirements. 

When you purchase a license (Product ID) for a mobile computer essentially it means two licenses:
one for the Mobile computer and one for the Desktop. Please note that in this case the mobile
device holds the License key. So you need to install and activate the software on mobile
device prior to installing the Desktop software because the Desktop software inherits the
license from the mobile device.

DigiTerra Explorer requires Activation for full functionality. Without the activation, DigiTerra
Explorer will operate in evaluation mode and allows non time limited software access with the
following restrictions:

Disabled in the demo:

1. Export,
2. Print and
3. Report functions.
4. Projects saved in trial version cannot be opened in a fully licensed version of DigiTerra

Explorer.
5. Area calculation up to 1 hectare.

Entering a valid DigiTerra Explorer Product ID disables the limitations.

The registration process requires a valid Product ID (License key) which you
receive when you purchase DigiTerra Explorer.

SD Card based edition

If you have purchased the software on SD Card you don't need to activate the software, because it is
preactivated by DigiTerra.

In that special case when you want to activate a license (Product ID) to your own SD Card please
follow the installation process to the SD Card in the Getting Started > Installation > Mobile topic and
then you need to follow the Activation process as below. It is highly recommended to use a good
quality SD Card with the best speed that your mobile device supports. Please also keep in mind that
the, 

Please note, that the "SD Card based edition" is the only method to quickly move
the license (Product ID) from a mobile device to another one. When you installed
the software from CAB file or you are using the Desktop version and already
activated your license (Product ID) to the mobile device or to the desktop
computer the license cannot be moved to an other device. Terms and conditions:
http://www.digiterra.hu/en/purchase/terms-and-conditions.html

http://digiterraexplorer.com/compare
http://digiterraexplorer.com/compare
http://www.digiterra.hu/en/purchase/terms-and-conditions.html
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CAB file based edition

When you want to activate a DigiTerra Explorer license to the device instead of the SD Card please
note that once you have activated the license (Product ID) it will connect to that specific device (with
a unique serial number) and the license cannot be moved to an other device in this case in
accordance with Terms and conditions: http://www.digiterra.hu/en/purchase/terms-and-
conditions.html

The Activation process

The software activation process is quite straight forward. It can be also used when you accidentally
deleted the software license from the computer/handheld/SD Card. Prior to activation please make
sure that:

1. You have the Product ID,
2. Your device has an Internet connection and
3. The operating system using the current date time on the device,

anyway the activation might be failed.

To start the Activation go to

Mobile:
File menu > Help > About > License tab

Desktop:
File menu > About > License tab

Enter the Product ID and tap on/click on the Activate button.

Please note, that when you are not using a separate license for the Desktop
computer you need to install and activate the mobile device prior to installing the
desktop tool because the desktop tool inherits the license from the mobile device.

About > License tab

http://www.digiterra.hu/en/purchase/terms-and-conditions.html
http://www.digiterra.hu/en/purchase/terms-and-conditions.html
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Entered Product ID

Activated software, License tab
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Activated software, About tab

3 Workspace

DigiTerra™ Explorer offers native support for Mobile computers (Windows® Mobile OS's) and for
Desktop computers (Windows® 2000, XP, Vista, 7, 8). Therefore the workspace of the Mobile and
the Desktop version is slightly different that are described in detailed in this Reference Guide.

DigiTerra Explorer workspace contains the Menu bar, Toolbar (available in the Desktop version
only), Pan frame and the interface of the map view. You can customize the general appearance
of the workspace on the Settings panel > Map tab and by using customized Menu and Toolbar
definitions on the Settings panel > System tab.
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Mobile

Startup options - Mobile version

Parts of the workspace - Mobile version

A - Edited layer
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B - Pan frame with the most frequently used buttons

The Pan frame around the map view and its buttons

     

C - Map view
D - Quick information about the currently/last measured/captured geometry, that displays the
followings:

1. Shows the area and the perimeter of the line/polygon in current area and length units.
2. Displays the Easting and Northing coordinates of the tapped/clicked position of the map view.

E - Menu bar
F - Scale bar
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G - Shows the current GPS position when the GPS is activated.
H - Shows the Easting and Northing coordinates of the current GPS position and GPS status
information with colored GPS statuses when the GPS is activated.

Desktop

Startup options - Desktop version

Parts of the workspace - Desktop version (marked with the differences only)
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A - Menu bar
B - Toolbar
C - Shows the current version
D - Shows the purchased edition / EVALUATION mode
E - Shows the and the path of the opened map project
F - Shows the Easting and Northing coordinates of the current cursor position

3.1 Startup options

This panel accessible in the File menu > Projects sub-menu and in the toolbar (Desktop version).

Sometimes there is a need to go into the field to start capturing data as quickly and effortlessly as
possible. The Startup options panel can help you to create a “ready to use” data capture project,
providing a simple and efficient method for capturing data into new layers. It is also a useful panel if
you only want to open the recent or a custom project or even to use efficient project templates.

The Startup options dialog displays when the Settings > Map tab > Startup
project option disabled

Disabled Startup project option on the Settings > Map tab
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Startup options - Mobile version

Startup options - Desktop version
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Detailed help available on the Startup options panel in the Menu and toolbars >
File menu > Projects sub-menu > Startup topic

3.2 Workspace customization

Workspace customization

The following customization options are available in the Mobile and also in the
Desktop edition

Settings panel > Map tab

Customization options on the Settings panel > Map tab
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Full screen

Full screen mode: on/off

  

Pan frame

Pan frame: on/off
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Coordinate display

Coordinate display: on/off

  

Map grid

Map grid: on
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Night colour

Night colour = WHITE

Background colour

Background colour = BLACK
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Using customized Menu and Toolbar definitions on the Settings panel > System
tab

In DigiTerra Explorer the tool definitions are stored as menu (.MNU) and toolbar (.TBR) text files. If
your mobile GIS application only requires a subset of the commands offered in the default menu and
toolbar, or requires them presented in a different arrangement, you can modify the existing menu and
toolbar and / or create your own. You can do this using a simple text editor (e.g. Notepad) based
only built-in commands in this Reference Guide.

Menu

Selecting custom menu files on the Settings > System tab



30 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

Toolbar

Selecting custom menu and toolbar files on the Settings > System tab

4 Menu and toolbars

In the DigiTerra Explorer workspace, the menu bar is a horizontal "bar" anchored to the top of the
screen in the Desktop version and it is anchored to the bottom of the screen in the Mobile
version. On the left side, it contains the Windows® application menus (e.g. File, Edit, View...).
On the right hand side in the Mobile version it contains the Keyboard button. The toolbar is a
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horizontal "bar" anchored to the top of the screen under the menu bar, available only in the
Desktop version.

The content of the toolbar and the menu bar differs by different editions and by
available extensions. The edition-specific differences can be found in the individual
chapters. You can easily check which tools / commands are accessible in which
edition by opening the About panel > Evaluation > select an edition / extension
then tap/click on the EVALUATE button.

 Menu bar in the Mobile version

A - Menu bar with six (6) application menus. File, Edit, View, Query, GNSS, Tools. The Help
menu can be found in the File menu as a sub-menu, above the Exit button. On some devices there
are only 5 application menus available, because the keyboard covers a part of the Tools menu and it
cannot be hidden in the deviceSizeConf.txt. In this case the Tools menu is located at the bottom of
the GPS menu as a sub-menu on the relevant devices.
B - Displays / hides the menu
C - Active tool
D - Opens / closes the Keyboard
E - Menu and a selected sub-menu. Defined in the Default.mnu file.
F - Selected menu item

The font size in the menu can be modified in the device configuration file.
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Menu and toolbar in the Desktop version

A - Application menus. You can display/hide application menus by clicking on the name (File, Edit,
View, Query, GNSS, Tools and Help) of the menu. These seven (7) application menus defined in
the Default.mnu file.
B - Toolbar. Available only in the Desktop version, it is defined in the Default.tbr file.
C - Menu and a selected sub menu
D - Selected menu item

The default Menu and the Toolbar can be customized by editing tool definitions in
the Menu (.MNU) and Toolbar (.TBR) text files. These text files allows you to
create or modify a toolbar or menu bar configuration in your favorite text editor
(e.g. in Notepad) without the need of any developer application.

4.1 File menu

The File menu contains the following options and sub-menus

 Startup
o Projects
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o Recent Projects (Desktop function)

 Background Map
o Layers

 Change Layer

 Generate TIN (Desktop function)

 Export raster (Desktop function)

 Synchronization (Desktop function)
MapSync for Dropbox (Mobile function)
o E-mail

 Print (Desktop function)

 Settings

 Language
o Help (Mobile function)

 Exit

File menu - Mobile version

File menu - Desktop version
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4.1.1 Startup

The  Startup command is accessible in the File menu, or by clicking on the  Startup button
in the toolbar (Desktop version).

 Startup
Opens the Startup options panel that has two parts: the Main screen and the Settings area.

The following video tutorial explains the Startup options panel usage in detail:

Using the Startup options panel

Startup options: Main screen
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Startup options - Mobile version

A - New project
Scrolls the Startup options panel to the Settings area to specify the project parameters and creates
a new mapping project without layers. Default file format: .EXP that can be changed to any other
supported map and mapping project formats when saving the project.

B - Open project
Opens the Open project File panel to open a Project

C - Project templates
Opens the Open Template File panel to open a Project template then scrolls the Startup options
panel to the Settings area to specify the project parameters. Default file format: .EXP that can be
changed to any other supported map and mapping project formats when saving the project.

1 - Quick measure functions
Scrolls the Startup options panel to the Settings area to specify the project parameters and creates
a new mapping project with a point, line or polygon feature layer. Then opens the GNSS Surveying
panel.

2 - Recent projects
Displays the three most recently opened projects. Tap any one of these to close the current project
and open the selected one.

3 - Recent project templates
Displays the three most recently opened project templates. Tap any one of these to create a new
mapping project using the selected project template.

4 - Clean projects
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Removes the recent projects from the Startup options panel and the Recent Projects sub-menu

5 - Clean templates
Removes the recent project templates from the Startup options panel

New Map Options - Desktop version

Startup options: Settings
The Settings area of the Startup options panel displays automatically when using the following
options on the panel:

o New project

o Quick project

o Project templates

Please note, that this is a scrollable panel. So when you can't see the controls at
the bottom just drag the panel and scroll down.

Startup options > Settings - Mobile version
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Name - Displays the Project name. It can be edited on the Startup options Input panel by tapping/
clicking on the path. The project file format is DigiTerra Explorer Map (.EXP)

Naming conventions:
o Default is 'Project01'

o The number at the and of the project name automatically increments

o Automatically renames the project when trying to use the same project name to an existing

project

Path - Displays the target directory where the project file will be saved. It can be modified by
tapping/clicking on the name of the project.

Modifying the project folder:
    

    Modifying the project folder - Mobile version
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   Modifying the project folder - Desktop version

   

Default Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Maps

Mobile version: $SDCARD\Maps

Format - Specifies the output vector layer format to the Quick measure and Project template
functions. It also specifies the default vector layer format when creating a new layer. The selected
output format is grayed, the default is MAP - DigiTerra.

Projection - Specifies the projection to the New project and Quick measure functions. The
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projection cannot be changed when using a Project template.

Modifying the projection:
Tap on/ click on the projection button to open the Select Projection panel and select a projection.

   Selected projection

    

Dictionary - Enables to use a global code dictionary to each project when checked. Default is
unchecked, in this case the code dictionary stores next to the project file.

Cancel - Cancels changes that has been made on the Startup options > Settings area and the
panel scrolls back to the Startup options > Main screen.

Create Project - Creates the project.

Attribute table templates to the Quick measure functions

Point template -  Displays the path to the current Point template file. The default is
QuickPoint.tab.
Line template - Displays the path to the current path of the Line template file. The default is
QuickLine.tab.
Area template - Displays the path to the Area template file. The default is QuickArea.tab.

Modifying the template:
Tap on/ click on the projection button to open the file panel to select a different template file.

The QuickPoint.tab attribute table template can be used when working in a local
projection system. In case of using global geographical LAT, LON coordinates
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please use the QuickPointWGS.tab template file.

Templates Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Templates

Mobile version: $SDCARD\Templates

4.1.1.1 Input panel

The input panel is used to edit the name of the project.

The following video tutorial explains the Input panel usage in detail:

Using the Input panel on the Startup options dialog box

Main buttons on the Input panel
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 E  - Applies changes then closes the input panel

 F  - Backspace

 G  - Cancels changes then closes the input panel

Other buttons on the Input panel

 A  - Capitalized characters
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 B  - Numeric keypad

 C  - Special characters
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 D  - Accented characters

4.1.1.2 Project templates

Project templates are ready to use data capture projects with empty vector layers and optional
raster and/or vector background layers. The Project template usage is accessible on the Startup
options panel via the Open template button and also via the Recent project template button.

The following video tutorial covers the Project template usage in detail:
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Using Project templates

Using Project templates

1 - Accessing project templates

2 - Selecting a Project template
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3 - Configuring Project template options

The reference description to the controls on the screenshot: "3 - Configuring Project template
options" can be found in the Startup topic.

Default Project template Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\MapTemplates

Mobile version: $SDCARD\MapTemplates

 = new feature Basic Advanced Professional

Availability of the "Use map template
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feature" in different editions

How to use the Project template feature?

1. Tap on the Open button (or choose among the recent Project templates) on the Startup options
panel to select a Project template

2. Select a template file then tap [OK]. The template file extension is DigiTerra Explorer Map (.EXP)
3. Configure the project on the settings area of the Startup options panel, then tap on/click on the

Create Project button

Which layers can be used in the Project template?

Any vector layer format can be used in the Project template as attribute table template without
existing geometry/attribute records. If there are geometries and attribute records in the layer or if you
are using Raster or TIN layers the software will open them with relative path from their original
location in the new project. Projection, Labeling, classification, scale settings...etc. can also be
used dynamically. Code dictionary can also be used in the Project template.

How to create a new Project template?

1. Create a New project on the Startup options panel using the "Default Project template Path"
2. Create new layers into the project
3. Customize the attribute table by adding new data fields with the required default values,

expressions ...etc. or by using Attribute table templates
4. Copy the optional background raster and / or vector layers to the Project template path described

above then add them to this project as layers
5. Save the project with the changes you made

If you would like to use the your Project templates in the Project template folder
synchronize this folder with the mobile devices you want to use on the field. If you
are working with tablets copy this folder to the Project template PATH described
above.

4.1.2 Projects

This sub-menu is accessible in the File menu and contains the following items:

 Open project

 Open db project

 Save project

 Save db project

Projects sub-menu (Mobile)
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Projects sub-menu (Desktop)

4.1.2.1 Open project

This command is accessible in the File menu > Projects sub-menu, or by clicking on the 
 Open Project button in the toolbar (Desktop version). The Open Project command also
accessible on the Startup options panel.

 Open Project
Opens the Open Project File panel to Open project(s).

DigiTerra Explorer merges the selected Projects into one Project when more than
one project files selected in the Open Project file panel for opening.

Keyboard command: O
Supported map file formats: APM, DAT, DMP, EXP, GML, KML, KMZ

Open Project File panel
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 = new feature Basic Advanced Professional

Supported mapping project formats with the Open Project command in different editions

APM - ArcPad Map file
with ArcPad Layer Definition file(.APL)

DAT - Hungarian Digital Base Map

DMP - DigiTerra Map Pack

EXP - DigiTerra Explorer Map

GML - OpenGIS GML Map file

KML - OpenGIS KML Map file

KMZ - OpenGIS KMZ Map file

4.1.2.2 Open db project

This command is accessible in the File menu > Projects sub-menu, or by clicking on the 
 Open db project button in the toolbar (Desktop version).

 Open db project
Opens the Open db project panel, that enables to select and open an SQLite file geodatabase
project from an SQLite DB3 geodatabase.
Supported geodatabase: DB3 - SQLite version 3

Open db project panel
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Connection name: Lists the connections in a drop-down list, that can be created on the Database
connection dialog box to SQLite DB3 geodatabase files. A connection needs to be selected from
the list to display its view(s) in the SQL view list below. Only one database view can be selected to
open a project contrary by the EXP, DMP file selection when opening a Project with the Open
project tool where more than one files can be selected.

 - Opens the Database connection panel to manage connections with geodatabases

SQL view list: Lists the SQL views of the geodatabase. Tap on a list item to select an SQL view
for loading or deletion.

 Cancel  - Closes the Open db project panel

 Delete  - Deletes the selected SQL view from the geodatabase

 Load  - Opens the SQL view as a map view

 = new feature Basic Advanced Professional

Availability of the "Open db project"
command in different editions

4.1.2.2.1  Database connection

This panel is accessible on the following paneles by tapping on the  button after the Connection
name drop-down list:

Open db project
Save db project
New db Layer
Add db Layer
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Save db Layer

Database connection panel is used to define/open a new database/existing
connections with SQLite DB3 geodatabase files.

Database connection panel

  

Name: Displays the list of the geodatabase connection. Default name is the file name of the SQLite
DB3 file. The connection name can be modified.

Provider: Lists the selectable providers. Currently it is SQLite only.

 Path  - Displays the path to the SQLite DB3 file. The path can be modified by editing the path text
or either by tapping on the Path button to open the Open DB file panel.

Database connection list: Lists all available SQLite connections. Tap on a list item to select a
connection for loading or deletion.

 Load  - Opens the relevant SQLite geodatabase to the selected connection then closes the
Database connection panel. The geodatabase can be selected on the listed five paneles above.

 Save  - Saves the connections when you add a new connection or when modify the Name or Path.

 New  - Opens the Open DB file dialog to select an existing SQLite DB3 file or create a new one to
define a new geodatabase connection.

 Cancel  - Closes the Database connection panel and discard all unsaved modifications.
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 Delete  - Deletes the selected geodatabase connection. The relevant SQLite DB3 file remains
intact.

 OK  - Opens the relevant SQLite geodatabase to the selected connection then closes the Database
connection panel. The geodatabase can be selected on the listed five paneles above.

To define and open (load) a new database connection follow this tutorial

1. Tap on the [New] button top open the Open DB file panel
a. Enter the Name of the database to create a new SQLite DB3 geodatabase file then tap [OK]

and finally [OK] on the "File does not exist! Create" message box.
or

b. Select an existing SQLite DB3 geodatabase file in the Open DB file panel
2. Select a geodatabase connection in the list and then tap on the [Load] button
3. The selected geodatabase finally can be selected on the listed five paneles above as:

Selectable geodatabase (connection)

4.1.2.2.2  Open db

The Open db file panel accessible through the Database connection panel when tapping on the
[New] button.

Open DB file panel

To create a new SQLite DB3 geodatabase file enter the Name of the database
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then tap [OK] and finally [OK] on the "File does not exist! Create" message box.

Creating a new geodatabase

1.

2.

3.



53Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

4.1.2.3 Save project

This command is accessible in the File menu > Projects sub-menu, or by clicking on the 
 Save project button in the toolbar (Desktop version).

 Save project
Opens the Save project panel, that enables to save modification(s) you made in the project and in
the vector source layer(s) and their attributes separately.
Supported map formats: DMP, EXP, GML, KML, KMZ

Save project panel
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[x] before the button - Allows you to open the " PATH  button" to access to the Save project file
panel.

This check-box checked once you modify any parameter in the project: e.g. labeling, a new
thematic class etc.

Note: This check-box is also checked if you are using the following vector layer, text and tabular file
formats in the project, which are not able to store long Field name, Alias, Default value and
Expression, Data type, Rules, Code filters. In this cases the project file store these parameters due
to the limitations of the selected vector layer format.

o ESRI Shape (.SHP)

o Zipped ESRI Shape (.ZIP)

o Mapinfo Interchange (.MIF/MID)

o Microstation (.DGN) - up to version 7

o AutoDesk (.DXF)

o GPS logfile (.LOG)

o Coordinates (point) (.CRD)

o Coordinates (shape) (.DAT)

o Atlas GIS (.BNA)

--------------------------
o dBase (.DBF)

o Text files (.TXT)

 PATH  button - Opens the Save project file panel to modify the map file name and the file format.
The default file format is: DigiTerra Explorer Map (.EXP)

Changed layers - Lists the number of changes in the affected vector layers (feature geometry and
their attributes)

[x] before the layer name - Allows you to skip the selected changes in the data source and save
only the selected data sources. Checked as default once you have modified the data source. 

  Select all   - Checks all check-boxes before the layers

 OK  - Saves the selected data sources and the project
          Opens the Save project Pack panel when working with DigiTerra Map Pack (.DMP) project file
format.

 Cancel  - Cancels the saving process and closes the panel

The Save project file panel allows you to change the name of the project by entering a different name
in the File Name text box. It also enables to Save as the project in different Project file formats.

Save project file panel
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Before exiting DigiTerra Explorer with the  Exit button the Save panel appears.
Here you can decide whether you want to save the changes into the project and
into the edited layers.

 = new feature Basic Advanced Professional

Supported project file formats with the Save project command

DMP - DigiTerra Map Pack

EXP - DigiTerra Explorer Map

GML - OpenGIS GML Map file

KML - OpenGIS KML Map file

KMZ - OpenGIS KMZ Map file

For detailed information about Project file formats see the Project formats topic.

4.1.2.3.1  Save Map Pack

This panel accessible from the Save project panel when working with DMP - DigiTerra Map Pack
map project file format. The Save project Pack dialog is used to save DMP- DigiTerra Map Pack
files. You can access this dialog when

1. Select DMP file format on the Save project file dialog
2. Then tap [OK] button.
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Select DMP file format

Save project Pack panel

Protection: Select one from the following options you want to apply in the DMP file

Available options:
No protection
Read only protection 
Reading and printing

[ ] Save only filtered records: Only filtered attribute records will be saved
[ ] Save only visible records: Only visible features of the map view and their related attributes will
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be saved 
[ ] Use UTF-8 encoding: It is recommended to use this option when the mapping project contains
Cyrillic, Arabic, Chinese, Korean, Japanese ... characters among the attributes

Product ID(s): DMP can be protected by the software Product ID(s)
Device ID(s): DMP can be protected by the software's Device ID(s)

More than one Product ID and/or Device ID can be used on the Save project
Pack panel to protect a DMP project file.

Protecting DMP file by Product ID and Device ID

Password: Enter any password to the password protection of the DMP file. You are prompted to
enter this password whenever you open this DMP.

Enter DMP password
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 OK  - Saves the DMP file

 Cancel  - Closes the Save project Pack dialog

4.1.2.4 Save db project

This command is accessible in the File menu > Projects sub-menu, or by clicking on the 
 Save db project button in the toolbar (Desktop version).

 Save db project
Opens the Save db project panel to save the current project into SQLite DB3 geodatabase.
Supported geodatabase: DB3 - SQLite version 3

Save db project panel
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Connection name: Lists the connections in a drop-down list, that can be created on the Database
connection dialog box to SQLite DB3 geodatabase files. A connection needs to be selected from
the list to display its view(s) in the SQL view list below.

 - Opens the Database connection panel to manage connections with geodatabases

SQL view list: Lists the SQL views of the geodatabase. Tap on a list item to select an SQL view
for updating its content or deletion.

Map name: Enter the name of the SQL view. The default name is "Map" or the name of the original
mapping project file name.

Including all vector data: Saves all vector geometry into geodatabase. Checked as default.

GeomType: Select a geometry type if you want to store to the vector geometry in the geodatabase.

DT Geom: DigiTerra Binary Geometry data field type. Solid, encrypted data field format that
can be only read by DigiTerra Explorer 7. Default geometry format.
WKT: Well-known text (WKT) is a text markup language for representing vector geometry
objects on a map, more details: http://en.wikipedia.org/wiki/Well-known_text
WKB:  Well-known binary (WKB). Solid data field format, more details: http://en.wikipedia.org/
wiki/Well-known_text#Well-known_binary

Overwrite existing tables: Overwrites existing data tables in the geodatabase when updating a
geodatabase. e.g. when adding new features or modifying the thematic classes, labels, etc...
Checked as default.

 Cancel  - Closes the Save db project panel

 Delete  - Deletes the selected SQL view from the geodatabase

http://en.wikipedia.org/wiki/Well-known_text
http://en.wikipedia.org/wiki/Well-known_text#Well-known_binary
http://en.wikipedia.org/wiki/Well-known_text#Well-known_binary
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 Save  - Saves/Updates the map view as an SQL view into the geodatabase

 = new feature Basic Advanced Professional

Availability of the "Save db project"
command in different editions

4.1.3 Recent Projects

This sub-menu as a Desktop function is accessible in the File menu and contains the three most
recently opened projects in accordance with the Recent project buttons on the Startup options
panel. Tap any one of these to close the current project and open the selected one.

Recent Projects sub-menu

4.1.4 Background Map

This tool is accessible in the File menu, or by clicking on the  Background Map button in the
toolbar (Desktop version)

Background Maps (Mobile)

Background Maps (Desktop)
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 Background Map
Opens the Background Map panel to use a background map layer as the lowermost layer of the map
view. The Background Map layer not displays in the Layers panel.

Background Maps panel

The Online tab allows you to access online imagery services such as Web Map Services or built-in
Tile Map Services.

The Cached imagery content of the previously used WMS, WMTS or TMS online data sources
can be accessed via the Offline tab. On this tab you can import a background map layer: in Mobile
Atlas Creator .ZIP or SQLite files with any extension.

Please Note: The Background Map layer not displays under scale: 1:10 000 000 if
the map view is in a local projected spatial reference system.

 = new feature Basic Advanced Professional

http://mobac.sourceforge.net
http://mobac.sourceforge.net
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Availability of "Background map tool" in
different editions

4.1.4.1 Online data sources

This dialog is accessible on the Background Map tool to use online imagery content on the map
view as WMS and TMS services. The Online tab contains the following controls:

Background Maps - Online tab

[  ] Enable WMS:  Allows to add your own Open Geospatial Consortium standard Web Map Service
data sources for access to any data published on a WMS server. The built-in WMS client supports
the WMS server served map image data in bitmap format, e.g. PNG, GIF or JPEG. WMTS data
sources are also supported here.

Web Map Services

A Web Map Service (WMS) is a standard protocol for serving georeferenced map images over the
Internet that are generated by a map server using data from a GIS database. The specification was
developed and first published by the Open Geospatial Consortium in 1999.

Requests

WMS specifies a number of different request types, two of which are required by any WMS server:

GetCapabilities - returns parameters about the WMS (such as map image format and WMS
version compatibility) and the available layers (map bounding box, coordinate reference systems,
URI of the data and whether the layer is mostly opaque or not)
GetMap - returns a map image. Parameters include: width and height of the map, coordinate
reference system, rendering style, image format

Request types that WMS providers may optionally support include:
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GetFeatureInfo - if a layer is marked as 'queryable' then you can request data about a coordinate
of the map image.
DescribeLayer
GetLegendGraphic - return an image of the map's legend image, giving a visual guide to map
elements

WMS list: displays the previously defined WMS servers listed below each other. Inactive if the
Enable WMS option not checked.

Adding a WMS layer to the map view: you can quickly add a WMS server data source to the
map view as Background Map layer by selecting a WMS server list item here and then tap/click on
the Add background map button.

Removing a WMS layer from the map view: uncheck the check box before "Enable WMS"

 New     -  Opens the WMS Server Management panel to define a new server

 Copy    -  Copies the selected WMS source as a new source (i.e.) to define a new layer set from
the available data layers on the WMS Server Management panel

 Modify  -  Opens the WMS Server Management panel to modify the parameters of the selected
WMS source

 Delete  -   Removes the selected WMS source from the list

[  ]  Enable TMS -  Allows to use a built-in Tile Map Service source as a background map layer

Tile Map Services

Tile Map Service or TMS, is a specification for storing and retrieving cartographic data, developed by
the Open Source Geospatial Foundation. The definition generally requires a URI structure which
attempts to fulfill REST principles. The TMS protocol fills a gap between the simplistic standard used
by OpenStreetMap and the complexity of the Web Map Service standard, providing simple urls to
tiles while also supporting alternate spatial referencing system.

Supported Tile Map Server sources

Google Maps Satellite
Google Maps Topographic
Google Maps Road
Bing Maps Satellite
Bing Maps Road
Open Street Maps
Nokia Maps Satellite
Nokia Maps Road
Nokia Maps Transit
CloudMade Maps
Open Sea Map
Open Street Maps Polska
Freemap Slovakia Road
New Zealand Topographic Maps
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Adding a TMS layer to the map view: select a TMS server option in the drop-down list and then
tap/click on the Add background map button

Removing a TMS layer from the map view: uncheck the check box before "Enable TMS"

 Cancel  - Closes the panel

 Add background map  - Adds the selected WMS or TMS server source to the current map view as a
background map layer

4.1.4.1.1  WMS Server Management

This dialog is accessible from the Background maps tool > Online tab with the New, Copy and
Modify buttons. The WMS Server Management panel contains the following controls:

WMS Server Management panel

Name: enter the name of the service

Server URL: enter the 'Get Capabilities' Address of the WMS service

Login name: enter the optional login name to access the service

Password: enter the optional password to access the service

 Get List of Available Data Layers  - queries the available data layers at the Server URL

Data Layers list: list the available WMS data layers to select and define the background map layer.
Multiple layers can be selected.

 Cancel  - closes the panel
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 Save     - saves the entered parameters with the selected data layers in the list

4.1.4.2 Offline data sources

The Offline tab accessible on the Background maps tool. The Offline tab contains the following
controls:

Background Maps - Offline tab

[  ] Enable offline/cached map sources - allows to add cached or imported data source

Offline data sources

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Maps\Background\

Mobile version: $SDCARD\Maps\Background\

 Import  - you can import a background map layer: in Mobile Atlas Creator .ZIP or .SQLite format,
that will be displayed in the drop-down list above

Adding an Offline background map layer to the map view: you can quickly add an offline data
source to the map view as Background Map layer by selecting an item in the drop-down list and then
tap/click on the Add background map button.

Removing an Offline background map layer from the map view: uncheck the check box
before "Enable offline/cached map sources"

Cache manager

Selected source: The selected source will be removed when pressing the  Delete cache  button

http://mobac.sourceforge.net
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All source: All cached sources will be removed when pressing the  Delete cache  button

 Delete cache  - Removes the selected or all offline data source

 Cancel  - Closes the panel

 Add background map  - Adds the selected cached source to the current map view as a background
map layer

4.1.5 Layers sub-menu

This sub-menu is accessible in the File menu and contains the following items:

 New Layer

 New db Layer

 Add Layer

 Add db Layer

 Save Layer

 Save db Layer

 Layer Manager

Layers sub-menu (Mobile)

Layers sub-menu (Desktop)
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4.1.5.1 New Layer

1. This command is accessible in the File menu > Layers sub-menu with the  button and in the
toolbar (Desktop version).

2. On the Layer Manager: tap on the  New Layer button > then select the File option in the
pop-up menu.

Accessing to the New Layer command in the menu
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Accessing to the New Layer command in the Desktop version

Accessing to the New Layer command in the Layer Manager

 New Layer
Opens the Create Layer File panel and then the New Layer panel to create a new (empty) layer.
Opens the Database/File context menu on the Layer Manager.

Create Layer file panel
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Supported formats on the Create Layer file panel:
- Vector: BNA, CRD, DAT, DGN, DXF, MAP, MIF/MID, SHP, ZIP(SHP)
- Tabular / Text: DBF, TAB, TXT

Default file name: today's date in YYYY-MM-DD-HHMM format
Default file format: MAP - DigiTerra

For new users it is recommended to use the default MAP - DigiTerra file format

to collect data in a vector layer. The layer can be easily exported with the 
 Save Layer command in the Layers sub-menu or on the Layer Manager.

 = new feature Basic Advanced Professional

Supported vector formats with the New Layer command

BNA - Atlas GIS

CRD - Coordinates (point)

DAT - Coordinates (shape)

DGN - Microstation

DXF - Autodesk

MAP - DigiTerra

MIF - Mapinfo Interchange

SHP - ESRI Shape

ZIP - Zipped ESRI Shape

Supported tabular / text formats with the New Layer command

DBF - dBase

TAB - DigiTerra

TXT - Text files
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4.1.5.1.1  New  layer dialog

The New layer panel accessible through the  New Layer command once you have selected
the vector file name, file format and PATH on the Create layer file panel.

New layer panel contains the following controls:

The New layer panel

Type of geometry: Select a feature type for the new layer with a radio button
Default feature type: Polygon

The default feature type can be easily modifiable by selecting a different feature
type on the New layer panel.

Point:  the new layer will be a point feature layer
Line: the new layer will be a line feature layer
Polygon: the new layer will be a polygon feature layer

Character coding: Select a character coding method you wish to use to the attribute table of the
template
Default character coding: ANSI

ANSI
UTF-8 (available since version 6)
UNICODE (available since version 6)

In case of using ESRI Shape file (.SHP) the selected code page will be stored in
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.CPG format. In case of using MAP - DigiTerra vector layer format, the code page
can be stored in the TAB - DigiTerra file.

Store 3D coordinate: Enables to store 3D coordinates in the new layer when capturing a feature
with GPS on the GNSS Survey panel

Please note that the Z coordinate can only be stored in DXF - AutoDesk, SHP -
ESRI Shape and MAP - DigiTerra file formats

Use attribute table template: Enables to use attribute table templates for the created new layer.
Default option is unchecked.

Previously used templates: Lists the previously used attribute table templates

 Browse...  - Opens the Select template file panel to select an existing attribute table template. This
button active only when the "Use attribute table template" option checked. The template PATH
described in the Select template topic.

 New template  - Opens the New template file panel to create a new attribute table template to the
template PATH

 Cancel  - Closes the New layer panel

 OK  - Closes the New layer panel and then stores the new vector layer in the defined path, file
format, feature type, character coding, 3D storing option and creates the attribute table based on the
selected attribute table template.

4.1.5.1.2  Select template

The Select template file panel accessible through the New layer panel with the  Browse...  button

to select an attribute table template to the vector layer you want to create with the  New Layer
command.

Select template file panel
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Template Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Templates

Mobile version: $SDCARD\Templates

Mobile version: $PROGRAMFILES\DigiTerra Explorer v7\Bin\Templates

4.1.5.1.3  New  template

The New template file panel accessible through the New layer panel with the  New template

 button to create a new attribute table template to the vector layer you want to create with the 
 New Layer command. Once you have tapped the [OK] button the New data field panel appears to
define the attribute table's field one by one.

Attribute table template: it is a TAB - DigiTerra file in the Template Path that
stores the data field definitions to create the new layer's attribute table structure
based on a predesigned attribute table quickly and easily.

It is recommended to save the new attribute table template into the Template
Path (described below).

New template file panel
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Default file name: today's date in YYYY-MM-DD-HHMM format
File format: TAB - DigiTerra

Template Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Templates

Mobile version: $SDCARD\Templates

Mobile version: $PROGRAMFILES\DigiTerra Explorer v7\Bin\Templates

Please have a look at this topic: Attribute table template to learn how to create a
new attribute table template on the Layer Manager.

4.1.5.1.4  New  data f ield

The New data field panel accessible through the New layer panel with the  New template  button
to create a new attribute table template.

The attribute table template that you can define on the New data field panel -
data field by data field- will be located in the Template Path if you have saved it
on the New template file panel into this folder. If you have not saved it into this
folder create the template then copy the this TAB - DigiTerra file into the Template
Path.

New data field panel
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The New data field panel contains the same controls as the Data field panel except three buttons
at the bottom of the panel.

 New  - Adds a new data field to the template

 OK  - Saves the attribute table template then closes the New data field panel, then the New layer
panel appears with the created template in the template list box.

 Cancel  - Cancels the current data field, closes the New data field panel, then the New layer
panel appears with the created template in the template list box.

4.1.5.2 New db Layer

1. This command is accessible in the File menu > Layers sub-menu with the  button and in the
toolbar (Desktop version).

2. On the Layer Manager: tap on the  New db Layer button > and select the Database option in
the pop-up menu.

Accessing to the New db Layer command in the menu
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Accessing to the New db Layer command in the Desktop version

Accessing to the New db Layer command in the Layer Manager

  

 New db Layer
Opens the New db Layer panel to create a new (empty) geodatabase layer by entering the Table
name. The New db Layer dialog allows to create a new (empty) layer into an SQLite DB3
geodatabase.
Supported geodatabase: DB3 - SQLite version 3

Please have a look at this topic: Open db to learn how to create a new
geodatabase to store the New database layer. If you want to use an existing
geodatabase to store the New database layer follow the description at the bottom
of this this topic: Database connection.
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Once you have entered the Table name (it is the database layer name that
appears on the Layer Manager) the New layer dialog appears even when working
with file-based vector feature layers.

New db Layer panel

New db layer panel - inactive
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If the New db Layer inactive select an existing connection from the Connection
name combo box or add a new database connection to the combo box with the 

 button.

Connection name: Lists the connections in a drop-down list, that can be created on the Database
connection dialog box to SQLite DB3 geodatabase files. A connection needs to be selected from
the list to display its table(s) in the SQL table list below.

 - Opens the Database connection panel to manage connections with geodatabases

SQL table list: Lists the SQL tables of the geodatabase. Tap on a list item to select an SQL table
for deletion.

Table: Enter the name of the SQL table. This text box is empty as default.

Geom. field: Enter the name of the SQL field name that stores the geometry. The default name is
geometry.

Type: Select a geometry type if you want to store to the vector geometry in the geodatabase.

DT Geom: DigiTerra Binary Geometry data field type. Solid, encrypted data field format that
can be only read by DigiTerra Explorer 7. Default geometry format.
WKT: Well-known text (WKT) is a text markup language for representing vector geometry
objects on a map, more details: http://en.wikipedia.org/wiki/Well-known_text
WKB:  Well-known binary (WKB). Solid data field format, more details: http://en.wikipedia.org/
wiki/Well-known_text#Well-known_binary

 Cancel  - Closes the New db Layer panel

 Delete  - Deletes the selected SQL table from the geodatabase

 OK  - Creates the new database layer into the geodatabase

 = new feature Basic Advanced Professional

Availability of the "New db Layer"
command in different editions

4.1.5.3 Add Layer

1. This command is accessible in the File menu > Layers sub-menu with the  button and in the
toolbar (Desktop version).

2. O the Layer Manager: tap on the  Append Layer button > and select the File option in the
pop-up menu.

Accessing to the Add Layer command in the menu

http://en.wikipedia.org/wiki/Well-known_text
http://en.wikipedia.org/wiki/Well-known_text#Well-known_binary
http://en.wikipedia.org/wiki/Well-known_text#Well-known_binary
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Accessing to the Add Layer command in the Desktop version

Accessing to the Add Layer command in the Layer Manager

 Add Layer
Opens the Append Layer file panel to add one or more layers to the current map.

Keyboard command: A

Supported formats:
- Vector: BNA, CRD, DAT, DGN, DXF, LOG, MAP, MIF, SHP, TIN, ZIP
- Table /Text: DBF, MDT, TAB, TXT
- Raster: BIL, BMP, CADRG, ECW, ERS, JPG, JP2, LAN, PCX, PNG, RAS, SID, TIF
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Please Note: MrSID and TIN file formats are available only in the Desktop version

 = new feature Basic Advanced Professional

Supported vector formats with the Add Layer command

BNA - Atlas GIS

CRD - Coordinates (point)

DAT - Coordinates (shape)

DGN - Microstation

DXF - Autodesk

MAP - DigiTerra

MIF - Mapinfo Interchange

SHP - ESRI Shape

TIN - Triangulated Irregular Network

ZIP - Zipped ESRI Shape

Supported tabular / text formats with the Add Layer command

DBF - dBase

MDT - Leica Total Station

TAB - DigiTerra

TXT - Text files

Supported raster formats with the Add Layer command

BIL - ESRI Raster

BMP - Windows

CADRG - Compressed Arc Digitized

ECW - Er-Mapper Wavelet

ERS - Er-Mapper

JPG - JPEG file

JP2 -  JPEG2000 file

LAN - Erdas

PCX - Paintbrush

PNG - Portable Network Graphics

RAS - DigiTerra Raster

SID - LizardTech MrSID Raster

TIF - Tagged Image File

4.1.5.3.1  Append Layer

1. The Append Layer file panel accessible through the  Add Layer command to add one or more
layers to the current map.

2. It is also accessible on the Layer Manager with the  Add Layer button > by selecting the File
option in the pop-up menu.
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Append Layer file panel

4.1.5.4 Add db Layer

1. This command is accessible in the File menu > Layers sub-menu with the  button and in the
toolbar (Desktop version).

2. On the Layer Manager: tap on the  Add Layer button > and select the Database option in
the pop-up menu.

Accessing to the Add db Layer command in the menu

Accessing to the New db Layer command in the Desktop version
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Accessing to the New db Layer command in the Layer Manager

 Add db Layer
Opens the Add db Layer panel to add a geodatabase layer to the current map.
Supported geodatabase: DB3 - SQLite version 3

Add db Layer panel

Connection name: Lists the connections in a drop-down list, that can be created on the Database
connection dialog box to SQLite DB3 geodatabase files. A connection needs to be selected from
the list to display its table(s) in the SQL table list below.

 - Opens the Database connection panel to manage connections with geodatabases
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SQL table list: Lists the SQL tables of the geodatabase. Tap on a list item to select an SQL table
for deletion.

Geom. field: Select an SQL geometry field to the database layer you want to add to the map view

 Cancel  - Closes the Add db Layer panel

 Delete  - Deletes the selected SQL table from the geodatabase

 Save  - Adds the database layer to the map view from the geodatabase

 = new feature Basic Advanced Professional

Availability of the "Add db Layer"
command in different editions

4.1.5.5 Save Layer

1. This command is accessible in the File menu > Layers sub-menu with the  Save Layer
button.

2. On the Layer Manager: tap on the  Layer Export button > and select the File option in the
pop-up menu.

Accessing to the Save Layer command in the menu

Accessing to the Save Layer command in the Desktop version



83Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

Accessing to the Save Layer command in the Layer Manager

 Save Layer
Opens the Save as file panel to export the active layer with another file name or into another file
format.

Active layer: Selected grayed layer on the Layer Manager

In case of exporting a multi feature layer DigiTerra Explorer is able to save each
feature types separately.

Supported formats:
- Vector: BNA, CRD, DAT, DGN, DXF, MAP, MIF, SHP, ZIP
- Raster: JPG - 15% compression (85% quality) as default. The compression scale cannot be
changed. PNG
- Table: DBF, TAB, TXT

 = new feature Basic Advanced Professional

Availability of the "Save Layer" command
in different editions

 = new feature Basic Advanced Professional

Supported vector formats with the Save Layer command
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BNA - Atlas GIS

CRD - Coordinates (point)

DAT - Coordinates (shape)

DGN - Microstation

DXF - Autodesk

MAP - DigiTerra

MIF - Mapinfo Interchange

SHP - ESRI Shape

ZIP - Zipped ESRI Shape

Supported tabular / text formats with the Save Layer command

DBF - dBase

TAB - DigiTerra

TXT - Text files

Supported raster formats with the Save Layer command

JPG - JPEG file

PNG - Portable Network Graphics

4.1.5.5.1  Save as

1. The Save as file panel accessible through the  Save Layer command in the File menu >
Layers sub-menu to Save as the active layer.

2. It is also accessible on the Layer Manager with the  Layer Export button > by selecting the
File option in the pop-up menu.

Save Layer file panel
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4.1.5.5.2  Exporting a multifeature layer

Exporting multi feature layers
In case of exporting a multi feature layer DigiTerra Explorer is able to save each feature types
separately.
For example: you have a "multifeature.DXF" layer with points, lines and polygon features in the file.
In this case you will get three different layers in accordance with the feature type:

multifeature_point.DXF
multifeature_line.DXF
multifeature_area.DXF

Selected multifeature layer to export

The Save as File panel
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Message box to the separated export: select "Yes" if you want to save the features into separated files

The exporting process with the progress bar
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Results

4.1.5.6 Save db Layer

1. This command is accessible in the File menu > Layers sub-menu with the  Save db Layer
button.

2. On the Layer Manager: tap on the  Layer Export button > and select the Database option in
the pop-up menu.

Accessing to the Save db Layer command in the menu
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Accessing to the Save db Layer command in the Desktop version

Accessing to the Save db Layer command in the Layer Manager

 Save db Layer
Opens the Save db Layer panel to save the active layer as a geodatabase layer. The Save db
Layer dialog allows to save the active layer into an SQLite DB3 geodatabase.
Supported geodatabase: DB3 - SQLite version 3
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 = new feature Basic Advanced Professional

Availability of the "Save db Layer"
command in different editions

Save db Layer panel

Connection name: Lists the connections in a drop-down list, that can be created on the Database
connection dialog box to SQLite DB3 geodatabase files. A connection needs to be selected from
the list to display its table(s) in the SQL table list below.

 - Opens the Database connection panel to manage connections with geodatabases

SQL table list: Lists the SQL tables of the geodatabase. Tap on a list item to select an SQL table
for deletion.

Table: Enter the name of the SQL table. This text box is empty as default.

Geom. field: Enter the name of the SQL field name that stores the geometry. The default name is
geometry.

Type: Select a geometry type if you want to store to the vector geometry in the geodatabase.

DT Geom: DigiTerra Binary Geometry data field type. Solid, encrypted data field format that
can be only read by DigiTerra Explorer 7. Default geometry format.
WKT: Well-known text (WKT) is a text markup language for representing vector geometry
objects on a map, more details: http://en.wikipedia.org/wiki/Well-known_text
WKB:  Well-known binary (WKB). Solid data field format, more details: http://en.wikipedia.org/
wiki/Well-known_text#Well-known_binary

 Cancel  - Closes the Save db Layer panel

http://en.wikipedia.org/wiki/Well-known_text
http://en.wikipedia.org/wiki/Well-known_text#Well-known_binary
http://en.wikipedia.org/wiki/Well-known_text#Well-known_binary
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 Delete  - Deletes the selected SQL table from the geodatabase

 Save  - Saves / updates the layer as a database layer in the geodatabase

4.1.5.7 Layer Manager

1. This command is accessible in the File menu > Layers sub-menu with the  Layers button and
in the toolbar (Desktop version).

2. It can also be accessed on the pan frame with the Layers button.

The Layers button can be found in the top left side on the pan frame.

Accessing to the Layer Manager command in the menu

Accessing to the Layer Manager command in the menu in the Desktop version
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Layers button on the pan frame

 Layers
Opens the Layers panel.

Keyboard command: D

4.1.6 Change Layer

This command is accessible in the File menu and in the toolbar (Desktop version) with the 
 Change Layer button.

 Change Layer
Moves/copies the selected point, line or polygon item(s) from the active layer into the edited layer.

Tap / Left click: selects an item on the map to move/copy. The selected item can be copied/moved
from the active layer to the edited layer.
Drag:  scrolls the map (dynamic pan).
Tap and hold then drag / Right drag: Dynamic Zoom.

The Change Layer remains active until another tool is activated.

Active layer: the source layer in which the item(s) must be selected.
Edited layer: the result layer in which the copied/moved items will be stored.

The active and the edited layer
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Selected item in the active layer

Move: moves the selected feature(s) into the edited layer. The selected feature(s) will be deleted in
the active layer.
Copy: copies the selected feature(s) into the edited layer. The selected feature(s) will be remained in
the active layer.

You can select multiple items in the active layer with the multi selection tools and
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then use the Change Layer tool.

4.1.7 Generate TIN

This tool is available only in the Desktop version in the File menu and in the toolbar with the 
 Change Layer button to create a TIN vector model file from the selected vector layer or an
individual attribute table.

 Generate TIN
Opens the Generate TIN panel to create a TIN vector file from vector feature layer or from the layer's
attribute fields.

Generate TIN panel

Layer - List the available vector layers and attribute tables from the current map view. Select the
layer from the drop-down list that contains x, y, z data as geometry or attribute data.

X - List the attribute fields of the selected layer. Select a data field that stores the X coordinates.
Y - List the attribute fields of the selected layer. Select a data field that stores the Y coordinates.
Z - List the attribute fields of the selected layer. Select a data field that stores the Z coordinates
(heights values).

[ ] Use geometry - The TIN generator uses only the geometry to create the TIN file.
[x] Skip points with 0 height -  The TIN generator skips the zero heights from the geometry to
create the TIN file.

4.1.8 Export raster

This tool is available only in the Desktop version in the File menu and in the toolbar with the 
 Change Layer button to create a TIN vector model file from the selected vector layer or an
individual attribute table.
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 Export raster
Opens the Rasterization: Export Raster Data panel to export the current map view as a 
georeferenced raster image or as sliced map tiles grouped by specified zoom levels =
TILESET

Rasterization w ith the Raster Image tab

Rasterization w ith the Tileset tab

Common controls

Extent: defines the data frame on the map view to use when exporting. Default is Visible extent.

Entire extent: option will export the entire extent of the map view
Visible extent: option will export only the visible portion of the map view in the display
Selected features: option will clip and export the map view based on the selected features in
the active layer; this option will retain the data inside the graphic
Custom: option will clip and export only the portion of the map view  based on the manually
entered map extent coordinates
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o North, South, East, West: displays the map extent coordinates. Editable only when selecting

the Custom radio button.

Selected features in the active layer

Raster Options: choose the format in which to save the raster export. You will be able to save the

export to JPG or PNG. This includes situations where you are saving your map view to a JPG or
PNG compression within a geodatabase. Default is JPG.

JPG: If JPG format is chosen, then you can set the compression quality between 1 to 100. Default
is 85%.
PNG: If JPG format is chosen, then you can set the transparent option
o Transparent: The saved raster will be a transparent PNG. Default is unchecked.

Raster Image tab

Cell Size (cx, cy): Displays the current pixel size. Changes the output raster size based on the
entered pixel size values in x, y directions
Raster Size (columns, rows): Displays the current raster size in columns/rows. Specifies the
size of the raster image based on the adjusted values to your specifications.

The default is to export by using the cell size.

Size: Displays the file size of the output raster image.
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Location: Displays the current working directory where the raster image will be saved. Opens the
Browse for Folder panel to specify the output path.

Default Path: $DOCUMENTS\DigiTerra Explorer\Maps\

Name: Displays the output file name with the selected extension. Default name is the map project
name, that can be modified here.

Tileset tab
You can also export the map view into tiles, rather than a single raster image file using the Tileset
tab. The Tileset tab allows you to tile the output according to the zoom levels to your specifications,
among other options. Using the Tileset tab will tile the output according to predefined zoom level
schemas.

Min zoom: Lists the zoom levels to select the minimum zoom level.
Max zoom: Lists the zoom levels to select the maximum zoom level.

Output mode: 
Files - The result of the tile export will be stored in individual files grouped by zoom levels in
specified folders with an index.html file that will be opened in the default web browser.
Zipped files - Same with the Files option, but the files will be compressed into a .ZIP file
Database - The result of the tile export will be stored in an SQLite - DB3 geodatabase

The default option is Files.

[x] Do not create blank tiles - The tile export will not create blank tiles when checking this
option. Default is checked.
[ ] Skip existing tiles - The tile export will not re-generating existing files when overwriting the
content in the same Subfolder.

Location: 

Default Path: $DOCUMENTS\DigiTerra Explorer\Maps\Background

Subfolder: Displays the subfolder where the output will be saves. Default subfolder name is the
map project name, that can be modified here.

 Cancel  - Closes the panel

 Start processing  - Starts the raster export with the specified export options

4.1.9 Synchronization

 Synchronization

This tool is available only in the Desktop version in the File menu and in the toolbar with the 
 Synchronization button.
Opens the File Synchronization panel to download, upload or automatically synchronize files
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between mobile device and desktop computer.

The File Synchronization panel is used to download, upload or synchronize files between a selected
directory of the Mobile and the Desktop computer. You can access to this desktop command in the

menu bar: File >  Synchronization and in the toolbar:  as well.

This feature of DigiTerra Explorer requires Windows Mobile Device Center (for
Windows 7, 8 or Vista), or Microsoft ActiveSync (for Windows XP) to be installed.
Please install these software utilities for full DigiTerra Explorer functionality. For
more information on these applications and to download, refer to http://
www.microsoft.com/windowsphone/en-us/65-downloads.aspx

File Synchronization panel

Directory: Shows the current path on the Mobile and on the Desktop

 \  - Changes the path to the root path on the Mobile; opens the drive selection on the Desktop

http://www.microsoft.com/windowsphone/en-us/65-downloads.aspx
http://www.microsoft.com/windowsphone/en-us/65-downloads.aspx
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 ..  - Changes the path one directory back

 Create folder  - Opens the "New folder name" text box to create a new folder

 Delete  - Delete selected files and folders

 Select all  - Selects/Un-selects all files and folders

 Download >>  - Downloads marked files from the Mobile device to the Desktop computer

 << Upload  - Uploads marked files from the Desktop computer to the Mobile device

 Synchronize  - Synchronizes all files between the Mobile device and the Desktop computer in the
selected current directory

Filetype: select a filetype from the drop-down list to filter the selected files

4.1.10 MapSync for Dropbox

MapSync for Dropbox (DigiTerra MapSync) is the official Dropbox app for Windows Mobile/
Embedded to integrate Dropbox to DigiTerra Explorer. DigiTerra MapSync can only read or write to a
single folder in your Dropbox. You can rename or move this App Folder wherever you want in your
Dropbox, and the app will keep working normally. It is also allows automatic camera uploads.

App Folder in Dropbox:

Desktop version: \Dropbox\Apps\DigiTerra MapSync

For information on required software components to DigiTerra MapSync, please also refer to 
Required components topic.

MapSync for Dropbox menu
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DigiTerra MapSync start screen

 = new feature Basic Advanced Professional

Availability of "MapSync for Dropbox" in
different editions

Desktop version:

Download the official Dropbox client to your Desktop computer.

https://www.dropbox.com/downloading?src=index
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Please, use this feature in the Mobile version first to install the required DigiTerra MapSync plugin to
your Dropbox account.

Working directory on the Desktop:

Desktop version: \Dropbox\Apps\DigiTerra MapSync

The Main panel of the MapSync displays first when you start MapSync. This panel lists the
synchronized folders.

MapSync main panel

Logout: Logout the current Dropbox folder

New: Lists all folders to select a folder for synchronization

Sync: Synchronizes the local content from the selected folders with the authorized Dropbox folder

Dropbox: Queries and displays the content of the authorized Dropbox folder

Settings: Opens the MapSync - Settings dialog

Info: Opens the MapSync - Info dialog

Exit: Closes MapSync

MapSync - Selecting a folder for synchronization
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Queried Dropbox folder

Queried Dropbox folder - selected file
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4.1.10.1 Required components

All required components will be installed if you follow the installation scenarios on Introduction >
Installation > Mobile topic.

1. If the DigiTerra MapSync utility doesn't start once you tapped on the MapSync for Dropbox
menu item in the File menu and the following error message displays on the screen, please install
.NET compact framework manually from this path below:

This application requires the Microsoft® .NET Compact Framework version 3.5
and OperaMini5.1

Path:

Mobile version: $SDCARD\2577\NETCFv35.wm.armv4i.cab

.NET Compact Framework is not installed
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2. If you cannot log into your Dropbox account in Internet Explorer, install OperaMini5.1 manually
from the following path below. Note: IE mobile version is not compatible with Dropbox on Windows
Mobile/Embedded OS, this is why the software try to install OperaMini5.1 at the first start.

Path:

Mobile version: $SDCARD\2577\OperaMini51.cab

4.1.10.2 Authorizting MapSync

Authorizing MapSync for Dropbox plugin to your Dropbox account

1. Sing up to Dropbox at http://www.dropbox.com
2. Select MapSync for Dropbox in the menu, check [ ] Remember me? and press Login

http://www.dropbox.com
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3. In Opera Mini press Accept if you start MapSync for first time to authorize the MapSync for
Dropbox plugin to your Dropbox account

4. Sign in to Dropbox in the opened web page by entering your selected Email and Password,
check [ ] Remember me and press Sign in

5. Press Yes in the Remember Password window
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6. Finally press Allow to create a folder in your Dropbox that will be used for synchronizing data
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Video tutorial:

Authorizing MapSync - video

4.1.11 E-mail sub menu

This menu is accessible in the File menu > E-mail sub-menu and contains the following items:

 Receive E-mail

 Send E-mail

 = new feature Basic Advanced Professional

Availability of "E-mail sub-menu" in
different editions

The E-mail sub-menu
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 Receive E-mail
Receives E-mail with the associated e-mail software.

 Send E-mail
Sends mapping project and its sources (vector and raster layers, code dictionary, project file (EXP))
by e-mail with the associated e-mail software.
In the Mobile version the software packs the full project in a .ZIP archive, that can be sent as an
attachment by e-mail.

The size of the e-mail attachment is 5 MB as default, which can be modified on the Settings >
System tab at Attachment size option.

4.1.12 Print map

 Print
Prints the current Map. This menu item is available only in the Desktop version.

All details of the Print panel can be found in the Printing maps and reports topic

4.1.13 Settings

 Settings
Opens the Settings panel.
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All details of the Settings panel can be found within the Settings topic

4.1.14 Language

 Language
Opens the language selection dialog to change the language that currently displays in DigiTerra
Explorer.

The language selection panel displays automatically at the first start of the
software.

Language selection panel

DigiTerra Explorer stores the language variables in editable text files with LANG extension in the
following paths:

Path:

Desktop version: $PROGRAMFILES\DigiTerra Explorer v7\

Mobile version: $SDCARD\Bin\

4.1.15 Help sub-menu

This sub-menu contains the following items and it is available only in the Mobile version. In the
Desktop version the following commands are accessible in the Help application menu. 

 Help
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 About

The Help sub-menu

 Help
Opens the online version of the DigiTerra Explorer Reference Guide in the default browser.

 About
Opens the About DigiTerra Explorer panel to display information about the software (current
version), the license (registration) and the system. It is also used to try out the functionality of
different editions/extensions on the Evaluate tab.

4.1.15.1 About

The About dialog contains the following tabs:

1. About
2. License
3. Evaluation

The About tab
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Program version: Shows the current software version

Modules: Shows the purchased editions and extensions

 Explorer is up to date  - Updates DigiTerra Explorer online if new updates are available, anyway this
button is inactive.

 Save System Info  - Saves all information from the About and Registration panel into the
ExplorerSystem.txt file.

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer v7\ExplorerSystem.txt

Mobile version: $SDCARD\Bin\ExplorerSystem.txt

Displayed message box about the saved ExplorerSystem.txt
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4.1.15.1.1  License

The License tab is used to activate the Product ID you purchased and also to upgrade an existing
license.

For information on activation, license upgrade please also refer to Registration topic.

About > License tab
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4.1.15.1.2  Evaluation

Select an edition/extension to try it out then tap on the  EVALUATE  button. The purchased edition /
extension(s) are greyed.

The Evaluate tab

 EVALUATE - Activates the selected edition/extension without restarting the application

4.1.16 Exit

 Exit
Enables to exit the application.

Basic steps to exit DigiTerra Explorer
1. The Exit message box appears as default (if you have not unchecked the "Show this question

next time?")
2. Then opens the Save panel to save the map view into a new map project (The "Save panel"

displays only if you have added at least one layer to the map view and not yet saved it into a map
project before exiting the software)

3. Finally closes DigiTerra Explorer.

Exit message box
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Save panel

4.2 Edit menu

The Edit menu contains the following options and sub-menus for vector map editing operations

 Point

 Line

 Polygon
o Drawing
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o Modify

o Edit vertex

 Erase

 Undo

Edit menu (Mobile)

Edit menu (Desktop)

4.2.1 Point

 Point
Activates the point feature type for data capture. Tap the map to create a new point feature at the
tapped location into the edited layer then DigiTerra Explorer proceeds to capture attributes according
to the Settings > Record > New record: <selected option>. The point feature type remains

active for data capture until another tool is activated. The Point button allows capture on the screen



115Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

with the pen or mouse but not with incoming GPS coordinates.

Tap / Left click: captures point feature at the tapped location
Drag:  captures point feature at the tapped location using crosshairs
Tap and hold / Right click: displays the Context menu

Context menu

Opens the Insert Point panel. Only this option appears in the context menu when
there is no vector feature layer on the Layer Manager or when the edited layer's file
format is not MAP - DigiTerra

Context menu for MAP - DigiTerra layers

Opens the Insert Point panel

Activates the multipoint feature type for data capture

Multipoint context menu

Undoes the last edit made to a feature

Opens the Insert Point panel

Opens the Modify panel

Deactivates the multipoint feature type for data capture

Undoes all edit made to a feature

Creates the multipoint feature and deactivates the multipoint feature type for
data capture.

Point and multipoint features in a MAP - DigiTerra layer
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Troubleshooting
The point feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is POINT, anyway the following cases are
possible:

1. If the active layer is a POINT feature layer but the editing is turned off or the layer locked on
the Layer Manager the following message box appears to enable editing in the active layer:

2. If the active layer is a POINT feature layer but the edited layer is a line or polygon feature layer
(or a data table or a text file) the following message box appears:

3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New



117Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

work layer panel appears to select an existing layer from the project or create a new one:

Available in

 = new feature Basic Advanced Professional

Availability of the "Point" tool in different
editions

See also

Multipoint features can be exploded into single point features with the 
 Explode tool

You can also create multipoint geometry from a single point feature with the

 Insert vertex tool

Please also have a look at this video tutorial: Creating new multipoint features

4.2.1.1 Insert Point dialog box

The Insert Point panel enables to add point on the map in an editable point layer by entering its
coordinates.

Insert Point panel

http://youtu.be/T4vXXB54W5A
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East: Easting coordinate of the point
North: Northing coordinate of the point
Height: Height of the point

 Insert Point  - adds the point on the map with the displayed coordinates on the dialog

 GNSS  - takes over the Easting, Northing coordinates of the current GPS/GNSS position to add a
point at the current GPS/GNSS location

 Cancel  - Closes the panel

4.2.2 Line

 Line
Activates the line feature type for data capture. Tap the map to add the vertices of a new line or
polyline feature into the edited layer then Tap and hold / Right click to open the context menu and
select Create to create the feature. Once you selected the Create option in the context menu
DigiTerra Explorer proceeds to capture attributes according to the Settings > Record > New record: 
<selected option>. The line feature type remains active for data capture until another tool is

activated. The Line button allows capture on the screen with the pen or mouse but not with incoming
GPS coordinates.

Keyboard command: L

Tap / Left click: adds vertex into the edited layer at the tapped location
Drag:  adds vertex into the edited layer at the tapped location using crosshairs
Tap and hold / Right click: displays the Context menu

Context menu
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Undoes the last edit made to a feature

Opens the New vertex panel

Opens the Modify panel

Activates the multiline feature type for data capture

Undoes all edit made to a feature

Creates the line or multiline feature

Troubleshooting
The line feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is LINE, anyway the following cases are
possible:

1. If the active layer is a LINE feature layer but the editing is turned off or the layer locked on the
Layer Manager the following message box appears to enable editing in the active layer:

2. If the active layer is a LINE feature layer but the edited layer is a point or polygon feature layer
(or a data table or a text file) the following message box appears:
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3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New
work layer panel appears to select an existing layer from the project or create a new one:

Available in

 = new feature Basic Advanced Professional

Availability of the "Line" tool in different
editions
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4.2.3 Polygon

 Polygon
Activates the polygon feature type for data capture. Tap the map to add the vertices of a new
polygon feature into the edited layer then Tap and hold / Right click to open the context menu and
select Create to create the feature. Once you selected the Create option in the context menu
DigiTerra Explorer proceeds to capture attributes according to the Settings > Record > New record: 
<selected option>. The polygon feature type remains active for data capture until another tool

is activated. The Polygon button allows capture on the screen with the pen or mouse but not with
incoming GPS coordinates.

Tap / Left click: adds vertex into the edited layer at the tapped location
Drag:  adds vertex into the edited layer at the tapped location using crosshairs
Tap and hold / Right click: displays the Context menu

Context menu

Undoes the last edit made to a feature

Opens the New vertex panel

Opens the Modify panel

Activates the multipolygon feature type for data capture

Undoes all edit made to a feature

Creates the polygon or multipolygon feature

Troubleshooting
The polygon feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is POLYGON, anyway the following
cases are possible:

1. If the active layer is a POLYGON feature layer but the editing is turned off or the layer locked
on the Layer Manager the following message box appears to enable editing in the active layer:
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2. If the active layer is a POLYGON feature layer but the edited layer is a point or line feature
layer (or a data table or a text file) the following message box appears:

3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New
work layer panel appears to select an existing layer from the project or create a new one:
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Available in

 = new feature Basic Advanced Professional

Availability of the "Polygon" tool in
different editions

4.2.4 Drawing sub-menu

This sub-menu is accessible in the Edit menu and contains the following items:

 Free Line

 Free Polygon

 Rectangle

 Circle

 Ellipse

Drawing sub-menu (Mobile)
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Drawing sub-menu (Desktop)

4.2.4.1 Free Line

 Free Line
Activates the freehand line feature type for data capture. Tap the map to add the vertices of a new
line or polyline feature into the edited layer then Tap and hold / Right click to open the context
menu and select Create to create the feature. Once you selected the Create option in the context
menu DigiTerra Explorer proceeds to capture attributes according to the Settings > Record > New
record: <selected option>. The freehand line feature type remains active for data capture until

another tool is activated. The Free Line button allows capture on the screen with the pen or mouse
but not with incoming GPS coordinates.

Tap / Left click: adds vertex into the edited layer at the tapped location one by one
Drag:  adds vertices continuously into the edited layer at the tapped location
Tap and hold / Right click: displays the Context menu
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Context menu

Undoes the last edit made to a feature

Opens the New vertex panel

Opens the Modify panel

Activates the multiline feature type for data capture

Undoes all edit made to a feature

Creates the line or multiline feature

Troubleshooting
The line feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is LINE, anyway the following cases are
possible:

1. If the active layer is a LINE feature layer but the editing is turned off or the layer locked on the
Layer Manager the following message box appears to enable editing in the active layer:

2. If the active layer is a LINE feature layer but the edited layer is a point or polygon feature layer
(or a data table or a text file) the following message box appears:
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3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New
work layer panel appears to select an existing layer from the project or create a new one:

Available in

 = new feature Basic Advanced Professional

Availability of the "Free Line" tool in
different editions

Captured polyline w ith the Free line tool
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4.2.4.2 Free Polygon

 Free Polygon
Activates the freehand polygon feature type for data capture. Tap the map to add the vertices of a
new polygon feature into the edited layer then Tap and hold / Right click to open the context menu
and select Create to create the feature. Once you selected the Create option in the context menu
DigiTerra Explorer proceeds to capture attributes according to the Settings > Record > New record: 
<selected option>. The freehand polygon feature type remains active for data capture until

another tool is activated. The Free Polygon button allows capture on the screen with the pen or
mouse but not with incoming GPS coordinates.

Tap / Left click: adds vertex into the edited layer at the tapped location one by one
Drag:  adds vertices continuously into the edited layer at the tapped location
Tap and hold / Right click: displays the Context menu

Context menu

Undoes the last edit made to a feature

Opens the New vertex panel

Opens the Modify panel

Activates the multipolygon feature type for data capture

Undoes all edit made to a feature

Creates the polygon or multipolygon feature

Troubleshooting
The polygon feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is POLYGON, anyway the following
cases are possible:



128 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

1. If the active layer is a POLYGON feature layer but the editing is turned off or the layer locked
on the Layer Manager the following message box appears to enable editing in the active layer:

2. If the active layer is a POLYGON feature layer but the edited layer is a point or line feature
layer (or a data table or a text file) the following message box appears:

3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New
work layer panel appears to select an existing layer from the project or create a new one:
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Available in

 = new feature Basic Advanced Professional

Availability of the "Free Polygon" tool in
different editions

Captured polygon with the Free Polygon tool
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4.2.4.3 Rectangle

 Rectangle
Activates the rectangle polygon feature type for data capture. Tap the map to add two vertices:
top left (1) and bottom right (2) vertices of a new polygon feature into the edited layer using
crosshairs. Once you placed the second vertex on the map DigiTerra Explorer proceeds to capture
attributes according to the Settings > Record > New record: <selected option>. The rectangle

polygon feature type remains active for data capture until another tool is activated. The Rectangle
button allows capture on the screen with the pen or mouse but not with incoming GPS coordinates.

Tap / Left click: adds two vertices: top left (1) and bottom right (2) vertices of a rectangle into the
edited layer at the tapped location one by one then creates the feature
Drag:  adds two vertices: top left (1) and bottom right (2) vertices of a rectangle continuously into
the edited layer using crosshairs then creates the feature
Tap and hold / Right click: displays the Context menu

Context menu

Undoes the last edit made to a feature

Undoes all edit made to a feature

Troubleshooting
The polygon feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is POLYGON, anyway the following
cases are possible:

1. If the active layer is a POLYGON feature layer but the editing is turned off or the layer locked
on the Layer Manager the following message box appears to enable editing in the active layer:

2. If the active layer is a POLYGON feature layer but the edited layer is a point or line feature
layer (or a data table or a text file) the following message box appears:
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3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New
work layer panel appears to select an existing layer from the project or create a new one:

Available in

 = new feature Basic Advanced Professional

Availability of the "Free Polygon" tool in
different editions

Rectangle
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Rectangle context menu

4.2.4.4 Circle

 Circle
Activates the circle polygon feature type for data capture. Tap the map to add two vertices: top
left (1) and bottom right (2) vertices of a new polygon feature into the edited layer using crosshairs.
Once you placed the second vertex on the map DigiTerra Explorer proceeds to capture attributes
according to the Settings > Record > New record: <selected option>. The circle polygon

feature type remains active for data capture until another tool is activated. The Circle button allows
capture on the screen with the pen or mouse but not with incoming GPS coordinates.
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Tap / Left click: adds two vertices: top left (1) and bottom right (2) vertices of a circle into the
edited layer at the tapped location one by one then creates the feature
Drag:  adds two vertices: top left (1) and bottom right (2) vertices of a circle continuously into the
edited layer using crosshairs then creates the feature
Tap and hold / Right click: displays the Context menu

Context menu

Undoes the last edit made to a feature

Undoes all edit made to a feature

Troubleshooting
The polygon feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is POLYGON, anyway the following
cases are possible:

1. If the active layer is a POLYGON feature layer but the editing is turned off or the layer locked
on the Layer Manager the following message box appears to enable editing in the active layer:

2. If the active layer is a POLYGON feature layer but the edited layer is a point or line feature
layer (or a data table or a text file) the following message box appears:
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3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New
work layer panel appears to select an existing layer from the project or create a new one:

Available in

 = new feature Basic Advanced Professional

Availability of the "Free Polygon" tool in
different editions

Circle
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Circle context menu

4.2.4.5 Ellipse

 Ellipse
Activates the ellipse polygon feature type for data capture. Tap the map to add two vertices: top
left (1) and bottom right (2) vertices of a new polygon feature into the edited layer using crosshairs.
Once you placed the second vertex on the map DigiTerra Explorer proceeds to capture attributes
according to the Settings > Record > New record: <selected option>. The ellipse polygon

feature type remains active for data capture until another tool is activated. The Ellipse button allows
capture on the screen with the pen or mouse but not with incoming GPS coordinates.
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Tap / Left click: adds two vertices: top left (1) and bottom right (2) vertices of a ellipse into the
edited layer at the tapped location one by one then creates the feature
Drag:  adds two vertices: top left (1) and bottom right (2) vertices of a ellipse continuously into the
edited layer using crosshairs then creates the feature
Tap and hold / Right click: displays the Context menu

Context menu

Undoes the last edit made to a feature

Undoes all edit made to a feature

Troubleshooting
The polygon feature type for data capture is only available when editing is turned on for the active
layer on the Layer Manager and the layer's feature type is POLYGON, anyway the following
cases are possible:

1. If the active layer is a POLYGON feature layer but the editing is turned off or the layer locked
on the Layer Manager the following message box appears to enable editing in the active layer:

2. If the active layer is a POLYGON feature layer but the edited layer is a point or line feature
layer (or a data table or a text file) the following message box appears:
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3. If the active layer is a raster layer or there is no vector layer on the Layer Manager the New
work layer panel appears to select an existing layer from the project or create a new one:

Available in

 = new feature Basic Advanced Professional

Availability of the "Free Polygon" tool in
different editions

Ellipse
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Ellipse context menu

4.2.5 Modify sub-menu

This sub-menu is accessible in the Edit menu and contains the following items:

 Move

 Rotate

 Scale

 New part
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 Merge

 Explode

 Flip Line

Modify sub-menu (Mobile)

Modify sub-menu (Desktop)
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4.2.5.1 Move

 Move
Moves the selected feature(s) in the edited layer. The Move tool remains active for moving the
selected feature until another tool is activated.

Tap / Left click: selects/deselects the feature on the map at the tapped location. Second Tap / Left
click on the polyline or on the polygon's boundary defines the reference point.
Drag / Left drag:  moves the selected feature, crosshairs appear
Tap and hold / Right click: opens the Offset values panel to move the selected feature based on
entered offset values

Basic Steps on how to use the Move tool
1. Select the desired feature on the map when the Move tool is active (you can also pre-select it with

the  Identify command)
> If you want to move more then one features you have to select them with the multiselection
tools

2. Select a reference point/vertex: it is suggested to select it on the boundary (line and polygon
features) with a snapped red position mark
> Open the Offset values panel, enter the offset values then tap OK to offset
> In case of moving more then one features it is necessary to select a feature from one of them
then select a reference point/vertex

3. Drag the feature to the desired position

Selected feature

Reference point
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Reference point when moving more features

Dragging
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Offset values panel
Enter the x,y directions in the current length unit with space separated values, then tap OK to offset

Moving by offset values

 = new feature Basic Advanced Professional

Availability of the "Move" tool in different
editions
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4.2.5.2 Rotate

 Rotate
Rotates the selected multipoint, polyline or polygon feature(s) in the edited layer. The Rotate tool
remains active for rotating selected feature until another tool is activated.

Tap / Left click: selects feature on the map at the tapped location, reference point appears. Second
Tap / Left click reset the position of the center point to default.
Drag / Left drag:  rotates the selected feature or moves the center point (reference point) of the
rotation, crosshairs appear
Tap and hold / Right click: opens Rotation angle panel to rotate the selected feature based on
the entered angle

Basic Steps on how to use the Rotate tool
1. Select the desired feature on the map when the Rotate tool is active (you can also pre-select it

with the  Identify command)
> If you want to rotate more then one features you have to select them with the multiselection
tools

2. Drag the reference point to the desired location, snapped red position mark can also be used
3. Use dragging or open the Rotation angle panel, enter the angle then tap OK to rotate

> In case of rotating more then one features it is necessary to select a feature from one of them
then drag the reference point to the desired location

Selected feature w ith reference point

Dragging the reference point
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Dragged reference point

  

Rotation by dragging
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Rotation angle panel
Enter the angle of the rotation to rotate the selected feature. The positive direction of rotation is
counterclockwise, zero is the North direction.

Rotation by angle

  

 = new feature Basic Advanced Professional

Availability of the "Rotate" tool in different
editions
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4.2.5.3 Scale

 Scale
Changes the size of the selected polyline or polygon feature(s) in the edited layer. The Scale tool
remains active for scaling selected feature until another tool is activated.

Tap / Left click: selects feature on the map at the tapped location, reference point appears. Second
Tap / Left click reset the position of the center point to default.
Drag / Left drag:  changes the size of the selected feature or moves the center point (reference
point) of the scaling, crosshairs appear. Dragging towards to the center point will decrease the
size of, opposite direction will increase the size of the geometry.
Tap and hold / Right click: opens Scaling factor panel to scale the selected feature based on
the entered value

Basic Steps on how to use the Scale tool
1. Select the desired feature on the map when the Scale tool is active (you can also pre-select it

with the  Identify command)
> If you want to Scale more then one features you have to select them with the multiselection
tools

2. Drag the reference point to the desired location, snapped red position mark can also be used
3. Use dragging or open the Scaling factor panel, enter the scale value then tap OK to Scale

> In case of scaling more then one features it is necessary to select a feature from one of them
then drag the reference point to the desired location

Selected feature w ith reference point

Dragging reference point
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Dragged reference point

  

Scale: decreasing by dragging
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Please note when increasing the geometry with dragging you need to tap the
screen outside of the reference point's marked area

Scale: increasing by dragging

  

Scaling factor panel
Enter the scale factor of the scaling to change the size of the selected feature. The default value is 
1, meaning that the transformation keeps the original size of the geometry.
When the scaling factor is > 1 the size of the selected feature will be increased and if the scaling
factor is < 1 the selected feature will be decreased relative to the original size.
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Scaling factor

 = new feature Basic Advanced Professional

Availability of the "Scale" tool in different
editions

4.2.5.4 New part

 New part
Allows you to add new part(s) to the geometry of a selected point, line or polygon feature in the 
edited layer. The New part tool remains active for adding new part to a selected feature until another
tool is activated.

Possible use cases
In case of point and MAP - DigiTerra vector file format the new geometry will be a multipoint
In case of line or polyline feature the new geometry will be a multiline
In case of polygon feature the new geometry will be a multipolygon

Multifeature vector geometries can be exploded into single features with the 
 Explode tool.

Tap / Left click: selects feature on the map at the tapped location then adds a vertex of the new
part
Tap and hold / Right click: displays the Editing context menu to use the Create option to update
the geometry

Selected feature
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Adding new polygon part and context menu

You can add new parts inside and also outside of the selected polygon feature
and also inside the created new part.

Island in a polygon part
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New part tool can be identify a feature for adding new part on the map when
information query property and editing is turned on for a vector layer in the Layers
panel.

 = new feature Basic Advanced Professional

Availability of the "New part" tool in
different editions

4.2.5.5 Merge

 Merge
Merges selected features of same feature type into a multifeature geometry into the edited layer.

Selected features for merging
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Question before merging features

Merged features
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 = new feature Basic Advanced Professional

Availability of the "Merge" tool in different
editions

4.2.5.6 Explode

 Explode
Explodes the selected multifeature geometry into the edited layer

Selected feature for exploding
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Question before exploding multifeature geometry

Exploded single features

 = new feature Basic Advanced Professional

Availability of the "Explode" tool in
different editions
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4.2.5.7 Flip Line

 Flip Line
Flips the vertex order in the selected polyline feature into the edited layer

Tap / Left click: selects a feature on the map at the tapped location then flips the order of the
vertices in the selected geometry in the edited layer.

Original line: the vertex order is 1 then 2 from left to right

Flipped line: the vertex order is 2 then 1 from left to right
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The Flip Line tool is useful to simply change the direction of the arrowhead in the
arrowed line types by flipping the vertex order in the geometry.

 = new feature Basic Advanced Professional

Availability of the "Flip Line" tool in
different editions

4.2.6 Edit vertex sub-menu

This sub-menu is accessible in the Edit menu and contains the following items to edit vertices in
the selected feature's geometry. In this topic we'll take a look at how you can change the vertices in
any vector geometry after you've made it. This way you can alter the shape of geometry and perform
the "fine-tune" until every vertices just right.

 Insert

 Remove

 Edit

 Generalize

Edit vertex sub-menu (Mobile)

Edit vertex sub-menu (Desktop)



157Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

 = new feature Basic Advanced Professional

Availability of the "Edit vertex" sub-menu in
different editions

4.2.6.1 Insert

 Insert
This tool is designed for quickly selecting a feature and then insert new vertices into the
existing geometry. The Insert tool remains active for adding new vertices into a selected feature
until another tool is activated.

Tap / Left click: selects feature on the map at the tapped location for vertex editing mode then
you can insert new vertices among two vertices in the selected geometry
Drag / Left drag: moves the selected vertex using crosshairs
Tap and hold / Right click: opens the New Vertex panel or the Existing Vertex panel if you started
the Tap and hold / Right click over existing vertex

Possible use cases
In case of point feature and MAP - DigiTerra vector layer format the new geometry will be a
multipoint geometry
In case of line or polyline adds new vertices into the existing geometry
In case of polygon adds new vertices into the existing geometry

Inserting new vertex
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  See also

The multipoint geometry can also be created with the Point editing tool, but you
cannot convert existing point feature to multipoint

The multipoint geometry can also be created with the  New part tool and you
can also convert an existing point feature to multipoint

The multipoint geometry can be converted from the selected existing point

features with the  Merge tool

The feature will be immediately in vertex editing mode if you pre-selected it with

the  Identify command prior to activating the  Insert tool

4.2.6.2 Remove

 Remove
Selects the feature to delete vertices from the feature's geometry. The Remove tool remains active
for removing vertices until another tool is activated.
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Tap / Left click: selects feature on the map at the tapped location for vertex editing mode then
you can remove vertices from the selected geometry
Drag / Left drag: moves the selected vertex using crosshairs
Tap and hold / Right click: opens the New Vertex panel or the Existing Vertex panel if you started
the Tap and hold / Right click over existing vertex

Removing vertex

  

See also

The feature will be immediately in vertex editing mode if you pre-selected it with

the  Identify command prior to activating the  Remove tool

4.2.6.3 Edit

 Edit
Edits the vertices of a selected geometry. The Edit tool remains active for editing the geometry of the
selected feature until another tool is activated.

Keyboard command: V

Tap / Left click: selects feature on the map at the tapped location for vertex editing mode,
selects vertex using the vertex snap
Drag / Left drag: moves the selected vertex using crosshairs
Tap and hold / Right click: opens the New Vertex panel or the Existing Vertex panel if you started
the Tap and hold / Right click over existing vertex
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Activated vertex editing mode

Vertex snap

Moving a vertex
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See also

The feature will be immediately in vertex editing mode if you pre-selected it with

the  Identify command prior to activating the  Remove tool

4.2.6.4 Existing Vertex dialog box

The Existing vertex panel enables you to update existing vertex in the selected feature's geometry
by coordinates and by GPS. It also enables you to split a polyline feature into two separate features.

This panel can be accessed only from the Editing context menu > Position menu option

Existing vertex panel
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East: Displays the current Easting coordinate of the tapped/clicked position as default. Enables you
to enter the new Easting coordinate.
North: Displays the current Northing coordinate of the tapped/clicked position as default. Enables
you to enter the new Northing coordinate.
Height: enables you to enter the Height of the new vertex that you can save with the [Insert Vertex]
button if the the layer can store 3D-coordinate

 Modify  - updates the vertex with the modified coordinates in the selected geometry

 GNSS  - takes over the Easting, Northing, Height coordinates of the current GNSS position to
update a vertex into the geometry at the current GPS position

 Delete  - Removes the selected vertex from the selected feature's geometry

 Cancel  - Closes the panel

 Splitting Polyline  - Splits the polyline geometry at the selected vertex into two separate features.
Disabled when working with point and polygon features.

Height (Z value) can be stored in MAP, SHP, DXF layer file formats. Please also
have a look at this tutorial here: http://forum.digiterra.hu/viewtopic.php?f=60&t=302

4.2.6.5 Generalize

 Generalize
Enables you to select the desired feature for vertex editing to generalize the geometry and store the
results into the edited layer. The Generalize tool remains active for generalizing the geometry of the
selected item until another tool is activated.

http://forum.digiterra.hu/viewtopic.php?f=60&t=302
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Tap / Left click: selects an item on the map then opens the Generalize - distance panel to enter
the distance of the generalization in the current length unit.

Generalize

 OK  - Opens the Generalize panel (see below)

Settings> Record: Length unit

Generalize panel
Appears prior to storing the changes in the feature's geometry.

 Yes  -  Stores the generalized geometry into the edited layer
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 No  - Closes the Generalize panel

Results of the generalization in the Generalize message box

  

4.2.7 New vertex dialog box

The New vertex panel enables you to add vertex into the selected feature's geometry between two
vertices by coordinates and by GPS. It also enables you to split a polyline feature into two separate
features. When using it from the context menu of the Query menu > Measuring tools you can add
the vertex to the red editing line to measure on the map.

This panel can be accessed from the followings
1. From the Editing context menu > Position menu option
2. With the Insert, Remove, Edit vertex editing tools

New vertex panel
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East: Displays the current Easting coordinate of the tapped/clicked position as default. Enables you
to enter the new Easting coordinate.
North: Displays the current Northing coordinate of the tapped/clicked position as default. Enables
you to enter the new Northing coordinate.
Height: enables you to enter the Height of the new vertex that you can save with the [Insert Vertex]
button if the the layer can store 3D-coordinate

 Insert Vertex  - adds the vertex with the modified coordinates into the selected geometry

 GNSS  - takes over the Easting, Northing, Height coordinates of the current GNSS position to add a
vertex into the geometry at the current GPS position

 Cancel  - Closes the panel

 Splitting Polyline  - Splits the polyline geometry at the tapped position between two vertices into two
separate features. Disabled when working with point and polygon features. Hidden when you opened
the New vertex panel from the Editing context menu.

Height (Z value) can be stored in MAP, SHP, DXF layer file formats. Please also
have a look at this tutorial here: http://forum.digiterra.hu/viewtopic.php?f=60&t=302

http://forum.digiterra.hu/viewtopic.php?f=60&t=302
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4.2.8 Modify dialog box

The Modify panel contains the following controls:

The Modify panel

Angle: Angle between the last two (current and the previous) segments (4-5 and 5-6). If there is no
two segments the angle is the azimuth (0 = NORTH, 90 = EAST). The Angle can be modified with
the  Modify  or a new vertex can be added to the polyline, polygon with the  Add 

Distance: Length of the last (current) segment (5-6). You can enter a new value to modify the length
of the current segment by tapping/clicking on the  Modify  button.

Connection: Connection angle if the last vertex (6) connects to a section of a polyline or polygon,
anyway 0. It can be modified by entering a new value and tapping/clicking on the  Modify  button.
After modification the Angle and the Distance values change; this can be achieved to connect to
an existing section 90 degrees (perpendicular).

 Modify  - Modifies the position of the last vertex (6) based on the Angle and Distance

 Add  - Adds a new vertex to the polyline or polygon based on the Angle and Distance

 Offset  - Parallel shifts the polyline. In case of positive value shifts to the left, right for negative
values, accordance with the direction of travel

4.2.9 Erase

 Erase
Deletes the selected feature. The Erase tool remains active for deletion until another tool activated.

Keyboard command: E
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Tap / Left click: selects the feature on the map at the tapped location then displays a message box
to confirm the deletion
Drag / Left drag:  scrolls the map (dynamic pan)
Tap and hold then drag/ Right drag: dynamic zoom

Erase

 OK  - Deletes the selected feature

 Cancel  - Closes the Message box

Erase tool can identify a feature for deletion in the edited layer when information
query property is turned on for the vector layer in the Layers panel

4.2.10 Undo

 Undo
Undoes the last edit made to a feature

A deleted and restored feature
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The operations performed on multiple objects at the same time can not be
undone. For example when you selected more than one features with the 

multiselection tools and then used the  Erase command.

4.2.11 Edited layer properties

In this topic we'll take a look at how you can make a layer editable.

Possible use cases
1. If you want to edit an existing feature in a layer and you have an active vector layer in the Layers

Manager DigiTerra Explorer asks you before you could do anything

Making a layer editable



169Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

  

2. If you want to capture a new feature, but there is no editable layer, or the active layer is not a
vector layer in your project the following panel appears

New work layer

 New layer  - Open the Create Layer panel to create a new layer

Select a loaded layer: - Lists the layers in the current project to select one for editing

 Load layer  -  Opens the Append Layer panel to add an existing layer to the mapping project for
editing



170 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

 OK  - Active once you have selected a layer from the list from the "Select a loaded layer" drop-
down

 Cancel  - Closes the panel

4.2.12 Using crosshairs

Crosshairs appears during the editing process when using the drag technique.

Crosshairs display when dragging

4.3 View menu

The View menu contains the following options and sub-menu for map view-related operations

 Dynamic Zoom

 Zoom Window

 GNSS position
o Zoom to

 Pan

 Scroll

 Rotate

 3D view (Desktop function)

 Plan view

 Scale

 Show in Google Maps

 Show in Bing Maps (Desktop function)
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 Refresh map view

View menu (Mobile)

View menu (Desktop)
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4.3.1 Dynamic Zoom

 Dynamic Zoom
Zooms in/out the map using dragging with the pen or the mouse. The Dynamic Zoom button remains
active for zooming until another tool is activated.

Keyboard command: Z

Tap / Left click: centers the map on the tapped location
Drag up/down:  dynamically zooms in/out on the map
Tap and hold / Right click: dynamically pans the map

 = new feature Basic Advanced Professional

Availability of the "Dynamic Zoom"
command in different editions

Usage of the Dynamic zoom

4.3.2 Zoom Window

 Zoom Window
Zooms in to a rectangular area using dragging. The Zoom Window button remains active for zooming
until another tool is activated.

Keyboard command: W

Tap / Left click: centers the map on the tapped location
Drag: draws a window on the map using crosshairs and zooms in to that rectangular area
Tap and hold / Right click: dynamically pans the map

 = new feature Basic Advanced Professional
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Availability of the "Zoom Window"
command in different editions

Using the Zoom Window command

   

4.3.3 GNSS Position

 GNSS position
Centers the map on the current GPS position. Useful when using the Display option = Display
position on the Settings > GNSS tab.
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4.3.4 Zoom to sub-menu

This sub-menu is accessible in the View menu and contains the following items:

 Full Extents

 Active Layer

 Selected Feature

 Bookmark

 Last View

 Next View

Zoom to sub-menu (Mobile)

Zoom to sub-menu (Desktop)
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4.3.4.1 Full Extents

 Full Extents
Zooms to the full extent of all the layers in the map. Equivalent button can be found on the Pan
frame at the top right corner.

Full extent: displays the map to the extents of all vector and raster layers used in the current
project

Keyboard command: N

 = new feature Basic Advanced Professional

Availability of the Zoom to "Full Extents"
command in different editions

4.3.4.2 Active Layer

 Active Layer
Zooms to the extent of the active layer

Usage
1. Select a layer on the Layers panel (this will be the active layer)
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2. Click/tap on the Active Layer button to zoom to the active layer's extent

Selected active layer on the Layers panel

 = new feature Basic Advanced Professional

Availability of the Zoom to "Active Layer"
command in different editions

4.3.4.3 Selected Feature

 Selected Feature

Zooms to the extent of the selected feature that you have selected with the  Identify button.

Zooming to the selected feature
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 = new feature Basic Advanced Professional

Availability of the Zoom to "Selected
Feature" command in different editions

4.3.4.4 Bookmark

 Bookmark
Opens the Bookmarks panel to create a spatial bookmark or to zoom to an existing spatial
bookmark.

Spatial bookmark: stored center position, current map scale and rotation parameters

Keyboard command: B

Bookmark
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 Store   - Saves the spatial bookmark with the name you entered

 Delete  - Removes the selected spatial bookmark

The scale, center position of the map, map rotation and bookmarks can be stored
in the DigiTerra Explorer Map file (.EXP) or DigiTerra Map Pack file (.DMP)
formats.

 = new feature Basic Advanced Professional

Availability of the "Bookmark" tool in
different editions

4.3.4.5 Last view / Next view

 Last View
Zooms back to the previous extent and rotation you were viewing. DigiTerra Explorer stores the last
32 extents you have looked at since opening the map, so you can use this tool along with the Next
view tool to retrace your last 32 steps.

 Next View
Zooms forward to the next extent and rotation in the map view history. DigiTerra Explorer stores the
last 32 extents you have looked at since opening the map, so you can use this tool along with the
Last View tool to retrace your last 32 steps.

 = new feature Basic Advanced Professional

Availability of the "Last view / Next view"
tool in different editions
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4.3.5 Pan

 Pan
Pans the map using the pen or the cursor in the Desktop version. The Pan button remains active for
panning the map until another tool is activated.

Keyboard command: P

Tap / Left click: centers the map to the tapped location
Drag:  moves the map in any direction: horizontally, vertically, or diagonally. The view scale of the
map remains the same, as does its orientation (rotation) in space.
Tap and hold / Right click: dynamically zooms the map

 = new feature Basic Advanced Professional

Availability of the "Pan" command in
different editions

4.3.6 Scroll

 Scroll
Dynamically moves the map in the opposite direction of the movement using the pen or the cursor in
the Desktop version . The Scroll button remains active until another tool is activated.

Keyboard command: S

Tap / Left click: centers the map on the tapped location
Drag:  moves the map in any direction in the opposite direction of the movement: horizontally,
vertically, or diagonally. The view scale of the map remains the same, as does its orientation
(rotation) in space.
Tap and hold / Right click: dynamically zooms the map

 = new feature Basic Advanced Professional

Availability of the "Scroll" command in
different editions

4.3.7 Rotate

 Rotate
Rotates and tilts the map. The Rotate button remains active until another tool is activated.

Keyboard command: R

Tap / Left click: centers the map on the tapped location
Drag:  Rotates and tilts the map. The view scale of the map remains the same.
Tap and hold / Right click: dynamically zooms the map

Rotate
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 = new feature Basic Advanced Professional

Availability of the "Rotate" command in
different editions

4.3.8 3D view

 3D view
Switches the map into 3D view and back to plan view. Available in the Desktop version.

An overview is available about 3D related features at http://forum.digiterra.hu/
viewtopic.php?f=59&t=310

 = new feature Basic Advanced Professional

Availability of the "3D view" command in
different editions

4.3.9 Plan view

 Plan view
Changes the map view back to the default vertical orthographic view and sets the North direction (Y
axis) to upwards. Displays the map from overhead (without perspective).

Plan view

http://forum.digiterra.hu/viewtopic.php?f=59&t=310
http://forum.digiterra.hu/viewtopic.php?f=59&t=310
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 = new feature Basic Advanced Professional

Availability of the "Rotate" command in
different editions

4.3.10 Scale

 Scale
Opens the Set Scale panel to change the scale of the map based on the value you can enter into
the text box. Default value is the current scale.

Set scale
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 = new feature Basic Advanced Professional

Availability of the "Rotate" command in
different editions

4.3.11 Show in Google Maps

 Show in Google Maps
Displays the center position of the map in Google Maps in the default web browser

Show in Google Maps

   

 = new feature Basic Advanced Professional

Availability of the "Show in Google Maps"
command in different editions

4.3.12 Show in Bing Maps

 Show in Bing Maps
Displays the center position of the map in Bing Maps in the default web browser. Available in the
Desktop version.

Show in Bing Maps
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 = new feature Basic Advanced Professional

Availability of the "Show in Bing Maps"
command in different editions

4.3.13 Refresh map view

 Refresh map view
Redraws the map view and clears all editing lines.

Clears the cached content and re-download the tiles covered by the boundaries of the map view at
the current scale when using WMS, TMS background maps. Useful when the downloaded tiles are
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corrupt, or the cached map tiles are not-up-to-date. 

4.4 Query menu

The Query menu contains the following options and sub-menu for query-related operations

 Identify
o Select

 Search

 Tables

 Measure

 Free measure

 Radius measure

View menu (Mobile)

View menu (Desktop)
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4.4.1 Identify

 Identify
Activates the Identify tool. Displays attributes for any feature you tap/click according to the Settings
at Record tab > Info tool: <selected option>. It also selects and deselects the feature. The

identify option (  button before the layer name) must be turned on for the layer in the Layers panel
for a feature in that layer to be identified. The Identify button remains active until another tool is
activated.

Keyboard command: I

Tap / Left click: identifies/selects the feature then displays the attributes of the feature according to
the Settings at Record tab > Info tool: <selected option>

Drag: scrolls the map
Tap and hold / Right click: activates the Dynamic Zoom command while holding down

Identify
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The attributes of the queried and selected feature can be edited in the Record
panel

4.4.2 Select sub-menu

With the tools of this sub-menu you can select many features at the same time. The Selection
settings panel allows you to select multiply features on the map by geometry or by a layer of the
map view. The Selection tools remain active for selecting features until another tool is activated. This
menu is accessible in the Query menu and contains the following items:

 Advanced Selection

 Select by point

 Select by line

 Select by polygon

 Select by rectangle

 Select by circle

Select sub-menu (Mobile)

Select sub-menu (Desktop)



187Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

Selected features can be combined with the following functions

Export selected features into File or Database on the Layers panel > selected active layer > 
 Layer export
Change Layer: copies/moves the selected feature(s) into the edited layer
Move, Rotate or Scale selected features
Merge selected features
Explode selected features
Erase selected features
Create buffer zone around the selected features
Polygon Delineation and creating topology

 = new feature Basic Advanced Professional

Availability of the "Select" sub-menu and
its tools in different editions

4.4.2.1 Advanced Selection

 Advanced Selection
Opens the Selection settings panel with its default settings. The Selection settings panel can be
dragged while any tool from the Select sub-menu is active.

Selection settings panel

Selection settings panel

Layer: Lists the selectable vector feature layers of the map view. Enables you to select the desired
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layer in which you can select features. Default layer is the top item in the list.

Geometry

Point: Selects features by point. Equal with the  Select by point tool. Default option.

Line: Selects features by line. Equal with the  Select by line tool.

Polygon: Selects features by polygon. Equal with the  Select by polygon tool.
Within polygon: Selects features within the polygon

Rectangle: Selects features by rectangle. Equal with the  Select by rectangle tool.
Within rectangle: Selects features within the rectangle

Circle: Selects features by circle. Equal with the  Select by circle tool.
Within circle: Selects features within the circle

Mode
New selection: Creates a new selection
Add: Adds the result(s) of the current selection to previous selection(s). Press and hold the
Shift key while making a selection to temporarily enter add mode. Default option.
Subtract: Subtracts the result(s) of the current selection from the precious selection(s). Press
and hold the Ctrl key while making a selection to temporarily enter subtract mode.

 Clear  - Clears the the current selection in the source layer

 Inverse  - Creates the inverse selection of the currently selected features in the source layer

 All  - Selects all features in the source layer

Select by layer... - Selects features in the source layer by using overlapping geometries in the
selection layer of the map view.

Selecting features on the map

Context menu

Undoes the last edit made to a selection

Opens the New vertex panel

Opens the Modify panel

Activates the multiline feature type for data capture
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Undoes all edit made to a feature

Selects the feature

4.4.2.2 Select by point

 Select by point
Opens the Selection settings panel with Geometry = Point option to select multiply features in a
layer. The Select by point button remains active until another tool is activated.

Tap / Left click: selects item on the map at the tapped location
Drag:  adds selection point to the map at the tapped location with crosshairs
Tap and hold / Right click: opens the Advanced Selection panel

Using Hotkeys
Press and hold the Shift key while making a selection to temporarily enter add mode.
Press and hold the Ctrl key while making a selection to temporarily enter subtract mode.

Select by point

4.4.2.2.1  Advanced selection dialog box

The Advanced Selection dialog is used to select a feature in a layer by given coordinates or by
GPS. You can access this dialog when using the Select by point tool using tap and hold or right
click in the Desktop.

Advanced Selection dialog

East: Displays the current Easting coordinate of the tapped/clicked position. Enables you to enter
the new Easting coordinate.
North: Displays the current Northing coordinate of the tapped/clicked position. Enables you to enter
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the new Northing coordinate.
Height: Displays the height of the tapped/clicked position

 Select by coordinates  - Selects feature by entered coordinates

 GNSS  - takes over the Easting, Northing, Height coordinates of the current GNSS position and
selects the feature at the current GPS position

 Cancel  - Closes the panel

4.4.2.3 Select by line

 Select by line
Opens the Selection settings panel with Geometry = Line option to select multiply features in a
layer. The Select by line button remains active until another tool is activated.

Tap / Left click: adds selection point/vertex on the map at the tapped location
Drag:  adds selection point/vertex to the map at the tapped location with crosshairs
Tap and hold / Right click: displays the Context menu to select features by using the Select
option in the menu

Selecting features on the map

Context menu

Undoes the last edit made to a selection

Opens the New vertex panel

Opens the Modify panel

Activates the multiline feature type for data capture

Undoes all edit made to a feature

Selects the feature

Using Hotkeys
Press and hold the Shift key while making a selection to temporarily enter add mode.
Press and hold the Ctrl key while making a selection to temporarily enter subtract mode.

Select by line
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4.4.2.4 Select by polygon

 Select by polygon
Opens the Selection settings panel with Geometry = Polygon option to select multiply features in
a layer. The Select by polygon button remains active until another tool is activated.

Tap / Left click: adds selection point/vertex on the map at the tapped location
Drag:  draws a rectangle on the map at the tapped locations with crosshairs, then selects the
covered features
Tap and hold / Right click: displays the Context menu to select features by using the Select
option in the menu

Using Hotkeys
Press and hold the Shift key while making a selection to temporarily enter add mode.
Press and hold the Ctrl key while making a selection to temporarily enter subtract mode.

Selecting features on the map

Context menu

Undoes the last edit made to a selection

Opens the New vertex panel

Opens the Modify panel

Activates the multiline feature type for data capture

Undoes all edit made to a feature

Selects the feature
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Select by polygon

4.4.2.5 Select by rectangle

 Select by rectangle
Opens the Selection settings panel with Geometry = Rectangle option to select multiply features
in a layer. The Select by rectangle button remains active until another tool is activated.

Tap / Left click: adds two vertices: top left (1) and bottom right (2) vertices of a rectangle
Drag: draws a rectangle on the map at the tapped locations with crosshairs, then selects the
covered features
Tap and hold / Right click: displays the Context menu to select features by using the Select
option in the menu

Using Hotkeys
Press and hold the Shift key while making a selection to temporarily enter add mode.
Press and hold the Ctrl key while making a selection to temporarily enter subtract mode.

Selecting features on the map

Context menu

Undoes the last edit made to a selection

Opens the New vertex panel

Opens the Modify panel

Activates the multiline feature type for data capture

Undoes all edit made to a feature

Selects the feature



193Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

Select by polygon

4.4.2.6 Select by circle

 Select by circle
Opens the Selection settings panel with Geometry = Circle option to select multiply features in a
layer. The Select by rectangle button remains active until another tool is activated.

Tap / Left click: adds two vertices: top left (1) and bottom right (2) vertices of the radius of a circle
Drag: draws a circle on the map at the tapped locations with crosshairs, then selects the covered
features
Tap and hold / Right click: displays the Context menu to select features by using the Select
option in the menu

Using Hotkeys
Press and hold the Shift key while making a selection to temporarily enter add mode.
Press and hold the Ctrl key while making a selection to temporarily enter subtract mode.

Selecting features on the map

Context menu

Undoes the last edit made to a selection

Opens the New vertex panel

Opens the Modify panel

Activates the multiline feature type for data capture

Undoes all edit made to a feature
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Selects the feature

Select by polygon

4.4.3 Search

 Search

Opens the Search panel to find or select features. The identify option (  button before the layer
name) must be turned on for the layer in the Layers panel for a feature in that layer to be identified. 

Keyboard command: F

Search

Search panel

 1  - Use the Input box to type in the value (with spaces between the values) that you want to search
for in the attribute tables of the vector layers in the map. You can use the drop-down the list to
retrieve the previous keywords.

 2  -  Find  button: executes the search expression. DigiTerra Explorer examines full comparison in
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case of number and partial comparison in case of texts. The result list will contain those records
where all of the keywords occur. 

 3  - Results: this table displays all of the found features

Header of the results: orders the search records by Layer, Distance and Hit
Result list: Lists the records the search tool found. You can tap on the row to select the record
and pan the map to record's geometry.
Double tap on the row: selects the record and zooms the map to the extent of the record's
geometry
You can tick the check-box before the result item to select it on the map view

Layer: the source of the layer
Dist: distance between the center of the map and the found geometry in current map unit
Hit: found data field with the cell value

 = new feature Basic Advanced Professional

Availability of the "Search" tool in different
editions

4.4.4 Tables

 Tables
Opens the Record panel. It can also be accessed by using the Record panel button on the Pan
frame.

Keyboard command: C

All details of the Record panel can be found within the Attribute Properties topic

4.4.5 Measure

 Measure
Measures positions, distances, area and angle in the map view by added vertices on the map at the
tapped locations (in point mode). Display the Editing context menu and tap on the Finish option to
end and view the measurements in the Geometry panel. The Measure tool remains active for
measuring until another tool is activated.

Keyboard command: M

Tap / Left click: adds vertex on the map at the tapped location.
Drag:  adds vertex on the map at the tapped location with displayed crosshairs.
Tap and hold / Right click: displays the Editing context menu to finish the measurement and open
the Geometry panel.

Vertices on the map view for the measurement and the measurement information in the Geometry

panel
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4.4.6 Free measure

 Free measure
Measures positions, distances, area and angle in the map view in freehand mode. Display the 
Editing context menu and tap on the Finish option to end and view the measurements in the
Geometry panel. The Free measure tool remains active for measuring by freehand line until another
tool is activated.

Tap / Left click: adds vertex on the map at the tapped location.
Drag:  adds vertices on the map at the tapped locations.
Tap and hold / Right click: displays the Editing context menu to finish the measurement and open
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the Geometry panel.

Vertices on the map view for a freehand measurement

 = new feature Basic Advanced Professional

Availability of the "Measure" tool in
different editions

4.4.7 Radius measure

 Radius measure
 The Radius measure tool remains active for measuring radial distances until another tool is
activated.

Tap / Left click: adds vertex (center point and end point of the radius) on the map at the tapped
location then opens the Geometry panel.
Drag:  draws circle on the map at the tapped locations with displayed crosshairs then creates the
feature.

 = new feature Basic Advanced Professional

Availability of the "Radius measure" tool in
different editions

4.5 GNSS menu

The GNSS menu contains the following options and sub-menu for GNSS-related operations:

 Survey

 Target
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 Status
o GNSS Tools

GNSS menu (Mobile)

GNSS menu (Desktop)

4.5.1 Survey

 Survey

Possible use cases
1. Connects the application to the GNSS receiver according to the Serial port, NTRIP, Antenna

and Startup commands settings then opens the GNSS surveying panel to capture incoming
GPS positions as point, line or polygon features into vector feature layers.

2. If there is no editable layer in the Layer Manager the New work layer dialog appears to select an
existing or create a new vector feature layer before connecting to the GNSS receiver

Keyboard command: G

GNSS Surveying
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1.  GPS satellite button: indicates the GPS port reading. Flashing when the GPS connection
was success.

2. GNSS Survey panel: the description can be found below...
3. GNSS status information

GNSS Surveying panel

GNSS Surveying panel

Appearance modes and controls of the panel
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 - minimizes the panel to Mode "A"

 - maximizes the panel to Mode "A" + Mode "B" + Mode "C"

 - shows the default size of the panel as Mode "B" 

 - closes the panel, but the started data capture(s) doesn't stop in the relevant layers

Displayed controls in Mode "A":

1. Record > Stop toggle button: starts data capture in the selected layer (see the layer list at the
left hand side in figure - Mode "B")

2. Stop > Record toggle button: stops data capture and creates the geometry then proceeds to
capture attributes according to the Settings > Record > New record: <selected option>

3. Pause > Continue toggle button:  pauses data capture in the selected layer. Switches on
automatically in averaging mode and when you start or stop surveying a subpolygon.

4. Continue > Pause toggle button: continues data capture in the selected layer

5. Undo last vertex: deletes the last captured vertex

Displayed further controls in Mode "B":

1. Type: displays the feature type/method that DigiTerra Explorer can capture into the selected
layer. If the selected layer is a multi-feature type layer = namely more than one feature type
stored in the same layer, you can capture different feature types also as:
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o N/A: means you have to select a feature type. Appears when working with DBF, TAB or TXT

files.
o Point: captures point feature type

o Line: captures line feature type

o Polygon: captures polygon/multipolygon feature type

o Points: captures point features continuously. The attribute record of the new geometry appears

to the first and then to every hundredth point features as default. The only exceptional case
when the "No panel" option set under Settings > Record > New record.

More than one feature types can be selected at the Type option above only for
DGN, DXF and MIF file formats, in that special case when mixed feature types
stored in the layer inherently. Otherwise it is not allowed in DigiTerra Explorer to
store more than one feature types in the same vector feature layer.

2. Start/Stop subpolygon toggle button:

o  Activate subpolygon survey: activates subpolygon survey, Pause toggle button

switches into continue mode. The data capture of the subpolygon can be started by tapping /
clicking on the Continue button.

o  Stop subpolygon survey: closes the data capture of the subpolygon, Pause toggle

button switches into continue mode. The data capture of the 'main' polygon can be started by
tapping / clicking on the Continue button.

3.   Close to nearest  - closes the polygon geometry in the current data capture to adjacent polygon
features and creates a common boundary between them. The data capture process can only be
closed when the nearest vertex will be within 5 meters to the adjacent polygon boundary.

4. Delete all vertices: deletes all captured vertices in the current data capture

5. Layer list: lists all editable = unlocked layers from the Layer Manager. Enables you to tap / click
on the layer's name to select it for capturing data. GPS survey can be done simultaneously in the
listed layers.

Displayed further controls in Mode "C": these options below related to the data capture process in
the selected layer

1. Right/Left: horizontally offsets continuously captured GPS positions to the right, in case of
negative value offsets to the left

2. Forward/Back: horizontally offsets continuously captured GPS positions forward, in case of
negative value backward
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3. Up/Down: vertically offsets captured GPS positions upwards, in case of negative value
downwards

4. [ ] Mean: Activates stop & go measurement mode when checked anyway the software captures
continuously. Unchecked as default. Enables position averaging. Enter the number of positions to
calculate the averaged Easting, Northing (Latitude, Longitude) coordinates.

The coordinate of the averaged GPS position calculated by the following formula:

Easting/Longitude coordinate= (X
1
 + X

2
 + X

3
 +...+ X

n
)/n

Northing/Latitude coordinate= (Y
1
 + Y

2
 + Y

3
 +...+ Y

n
)/n

where n: meaning value

5. Skip: enables you to control the number of omitted positions between two captured positions

6. Distance: enables you to control the data capture with a distance based filter. If the distance
between the last captured position and the current position is less than this value DigiTerra
Explorer omits the incoming GPS position.

4.5.2 Target

 Target
Activates the Target tool. The Target tool remains active until you deactivate it by tapping on the
Target's position again.

Keyboard command: T

Tap / Left click: Sets the location you tap to be the current destination for navigation while the
Navigate to Target tool is active. Displays the "Would You like to relocate the target position
message box when the target is on the map.
Drag:  adds selection point to the map at the tapped location with crosshairs
Tap and hold / Right click: opens the Target context menu

Once the Navigate to Target tool became active DigiTerra Explorer automatically connects to the
GPS receiver.

Connecting to GPS
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The Navigate to Target tool zooms to the extent of the GPS position and the target. It can be
disabled when activating this tool.

Disable Auto Zoom to the Navigate to target tool

The Navigate to Target tool can be combined with the GPS Status panel and you can see the
following parameters of the navigation:

your current heading (blue arrow)
direction of the target (red line)
parameters of the navigation (with orange background)
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The current direction (blue line) and the direction of the target (orange line) on the Skyplot

Relocating and deactivating the target's position:

Relocating: tap on a new position on the map view and select Yes in the appeared message box
Deactivation: tap on the target button on the screen to remove it from the map then select an other
command

Relocating the Target's position to a new position

   

Deactivating the Target tool by tapping on the Target's position
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How to use the Navigate to target tool:

1. Navigate by waypoints (previously placed features in a vector layer) on the map view
2. Navigate by given coordinates
3. Navigate by data records: you can activate the Navigate to Target tool on the Record panel. Open
the Record panel, select a record then select the Navigate by record option  in the menu. This option
activates the Navigate to Target tool to the selected the record's geometry on the map view.

1. Navigate to Target by waypoints (added target at the tapping location on the map view)
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 You can access to the Target panel by using the tap and hold technique or right
click on the desktop.

2. Navigate to target by given geographical or projected coordinates

   

3. Navigate to target by given MGRS identifier
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Please, also have a look at this detailed tutorial about the MGRS identifier support
in DigiTerra Explorer here:
http://www.digiterra.hu/en/newsevents/64-digiterra-explorer-news/207-military-
grid-reference-system-in-digiterra-explorer.html

 = new feature Basic Advanced Professional

Availability of the "Navigate to target" tool
in different editions

http://www.digiterra.hu/en/newsevents/64-digiterra-explorer-news/207-military-grid-reference-system-in-digiterra-explorer.html
http://www.digiterra.hu/en/newsevents/64-digiterra-explorer-news/207-military-grid-reference-system-in-digiterra-explorer.html


208 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

4.5.2.1 Target context menu

You can access this menu by tap and hold the stylus on the screen / right click.

The Target context menu

Set Target Here: sets the target to the tapped position on the map view

Enter/Modify Target: opens the Set target panel to type the coordinates of the target

Target from Records: opens the Record panel to select the target by attribute records and then
use the Menu > Navigate by Record to set the target

Remove Target: removes the target from the map

Close menu: closes this context menu

4.5.2.2 Set target

This panel can be accessed by selecting the Enter/Modify Target option in the Target context
menu

The Set target panel
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Projected

North: Northing coordinate of the target
East: Easting coordinate of the target

 Recalculate 

- Calculates the geographical (WGS 84) coordinate when the Projected option selected
- Calculates the projected coordinate when the WGS 84 option selected

WGS 84

Lat: Latitude coordinate of the target
Lon: Longitude coordinate of the target

MGRS

Military Grid Coordinates of the Target

 Cancel  - 

 Remove target  - 

 OK  - 

4.5.3 Status

 GPS Status
Opens the GPS Status panel and activates the GPS if it wasn't active.

GPS Status panel
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The GPS Status utility allows you to quickly see if the GPS receiver is calculating a position from
the currently visible GPS constellation.

The GPS Status panel

The GPS Status panel displays the following, from left to right:

GPS status information:

8(11GPS/6GLO): shows in this example that there are 8 satellites in use and there are 11 GPS and
6 GLONASS viewable satellites
DGPS 3D: shows the type of position; following other values are possible:

Solution type:

"--- --" or "nofix" - Fixed position not available
"Fix 2D" or "Fix 3D" - Fixed 2D or 3D autonomous solution
"DGPS 3D" - Fixed differential GPS solution
"FLRTK 3D" - Real Time Kinematic (RTK) floated solution
"RTK 3D" - Real Time Kinematic (RTK) fixed solution

PDOP=2.5 - shows the current PDOP value
H=1.5 - shows the current HDOP value
V=2.0 - shows the current VDOP value

 satellite button: Shows the GPS activity. Displays when the GPS port can be opened (in case of
using correct GPS port settings). Becomes animated when the GPS connection is activated.

The current Easting, Northing GPS coordinate and the GPS status information
(number of used/viewable GPS/GLO satellites, PDOP, solution type) displayed on
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the map view at the bottom right corner.

Skyplot - shows all the satellites currently in view/use. This window allows you to monitor Signal/
Noise ratios (SNR) for received satellites. This information is shown as graphical to each satellite
with a coloured number from red to green. Each satellite is identified by its Pseudo-Random Number
(PRN), its azimuth and elevation angles on the Skyplot. The Skyplot will turn into the current
calculated direction and shows the last direction and can be combined with the Navigate to Target
function.

 - shows the satellite (PRN = 26) currently in use on channel 3
 - shows the satellite (PRN = 19) currently in view

SBAS satellites marked with "D" beside the displayed PRN number
GLONASS satellites marked with "G" beside the displayed PRN number

 - SNR (Signal/Noise ratio) range to interpret the sign quality to the displayed satellite on the
Skyplot (the greener the better).

h=146.3 - shows the calculated Height Above Ellipsoid of the current GPS position as default.
Shows the calculated Height if the geoid undulation is available and can be used with the current
GPS position.
524245.82 - shows the calculated Easting coordinates of the current GPS position in the selected
projection
139259.37 - shows the calculated Northing coordinates of the current GPS position in the selected
projection
0 m/s, 0° - shows the calculated speed in the current speed unit and the last calculated heading

 Connect  /  Disconnect  - activates the GPS receiver (opens the GPS connection) / deactivates the
GPS receiver (closes the GPS connection).

 Set  - opens the Settings panel > GPS tab to set / modify the currently used GPS related settings.

 NMEA  - displays the currently received NMEA sentences from the GPS device. Tap on the  NMEA
 button again to close the NMEA window.

 The  NMEA  button can also switches the NMEA and the TSIP or SiRF modes on
Trimble devices.

Displayed NMEA sentences in the NMEA window
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The displayed NMEA sentences can be logged in the Logger tab of the Settings
panel.

4.5.3.1 Status on the map view

GPS status information on the map view / estimated hRMS positional accuracy

  

524245.29 - Current Easting coordinate
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139257.86 - Current Northing coordinate
12(8GPS/8GLO) - Number of used satellites (number of viewable GPS/GLONASS satellites) of the
current position

PDOP2.9p F - PDOP value of the current position; F - Solution type of the current position

Solution types on the map view:

A - Autonomous solution
D - DGPS corrected solution
F - Floated RTK solution
R - Fixed RTK solution

Position accuracy on NMEA based GNSS receivers:
When the software connected to the receiver and the NMEA GST sentence is available on the
device, the GPS status area displays two position accuracy values: the horizontal and the vertical
accuracy of the current GNSS position.

hRMS=0.06m - horizontal root mean square positional accuracy
~hRMS - estimated hRMS positional accuracy displays based on vRMS = ~1.5 x hRMS when the
value of the hRMS cannot be calculated by the NMEA GST sentence

vRMS=0.40m - vertical root mean square positional accuracy

Position accuracy on Trimble (Pathfinder Tools SDK based connection: SiRF or TSIP protocol)
GNSS receivers:

Estimated accuracy on Trimble devices

As you log features, the GPS status area displays a value in the Estimated Accuracy (ESA) that
provides information about the accuracy of the current GNSS position.

The estimated accuracy value may be:



214 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

• ESA: the estimated accuracy of the current GNSS position
• PPA: the predicted accuracy after postprocessing the current GNSS position

The value shown depends on several factors, including satellite geometry and the
type of Trimble GNSS receiver that is connected.

To show the predicted postprocessed accuracy (PPA), there must be a vector layer open and the
software must be logging GNSS positions. The predicted postprocessed accuracy is a 
prediction of the accuracy that will be achieved after postprocessing. When logging H-Star or carrier
data, the predicted postprocessed accuracy value applies to all the positions collected since you
achieved lock on the required minimum number of satellites. For all other Trimble receivers, this
value applies only to the current position. The predicted postprocessed accuracy has a 68%
confidence level, which means that 68% of the time the postprocessed position will be within the
predicted postprocessed accuracy value shown when the position was collected.

Background colour of the status information:

Red: Indicates that the GPS/GNSS quality does not correspond to the used Quality settings on
the Settings panel > GPS tab or fix position not available

Green: Indicates, that the current solution type is an autonomous solution

Blue: Indicates, that the current solution type is DGNSS solution

Yellow: Float RTK

Pink: Fix RTK

4.5.4 GNSS Tools

This sub-menu is accessible in the GNSS menu and contains the following items:

 Statistics

 Log analysis

 FieldWork

 Guidance

4.5.4.1 Statistics

 GPS Statistics
Starts displaying statistical information about the current GPS positions on the map view and
activates the GPS if it wasn't active. The Statistics tool remains active until you deactivate it by
selecting it again in the menu.

The probability whether a position occurs within the horizontal confidence error ellipse is 86,6%.

Displayed GPS statistics on the map view
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645950.96: averaged Easting coordinate
242396.36: averaged Northing coordinate
170.29: averaged height

42:  averaged number of positions
dE: delta East (Easting difference of the Horizontal RMS)
dN: delta North (Northing difference of the Horozintal RMS)
dH: delta Height (Vertical RMS)
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The GPS positions can be processed to calculate and display the parameters of
the GPS statistics tool if the current GPS position is in accordance with the
conditions defined in the  Quality filter settings.

Saving Position Statistics

When you deactivate the GPS Statistics tool the Saving Position Statistics File panel appears
automatically to save the current position statistics into a LOG file. The LOG file can be added to the

map view by using the  Add layer tool.

Saving Position Statistics File panel

 = new feature Basic Advanced Professional

Availability of the "GPS Statistics" tool in
different editions

4.5.4.2 Log analysis

 GPS Log analysis
Opens the GPS log analyzer panel to analyze GPS tracklog files.

GPS Log analyzer panel

A GPS Tracklog and a polygon feature layer in the Layers panel and on the map view
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The opened GPS Log analyzer panel

Tracklog: Select a GPS logfile (or a point feature layer) that stores logged GPS positions for
processing. The default is "<nothing>".

You have to delete and re add the tracklog file to the current map view after you
changed the language of DigiTerra Explorer.
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Layer: Select a reference layer to analyze the GPS logfile by a spatial analysis. The default is
"<nothing>".

The spatial analysis works based on:
Overlay analysis: can be used with a polygon feature layer (as overlay layer).
What GPS positions are within what parcels?
When GPS positions are within what parcels?
When GPS positions enter/leave what parcels?
What is the distance along the logged GPS positions within what parcels?
How long was made that distance within what parcels?
What is the average speed within what parcels?
What was the duration of the standing within what parcels?

Proximity analysis: can be used with a point or polyline feature layer (as proximity reference
layer). This analysis can identify logged GPS positions in the tracklog (or features in a layer) that
are closest to an another feature of the proximity reference layer.
When GPS positions are closest to which point feature of the reference layer?

Interval: Set the time interval of the processing. Displays the duration of the GPS tracklog as
default.

 Settings  - Opens the Logger tab on the Settings panel.

 Export  - Opens the Export list File dialog to export the results of the analysis as a report.

TXT - Exports the results by the selected current control (Daily, By Layer, Detailed) into a Tab
limited Text file format.
XLS - Exports the results by the selected current control (Daily, By Layer, Detailed) into a Excel file
format.
HTM - Exports the results for all current control (Daily, By Layer and Detailed) into a HTML file
format.

 Covering  Calculates the covers between paths of the GPS Tracklog and stores the results of the
Cover Analysis in .TIF raster layers and .TXT text files to the overlayed polygon features of the
reference layer.

Process of the Covering Analysis: enter the path w idth and the raster field resolution
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Path width: working width in current map unit.
Raster field resolution: size of one pixel in current map unit.

Result of an analyzed GPS tracklog for a parcel
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Results of the cover analysis for the same parcel

Cover Pixel Percent Area

0 564689 66.07 564689.00

1 62179 7.28 62179.00

2 221583 25.93 221583.00

3 6147 0.72 6147.00

4 38 0.00 38.00

5 2 0.00 2.00

Controls to the details of the report

Daily: Groups GPS positions by days.
By layer: Connects/groups GPS positions to the identified features of the reference layer.
Detailed: Shows the detailed processing of GPS positions. Separates motion and standing.

Meaning of the table columns

Day: Year, month, day of the grouped GPS positions.
Feature: Identifier of a feature that contains (polygon feature reference layer) or locates closest
(point, polyline feature reference layer) the GPS positions. The data fields for identification can be
selectable.
Start: Time of the start of the movement (entering the containing polygon feature).
End: Time of finish of the movement (leaving the containing polygon feature). Equal with the Start at
the identified feature in case of proximity analysis (point or polyline feature reference layer).
Road: Total length of the movement (length within the containing polygon feature). Zero (0) at the
identified feature in case of proximity analysis (point or polyline feature reference layer).
Move: Duration of the movement (duration within the containing polygon feature).  Zero (0) at the
identified feature in case of proximity analysis (point or polyline feature reference layer).
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Speed: Average speed of the movement (average speed within the polygon feature).
Stand: Duration of the standing after the movement.

 = new feature Basic Advanced Professional

Availability of the "GPS Log analysis" tool
in different editions

4.5.4.3 FieldWork

 FieldWork
Opens the Field work panel. The FieldWork tool remains active until you deactivate it by tapping
on the Stop button.

Field work panel

The Field work panel

  

Save File panel; FieldWork in progress: displays the work w idth, the cultivated area in [m2] and the

covered area in [%]
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  zz

 New  - Creates a new Field work GPS Tracklog (.LOG) file. Fill the parameters of the Settings:
Area ID, Driver, Vehicle, Work session, Work width then tap on the  Start  button to open and save
the log file by using the Save File panel.

 Open  - Opens the Open file File panel to open an existing Field work GPS Tracklog (.LOG) file.

Covers in a Field work Tracklog

 Save as  - Opens the Save as File panel to save as the current Field work GPS Tracklog (.LOG) as
a new file with a different name.

Settings: attribute data for the current Field work GPS Tracklog file.
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Area ID: Unique identification value of the current area where you work. Textual field, e.g. "parcel
A3". Default value is empty. The software automatically increments the last value: 1, 2, 3, 4 ...; A1,
A2, A3, A4 etc.

Driver: Name of the driver. Textual field, e.g. "John Smith".
Data Field name in the General.cdt code dictionary: FieldWorkDriver

Vehicle: Type of the vehicle. Textual field, e.g. "CAT Challenger 55".
Data Field name in the General.cdt code dictionary: FieldWorkMachine

Work session: Type of the current work session. Textual field, e.g. "plowing".
Data Field name in the General.cdt code dictionary: FieldWorkProcess

The following code sets can be used to the Driver, Vehicle and Work session setting parameters
by enabling the default Gereal.cdt code dictionary on the Settings > Record tab. The default code
sets can be edited in a simple text editor.

-------------------

FieldWork code sets

-------------------

# FieldWorkDriver

1 Driver-1

2 Driver-2

3 Driver-3

# FieldWorkMachine

1 Vehicle-1

2 Vehicle-2

3 Vehicle-3

# FieldWorkProcess

1 Work session-1

2 Work session-2

3 Work session-3

Work width: Path width in meter. Default value is 5 m.

Area:

Net/Gross: The calculated net/gross covered (cultivated) area in current area unit, that calculated by
work width.
 
 Recalculate  - Recalculates the net/gross value of the covered area.

 Start  - Opens and save the log file by using the Save File panel. / Starts logging the current GPS
positions continuously in the selected Field work GPS Tracklog file.

 Map  - Switches to the map view to display the current Field work GPS Tracklog file on the map.

 Export  - Calculates the covers between paths of the Field work GPS Tracklog and stores the
results of the Cover Analysis in a TIFF raster layer in the same directory with the current Field
work GPS Tracklog file.
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 = new feature Basic Advanced Professional

Availability of the "FieldWork" tool in
different editions

4.5.4.4 Guidance

 GPS Guidance
You can define a GPS guidance layer with parallel lines above an area for GPS guidance. The GPS
Guidance tool remains active for (re)defining a new GPS guidance layer until another tool is
activated. Please note that the GPS Guidance layer does not stored to the opened project
automatically it is an auxiliary layer only.

Tap / Left click: adds vertex of the start and the end point of the baseline on the map at the tapped
location then opens the GPS Guidance panel.
Drag:  adds vertex of the baseline on the map at the tapped location with displayed crosshairs.

Defined baseline and the displayed GPS Guidance panel

Parallel guidance lines on the map view and the GPS Guidance layer in the Layers panel
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GPS guidance panel

X: Easting coordinate of the baseline's first placed vertex.
Y: Northing coordinate of the baseline's first placed vertex.
Azimuth: Direction of the baseline. 0 angle is upwards, positive direction is clockwise.
 Take GPS position and azimuth  -  Takes over the calculated GPS heading and the current GPS
position to the X, Y and Azimuth values.
Row: Distance between parallel guidance lines.
Covering: Covered area by parallel guidance lines in four direction.
Create: Stores the parallel guidance lines in the GPS guidance line feature layer. The GPS
guidance layer can be arbitrarily redefined to a new baseline.

 = new feature Basic Advanced Professional

Availability of the "GPS Guidance" tool in
different editions

4.6 Tools menu

The Tools menu contains the following options for advanced operations

 Raster orientation

 Reprojection

 Generate TIN (in the Desktop version)

 Export raster (in the Desktop version)

 Survey

 Divide

 Sampling
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 Change Layer

 Buffer Zone

 Polygon division

 Polygon Delineation

 Polygon Join

 Botany extension (in the Desktop version)

 Tree surveying extension

 Tree volume assessment

File menu in the Mobile version

File menu in the Desktop version
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 = new feature Basic Advanced Professional

Availability of the "Tools" menu in different
editions

4.6.1 Raster orientation

 Raster orientation
You can modify the georeference data of the current raster image by using affine (1st order)
polynomial transformation on-the-fly.

Tap / Left click on the map: designates/deletes control point on the map.
Drag: modifies the real position of the point.
Tap and Hold / Right click on the control point: enter coordinates to the existing control point.

The Raster orientation remains active for georeferencing until another tool is activated.

When you georeference a raster image, you define its location using map coordinates in the
selected coordinate system of the DigiTerra Explorer map. Georeferenced raster data allows it to be
viewed, with other geographic data.

General steps for georeferencing a raster image are:

1. Add the raster image that you want to align with your projected data to the map view.
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Add the raster image to the map

2. Add control points (maximum three control points can be used) and link them as known raster
image positions to known positions in map coordinates.

Add control points to the map

Link a control point to a known position by dragging
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Link a control point to a known position by entering the map coordinates

3. Save the georeferencing information into the DigiTerra Explorer Map file (.EXP), or save them into
a World file when you’re satisfied with the alignment (also referred to as registration).

Aligning the raster image with control points
Generally, you will georeference your raster image using existing spatial data (target data), such as
a vector feature class, that resides in the desired map coordinate system. The process involves
identifying three control points (known x,y coordinates) that link locations on the raster image with
locations in the spatially referenced data (target data). Control points are locations that can be
accurately identified on the raster dataset and in real-world coordinates. There are many different
types of features that can be used as identifiable locations, such as road or stream intersections,
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the mouth of a stream, rock outcrops, the end of a jetty of land, the corner of an established field,
street corners, or the intersection of two hedgerows.

The modified georeferenced data can be stored to each image in the DigiTerra
Explorer Map file (.EXP) format or can be saved to the active raster layer as a
World file.

4.6.2 Reprojection

 Reprojection
Opens the Reprojection panel to reproject the layers of the map view into the selected spatial
reference system

 Please select target spatial  - Opens the Select Projection panel
reference system! 

 OK  - Reprojects all layers of the map view

 Cancel  - Closes the Reprojection panel

4.6.3 Survey

 Survey
Opens the Survey panel. You can use five surveying methods with this tool. Designated base line
(defined auxiliary coordinate system) is required for the first four methods. The Survey tool remains
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active for surveying until another tool is activated.

Tap / Left click: add start P1 and endpoint P2 (snapped) of the base line/auxiliary coordinate
system on the map
Drag: drag the start P1 and endpoint P2 (snapped) of the base line/auxiliary coordinate system on
the map

You can fill the fields of the supported surveying methods with laser rangefinder/
ecompas by measuring the proper distance/angle after you tapped on the field you
wish to measure.

The Survey panel

Type: select the survey method you wish to use

The following surveying methods can be used on the Survey panel
1. Rectangular survey
2. Polar survey
3. Angle Intersection
4. Distance Intersection
5. Polar survey from start point

Z: height of the surveyed point/vertex position

 Average  - Averages the positions you have surveyed in the edited layer. In case of point feature
type, last measured positions of existing point features will be replaced to an averaged point
position; in case of working with a line/polygon feature type, last measured positions will be replaced
to an averaged vertex position. (Measured positions are displayed on the map view as red vertices
and/or auxiliary lines.)
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 P1=GPS  - Takes over the current GPS position as the startpoint P1 of the baseline/auxiliary
coordinate system

 P2=GPS  - Takes over the current GPS position as the endpoint P2 of the baseline/auxiliary
coordinate system

 - Erases the last survey made to a feature

 Add  - Adds point, vertex or vertices into the edited layer based on the entered values of the current
survey method. They are displayed on the map view as red vertex and/or auxiliary line. This button
will create the point feature also. In case of using line or polygon features you need to tap and hold
the stylus on the screen then select "Create" to store the feature in the edited vector layer.

Inst. height: Instance height. The default value is 1.45 m.
Sign. height: Signal height.  The default value is 1.35 m.

1. Rectangular survey

The Survey panel w ith rectangular survey

x: abscissa, the x coordinate
y: ordinate, the y coordinate

"x", "y" values can be measured with the  Set  buttons on Topcon GMS-2PRO

2. Polar survey

The Survey panel w ith polar survey
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d: distance
a: angle

"d", "a" values can be measured with the  Set  buttons on Topcon GMS-2PRO,
"a" value can be measured with the  Set  button on Topcon GMS-2

3. Angle Intersection

The Survey panel w ith angle intersection
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a1: measured angle from P1
a2: measured angle from P2

"a1", "a2" values can be measured with the  Set  buttons on Topcon GMS-2 and
Topcon GMS-2PRO

4. Distance Intersection

The Survey panel w ith distance intersection
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d1: measured distance (radius) from P1
d2: measured distance (radius) from P2

"d1", "d2" values can be measured with the  Set  buttons on Topcon GMS-2PRO

5. Polar survey from start point

The Survey panel w ith polar survey from start point method
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d: distance
fi: polar angle, azimuth

"d", "fi" values can be measured with the  Set  buttons on Topcon GMS-2PRO,
"fi" value can be measured with the  Set  button on Topcon GMS-2

DigiTerra Explorer calculates in decimal degrees (not in radian). The zero value is
equal with the direction of the North. You have to enter every angle in decimal
mode not in DD-MM-SS format. Negative decimal degrees can be used.

0° = North
90° = East
180° = South
270° = West

4.6.4 Divide

 Divide
DigiTerra Explorer enables you to create divided polyline features. There are two ways to use the
Divide tool:

1.) You can divide an auxiliary line (red line) into sections by using different methods on the
Divide panel. DigiTerra Explorer stores the splitting points into a point feature layer.

2.) The Divide tool can be also used on selected polyline or polygon features. In this case the
Divide tool stores the divided line segments in the edited polyline feature layer, or in a new
layer if there is no edited layer on the Layers panel.

The polygon feature can be selected by using the  Identify tool in the Query
menu\toolbar.

Tap / Left click: adds vertices of the auxiliary line on the map.
Drag:  adds vertices of the auxiliary line on the map with displayed crosshairs.
Tap and hold / Right click: displays the editing context menu. The Divide panel can be opened
by selecting the Create option from the editing context menu.

The Divide tool remains active until another tool is activated.

The Divide panel
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Divide panel

Type: select a dividing method you wish to use. Enter the value(s) that you want use to the selected
method.

Usable dividing methods:
1. Given numbers of sections: divides the auxiliary line into n equal parts.
2. Equal lengths: divides the auxiliary line from the first vertex into n equal length sections with

remainder.
3. Given distances: divides the auxiliary line from the first vertex into n given (different) length

sections with remainder. For example: 10 10 50 18.9 (space separated values).
4. Given ratios: divides the auxiliary line into n different length sections by given ratios. For

example: 2 3 2 (space separated values).

Enter the values in current map unit for method 2 and 3. 

 OK  stores the splitting points into the edited point layer.

The splitting points can be created when editing is turned on for a point layer in
the Layers panel.

Dividing by distances
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The results

4.6.5 Sampling

 Sampling
Opens the Sampling wizard panel to define the location of sample points, -lines or -polygons for a
sampling procedure into an edited layer by using pre-defined sampling methods.



239Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

The Sampling tool combined with the Navigate to Target function provides a
convenient method to collect data at specified intervals on the field for
observations. Such as soil samples, measuring the degree of weed infestation of
a designated area, water depth, chemical concentration which required for
contour map generation.

The general steps of the Sampling wizard tool are:

1. Tap  Sampling and the Sampling wizard dialog appears.

The Sampling wizard

2. Select a polygon with the Identify tool on the map to designate the sampling area.

Selected polygon feature w ith the Identify tool
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3. Create a new Layer on the Create Layer panel for storing the results in a vector layer.

Type the name of the new layer and select a file format you want to use. Select path

4. Select point, line or polygon feature type depending on the sampling method you want to use.
Use an attribute table template if required on the New layer dialog.

Select attribute table template
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5. Select a sampling method and enter its parameters on the Sampling panel.

The Sampling panel

6. Add the results into the created new layer by tapping the Create button.

Results of the sampling in a point layer
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The Sampling panel

The Sampling panel

Source: displays the source layer's name and the area in hectare of the selected polygon feature.
Method: select a sampling method you wish to use.

Usable sampling methods:
1. Point square net: creates nodes of a square grid/rectangular grid into a point layer. If you

want to create a square grid enter the length of the cell into the Size textbox. You can define
a rectangular grid by entering the width and height of one cell as space separated values.
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2. Point triangle net: creates nodes of a regular triangular grid into a point layer. If you want to
create an equilateral triangular grid enter the size of the cell (all sides have the same length)
into the Size textbox. You can define isosceles triangular grid by entering the length of the
base and the height as space separated values.

3. Random point: create points within the area randomly into a point layer.

4. Polygon line net: creates parallel lines (rectangles) over the selected polygon into a polygon
layer.

5. Polygon square net: same as Point square net; creates cells of a square grid/rectangular
grid into a polygon layer.

6. Polygon triangle net: same as Point triangle net; creates cells of a equilateral/isosceles
triangular grid into a polygon layer.

7. Polygon hexagon net: creates cells of a hexagonal grid into a polygon layer.
8. Line net: same as Point square net; creates lines of a square grid/rectangular grid into a

line layer.

Inside polygon: create result points, lines, polygons within the polygon.
Edge: buffer on the boundary of the selected polygon.
Size: size of the grid cells in the current map unit. Space separated values are enabled.

Position: center of the grid with easting, northing coordinates. Default is 0,0.
Direction: direction of the grid. Default is 0, the north direction.
GPS button:  takes over the current GPS coordinates to the position. Takes over the current GPS
direction to the direction.

Result: displays the name of the edited layer (that will store the results of the selected sampling
method), number of sampling points/areas, cell size and the sampling area size (area of one cell) in
square meter.
Create: adds the results of the sampling into the edited layer.

4.6.6 Buffer zone

 Buffer zone
Creates a buffer zone around the selected point, line or polygon feature and stores it into the edited
layer. Adds BufferDist field into the attribute table of the edited layer which stores the entered
diameter of the buffer zone.

Tap / Left click: selects an item on the map to buffer zone creation.

The Buffer zone remains active for creating buffer zones until another tool is activated.

Selected item for buffer zone creation
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Buffer distance: diameter of the buffer zone in current map unit. Default is 100 for area features, 20
to point and line features.

Result of the buffer zone creation

 

BufferDist field in the attribute table of the buffer zone's layer
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4.6.7 Polygon division

 Polygon division
Divides the selected polygon parallel with the base line by using different polygon dividing
methods and stores the divided polygons into the edited layer. If there is no editable layer on the
Layers panel, DigiTerra Explorer will create a new polygon feature layer to store divided polygons.

The polygon feature can be selected by using the  Identify tool in the Query
menu\toolbar.

Tap / Left click: designates the start and the endpoint of the base line on the map then opens the
Polygon division panel.
Drag:  designates the start and the endpoint of the base line on the map with displayed crosshairs
then opens the Polygon division panel.
Tap and hold / Right click: displays the editing context menu.

The Polygon division remains active for dividing a polygon until another tool is activated.

Selected polygon, Polygon division panel, polygon and base line
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Polygon division panel

Type: select a dividing method you wish to use. Enter the value(s) that you want use to the selected
method.

Usable polygon dividing methods:
1. Given number of polygons: divides the selected polygon into n equal part area of polygons.
2. Equal area of polygons: divides the selected polygon into n equal part area of polygons with

remainder.
3. Given areas of polygons: divides the selected polygon into n given (different) part area of

polygons with remainder. For example: 10 5 20 35.8 (space separated values).
4. Given ratios: divides the selected polygon into n different part area of polygons by given

ratios. For example: 2 3 2 (space separated values).

Enter the values in current area unit for method 2 and 3. 
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 OK  stores the divided polygons into the edited polygon layer.

Results of the Given areas method (1, 3, 4.5 hectare)

Divided polygons can be created when editing is turned on for a polygon feature
layer in the Layers panel.
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The last topological edit operation can be undo by using the   Undo tool
that you made to a feature with the Polygon Division tool.

4.6.8 Polygon Delineation

 Polygon Delineation
Separates one or more polygon features into separated polygons based on an overlapped polyline
(auxiliary line) into the same edited layer. The corresponding segments of the auxiliary line will be
the boundary between the created new polygons.

Tap / Left click: adds vertices of the auxiliary line on the map.
Drag:  adds vertices of the auxiliary line on the map with displayed crosshairs.
Tap and hold / Right click: displays the editing context menu. The Polygon Delineation can be
stored by selecting the Create option from the editing context menu.

The Polygon Delineation remains active until another tool is activated.

Overlapped auxiliary line through to polygons

Selected Create option in editing context menu to store new polygons
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Results of the Polygon Delineation

The last topological edit operation can be undo by using the   Undo tool
that you made to a feature with the Polygon Delineation tool.
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4.6.9 Polygon Join

 Polygon Join
Deletes the boundary line between two polygons and create a new polygon. Once you selected the
boundary line between the polygons DigiTerra Explorer opens the Area join panel to select which
attribute data record you want to store to the new polygon. Please, note that all geometry based
data field will be recalculated in the new polygon's data record. The boundary line can be selected
when the identify button turned on for the edited layer in the Layers panel.

Tap / Left click: selects boundary line.
Drag:  selects boundary line (drags selection point) on the map with displayed crosshairs.

The Polygon Join remains active until another tool is activated.

Boundary line between two polygons

Area join panel
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In the Desktop version the neighboring polygons filled with yellow colour and the edited source layer
is labeled by the first data field to help you identify the polygon's data in the Area join dialog. 

Area joining in the Desktop version

Joined new polygon
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The Polygon Delineation and the Polygon Join can be stored when editing is
turned on for the edited polygon layer in the Layers panel. If the attribute table
contains data fields with geometry related default value, the cell value of current
data field will be updated after you have applied the Polygon Delineation or the
Polygon Join tool.

The last topological edit operation can be undo by using the   Undo tool
that you made to a feature with the Polygon Join tool.

4.6.10 Extensions

Enter topic text here.

4.6.10.1 Tree volume assessment extension

Have a look at this short description about this extension here: http://www.digiterra.hu/wiki/en/
downloads/Tree_volume_Assessment_extension.pdf or read the detailed help: http://wiki.digiterra.hu/
en/downloads/treevolume.

4.6.10.2 Tree surveying extension

The Tree surveying extension is not part of the core DigiTerra Explorer. It is an additional software
module for surveying trees with GPS/GNSS receiver and Lasertech Trupulse 360B. It can be

accessed in the menu bar: Tools >  Tree surveying and in the toolbar with the  Tree

http://www.digiterra.hu/wiki/en/downloads/Tree_volume_Assessment_extension.pdf
http://www.digiterra.hu/wiki/en/downloads/Tree_volume_Assessment_extension.pdf
http://wiki.digiterra.hu/en/downloads/treevolume
http://wiki.digiterra.hu/en/downloads/treevolume
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surveying button.

 Tree surveying
Opens the Create Layer File panel to enter the name of the new point feature layer that stores the
surveyed trees. Opens the Tree surveying panel if you have an existing tree surveying layer.

Create Layer Files panel

New layer Files panel

Tree Surveying panel
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 Reference Point #0  - Tap on this button to define your standing point on the field with the Add
new reference point panel. "#0" means that your standing point is not yet defined.

 Reference Point #1  - "#1" means that you are on the first standing point. Tap on this button again
if you want to measure more trees from an other standing point.

Add new reference point panel

 GPS  - takes over the Easting, Northing coordinates of the current GPS position to define the
standing point at the current GPS location.

 Ok  - saves the standing point and then closes the panel



255Menu and toolbars

© 2015 DigiTerra Information Services Ltd.

 Cancel  - closes the panel without saving the standing point

Reference point symbol on the map view

 Connection (Off)  - Opens the Settings > Rangefinder tab to connect DigiTerra Explorer to the
Rangefinder. "Off" means the software not connected to the Rangefinder.

Remember to enable the Trupulse 360B for Bluetooth operation before start
working with the Tree surveying extension. Please continue with the following help
tutorial about "Enabling Bluetooth". 

 Connection (On)  - Opens the Settings > Rangefinder tab to modify connection settings with the
Rangefinder. "On" means the software connected to the Rangefinder.

Species: Select an existing tree species or enter a new species and use it later. The Species drop-
down list automatically stores the entered tree species in the TreeSurvey.cdt code dictionary. This
code dictionary can also be edited manually in your preferred text editor.

Path:

Desktop
version: 

$DOCUMENTS\DigiTerra Explorer
\Maps\TreeSurvey.cdt

Mobile
version: 

$SDCARD\Maps\TreeSurvey.cdt

Polar position: Displays the measured values. You can also enter the values in [degree, meter].

 Measure  - Displays the following message box: "DigiTerra Explorer controls TruPulse 360B to
measure an Azimuth (AZ) and Horizontal Distance (HD). Look through the eyepiece and use the
crosshair to aim to the target. Press-and-hold the FIRE button." The message box closes
automatically once your finished the measurement.

Tree height: Displays the measured value. You can also enter the values in [meter].

 Measure  - Displays the following message box: "DigiTerra Explorer controls TruPulse 360B to
measure the Tree height with the Height Routine. Height Measurements involve a simple routine that
prompts you to take 3 shots to the target: HD, INC base (or top), and INC top (or base). The
TruPulse uses these results to calculate the height of the target." The message box closes
automatically once your finished the measurement.

Trunk height: Displays the measured value. You can also enter the values in [meter].

 Measure  - Displays the following message box: "DigiTerra Explorer controls TruPulse 360B to
measure the Trunk height with the Height Routine. Height Measurements involve a simple routine
that prompts you to take 3 shots to the target: HD, INC base (or top), and INC top (or base). The
TruPulse uses these results to calculate the height of the target.
" The message box closes automatically once your finished the measurement.

Stem diameter: Displays the measured value. You can also enter the values in [meter].

http://digiterra.hu/wiki/en/downloads/TruPulse_360-B_Enable_Bluetooth.pdf
http://digiterra.hu/wiki/en/downloads/TruPulse_360-B_Enable_Bluetooth.pdf
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 Measure  - Displays the following message box: "DigiTerra Explorer controls TruPulse 360B to
measure the Stem diameter with the Missing Line Routine. The Missing Line Routine calculates
distances and angles to describe the relationship between two extremities of the stem. The simple
routine prompts you to take two shots to targets: "Shot 1” and “Shot 2”." The message box closes
automatically once your finished the measurement.

Crown diameter: Displays the measured value. You can also enter the values in [meter].

 Measure  - Displays the following message box: "DigiTerra Explorer controls TruPulse 360B to
measure the Crown diameter with the Missing Line Routine. The Missing Line Routine calculates
distances and angles to describe the relationship between two extremities of the crown. The simple
routine prompts you to take two shots to targets: "Shot 1” and “Shot 2”." The message box closes
automatically once your finished the measurement.

The measurement can be repeatable by tapping on the Measure button.

 New (Num#0, Total#0)  - Displays the currently measured Tree's number and the total number of
surveyed trees. Tap on this button to start surveying a new tree.

 Undo  - Removes the last measurement.

Attribute table structure of the Tree surveying point feature layer

4.6.10.3 Botany extension

The Botany extension is not part of the core DigiTerra Explorer software. It is an additional module
for botanical analysis and available only in the desktop version. It can be accessed in the menu bar:

Tools >  Botany and in the toolbar with the  Botany button.

 Botany
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Opens the Botanical analysis configuration panel.

The BS5837 British Standard provides guidance, in respect of development sites, for a balanced
approach on deciding which trees are appropriate for retention, on the effect of trees on design
considerations and on the means of protecting trees during development. This applies to applications
for most developments where construction work is involved. If the site contains trees, shrubs and/or
hedges, it is required to submit a Tree Report that contain appropriate plans and drawings. DigiTerra
Explorer and this module will help you to survey the site and its trees and to create a Tree Report.

In DigiTerra Explorer user interface the Botanical analysis panel is a modal panel. It is a child
window of the application that requires you to interact with it before you can return to operating the
main application or any of its other dialogs, thus preventing the workflow on the application main
window.

The following sample can be used to learn this extension:

Path:

Desktop
version: 

$DOCUMENTS\DigiTerra
Explorer\Maps\Botany\

Mobile
version: 

$SDCARD\Maps\Botany\

Botanical analysis configuration panel
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Source layer: Select a point feature layer that contains the surveyed trees and their attributes

The source layer will be set by the first point feature layer of the Layers panel

Category (A,B,C,R): Select a data field from the source layer's attribute table that contains tree
quality assessment (BS 5837:2005 – Trees in Relation to Construction Recommendations for
Submitting Planning Applications; British Standard). Each tree category (A, B, C, R) are assigned

http://digiterra.hu/downloads/standards/BS5837_cascade_chart.pdf
http://digiterra.hu/downloads/standards/BS5837_cascade_chart.pdf
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with a colour on the map view based on the British Standard above. DigiTerra Explorer automatically
assigns the correct colour to dot symbol of the tree which represents the stem when create the 
Crown Map.

The Category field will be automatically selected from the attribute table of the
source layer if the data field that stores the categories named as 'Category'

Category field in the source point feature layer

Crown shape box

Crown shape: The crown shape defines the horizontal parameters of the crown. Currently the
following five Crown Definitions are built in DigiTerra Explorer to describe the parameters of the
crown.

Crown definition: Select a crown definition to create Crown Maps. The selected method can be
defined by proper data fields of the source layer's attribute table. The Crown definition must
be set to create the Crown Map and the Shadow Map.

Selectable Crown definitions in the drop-down list
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The Crown definition fields will be automatically selected from the attribute table of
the source layer if the data fields which store the definitions named as 'East,
West, North, South'

Applicable crown definitions:

1 radius: Select a data field from the source layer's attribute table that stores 1 radius

1 radius - based crown shape

 

2 radiuses (E, N): Select proper data fields from the source layer's attribute table which store 2
radiuses

2 radiuses - based crown shape

4 radiuses (E, N, S, W): Select proper data fields from the source layer's attribute table which
store 4 radiuses

4 radiuses - based crown shape
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1 diameter (W-E): Select a data field from the source layer's attribute table that stores 1 diameter

1 diameter - based crown shape

2 diameters (W-E, S-N): Select proper data fields from the source layer's attribute table which
store 2 diameters

2 diameters - based crown shape
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 Create Crown Map  - Creates the Crown polygon feature layer and the Crown_Radius line feature
layer in ESRI Shape (.SHP) format. The Category data field (described above) will be stored in the
attribute table of the Crown polygon feature layer. 

Crown Map layers

Root area box

Root area: The root area defines the horizontal parameters of the root

Root Protection Area (RPA): The area that needed for a tree to survive and grow

Root definition: Select a root definition method to create the root map

Proportion to Crown size: Crown shape and Scale factor must be set to create the root map

Proportion to Stem diameter: Stem diameter and Scale factor must be set to create the root
map

Different factor for multi-stems: Number of Stems, Stem diameter, Scale factor and Multi-
stem factor must be set to create the root map. (Required method to the British Standard: BS
5837:2005)

Stem diameter: Select a data field from the source layer's attribute table that stores the Stem
diameter. The Stem diameter must also be set to create the Shadow Map.
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The Stem diameter field will be automatically selected from the attribute table of
the source layer if the data field that stores the Stem diameter named as
'Diameter'

Number of Stems: Select the data field from the source layer's attribute table that stores the
Number of Stems

The Number of stems field will be automatically selected from the attribute table
of the source layer if the data field that stores the Number of stems named
as 'StemNum'

Scale factor: Enter a scale factor you want to use to create the root map. Default Scale factor is
10.
Multi-stem factor: Enter a scale factor you want to use to create the root map when using the
"Different factor for multi-stems" method. Default Multi-stem factor is 12.

Cutting layer: Select the line or polygon feature layer you want to use to cut the root map. If you
have a line or polygon feature that crosses the root map, you can use the line or polygon layer to cut
the root map layers. Default is "none".

Cutted Root polygon (brown) and Crown polygon ()

Go to Settings > Record > Measurement units and set the Area unit to square



264 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

meter to store the RPA in square meter in the Area field of the Root polygon layer

 Create Root Map  - Creates the Root polygon layer and the Root_Radius line feature layer in ESRI
Shape (.SHP) format. The Root Protection Area (described above) will be stored in the Area field of
the Root polygon feature layer's attribute table.

Root Protection Area (brown), Crown polygon (green) and the footprint of the building

Shadow calculation: The Shadow Map shows the shadow of the trees by using the Source layer,
Crown shape, Stem diameter and the following additional parameters:

Date: Enter the date you want to use. Default is the today's date.
Time:  Enter the time you want to use. Default is the current time.
Timezone: Select the timezone you want to use. Default is UTC +00.00.
Daylight saving: Check this parameter if you want to use it. Default is checked.
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Position: Defines the center position of trees in the Source layer

Latitude, Longitude: You need to enter the center position of trees in the Source layer
Current Projection System: Automatically calculates the center position of trees in the Source
layer in the current projection system

Latitude: Enter the Latitude coordinate you want to use.
Longitude: Enter the Longitude coordinate you want to use.

Tree height: Select the data field from the source layer's attribute table that stores the Number of
Stems

The Tree height field will be automatically selected from the attribute table of the
source layer if the data field that stores the Tree height named as 'Height'

Trunk height: Select the data field from the source layer's attribute table that stores the Number of
Stems

The Trunk height field will be automatically selected from the attribute table of the
source layer if the data field that stores the Stem diameter named as 'Trunk'

Crown profile: Select the crown profile you want to use

Ellipse
Triangle
Egg
Balloon

 Create Shadow Map  - Creates the Shadow polygon feature layer in ESRI Shape (.SHP) format

Shadow map on the map view
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4.7 Help menu

The Help menu available only in the Desktop version and contains the following options:

Help - Opens the CHM help file
About - Opens the About panel

The Help menu can be found in the Mobile version as a sub-menu in the File menu.

AboutHelp menu in the Desktop version

4.8 File dialog boxes

The File dialog allows to open/save one or more files in DigiTerra Explorer. This dialog is commonly
used in the software for creating a new layer, adding layers to the map, saving a layer with a new
name, exporting the layer into a new format etc. The File dialog is different on the Mobile and on the
Desktop version. The Desktop version of DigiTerra Explorer uses the standard Windows® File dialog.

File dialog (Mobile version)
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Name: Enter the name of the file (without extension).
Type: Select a file format/file group mask. File format 'group' mask: Layers, Vector files, Tables,
Raster files, All files.
Path: Shows the current path.

 \  - Changes the path to the root path.

 ..  - Changes the path one directory back.

The File context menu by using Tap and hold technique in the Mobile version



268 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

4.9 Context menus

Context menus are popup menu that can be accessed by tap and hold / right click with the
following commands:

Edit menu

1.  Point

If there is no vector feature layer in the project:

  -  Opens the Insert Point panel

If there is at least one vector feature layer in the project:

2.  Line,  Free Line,  Polygon,  Free Polygon,  New part

3.  Rectangle,  Circle,  Ellipse

4.  Select by line,  Select by polygon,  Select by rectangle,  Select by circle
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5.  Measure,  Free measure,  Radius measure

6.  Polygon Delineation

Editing context menu when using Tap and hold / Right click



270 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

Back: Deletes the last vertex made to a feature (Backspace)

Position: Opens the Insert Point panel or the New vertex panel to add a new vertex into the edited
layer

Modify: Opens the Modify panel to modify the angle and length of the last section

New part: Adds new part(s) to the currently edited feature

in case of area: isle, hole or new part beside the area
in case of line: multiline
in case of point: multipoint

The usefulness of the new part feature depends on the selected vector layer
format.

Restart: Erases all vertices and editing lines (construction lines) from the map view. Cancels
changes to an existing feature’s geometry or cancels capture of a new feature.

Create / Finish / Select: Creates multipoint, line/polyline or polygon/multipolygon feature from
vertices. (Opens panel for the related tools) / Finishes the editing of the polyline. (Opens Geometry
panel for the Measurement tools). Selects features.

5 Printing maps and reports

 Print
Prints the current Map. This menu item is available only in the Desktop version.

The Printing available in the Desktop version only. You can print the map view, attributes and an area
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measuring report through the default Print Setup and by using three special paneles (one for the
map view, attributes and for the area measuring report).

Print Setup panel

Use the Print Setup panel to select the printer, page orientation, and paper size you want to use to
print the report/map view. If you do not select a printer, the program will print to the Windows default
printer.

This panel appears when you click on the  Print button in the menu bar/toolbar,  OK  button in
the Print Report panel, and click on   OK  button in the Printing Area Report panel. 

Printer

Name: Find the name of the printer to which you can send reports/map views in the Name list.
 Properties  - Click the Properties button to bring up the Properties panel for the selected printer.

Paper

Size: Use the Size list to select from a variety of paper- or envelope-size options.
Source: Use the Source list to select from a variety of feed or paper source options.

Orientation

Portrait: Select the Portrait option to print your report in a standard-letter orientation. 
Landscape: Select the Landscape option to print your report in landscape orientation. 

Network: Click the Network button to connect to a network printer.
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5.1 Printing maps

You can print the map view to printer/plotter or file through the Print Setup and the Print Map panel.

You can access to this desktop command in the menu bar: File >  Print and in the toolbar: 
 as well.

Print Map panel

The Print Map panel

Printing scale = 1: Enter the value of the Printing Scale to the printable map view. You can see
what will be printed in real-time on the map view as you entered a different Printing Scale value. The 
printable area marked with blue boundary on the map view. Default is Printing Scale is 1: 10 000.

You can adjust the what will be inside the printable area (blue boundary on the
map view) by entering the Printing Scale and by using the Pan tool in the View
menu/toolbar.

Boundary of the printable area on the map view
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Title: Customizable textual field that will be placed on the printed map as Map Title. Default Title is
the name of the mapping project.
Label: Customizable textual field that will be placed on the printed map as Map Label. Default Label
is the current system date.

Print legend: Optionally printable legend of the thematic classes. You can customize the contents
of the map legend in the Classes/Class panel and by using the Identify option (on/off) in the Layers
panel. Default is No legend.

No legend: Map legend won't be placed on the printed map.
Legend ad Top-Left: Map legend will be placed in the top-left corner on the printed map.
Legend ad Top-Right: Map legend will be placed in the top-right corner on the printed map.
Legend ad Bottom-Left: Map legend will be placed in the bottom-left corner on the printed map.
Legend ad Bottom-Right: Map legend will be placed in the bottom-right corner on the printed
map.

Printed map
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Vector Print: (points, lines, polygons, labels): Uses the Windows graphics device interface (GDI)
at the printing. When you want to print only vector layers/symbols Vector Print mode is
recommended to use. Raster layers, raster symbols, transparency cannot be printed in this printing
mode. Default is Vector Print mode.

Raster Print: (bitmaps, full Map content): When you want to print the full content of the map view
(including raster/vector layers and raster symbols) Raster Print mode is recommended to use.

Raster Print Resolution (DPI): You can customize the resolution of the printable map depending on
print quality. Default is 200 dpi.

Print through Metafile: Prints through Metafile. This option is recommended to use for some
special older printers.

Remember printing mode: Saves and reloads the last selected vector or raster printing mode.
Bitmap logo: You can add a bitmap logo in these formats to your printable map: BMP, PCX, JPG,
TIF

 OK  - Sends the printable content to the selected Printer.

5.2 Printing attributes

You can print the selected data table through the Print Setup and the Print Report panel. You can
access to this command in the Menu of the Record panel: Menu > Report.

Select data table; open the Menu
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Report option in the Menu

Print Report panel

The Print Report panel
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Title: Customizable textual field that will be placed on the printed report as Report Title. Default Title
is 'Report'.

Subtitle: Customizable textual field that will be placed on the printed report as Report Subtitle under
the Report Title.
Default Title is:
'Customer:
Surveyor:'.

Bitmap logo: You can add a bitmap logo in these formats to your printable map: BMP, PCX, JPG,
TIF

Print through Metafile: Prints through Metafile. This option is recommended to use for some
special older printers.

 OK  - Opens the Print Setup panel and sends the printable content to the selected Printer.

Printed report
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Filter conditions can be used to the Print Report function.

5.3 Print Point reports

You can print a point measurement report to the selected attribute table through the Print Setup and
the Print Point report panel. You can access to this command in the Menu of the Record panel:
Menu > Point report.

 = new feature Basic Advanced Professional

Availability of the "Point report" feature in
different editions

Select data table and data record; open the Menu
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Point report option in the Menu

Print Point report panel

The Print Point report panel
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Title: Customizable textual field that will be placed on the printed report as Title. Default Title is
'Point Measuring Report'.

Content: Customizable textual field. Default is 'I. General Information'. 
check-box: enabled as default.

Customizable part of the Point Report: Customizable textual fields. You can print data values to
any data fields of the selected record by using the data field name between percents: %FieldName
%.

Customizable parts of the Point Report
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Map draft: Customizable textual field. Default is 'II. Draft Map'.
check-box: enabled as default.

Every points: prints all points from the attribute table
Selected points: prints only the selected points (you can select them with the selection tools)

Coordinates: Customizable textual field. Default is 'III. Point Measuring report'.
check-box: enabled as default.

Projected coordinates: prints the projected coordinates from the selected attribute table.
Geographic coordinates: prints the geographic coordinates from the selected attribute table
Survey reliability: prints the reliability information of the GPS survey from the selected attribute
table

Print through Metafile: Prints through Metafile. This option is recommended to use for some
special older printers.

Vector Print: (points, lines, polygons, labels): Uses the Windows graphics device interface (GDI)
at the printing. When you want to print only vector layers/symbols Vector Print mode is
recommended to use. Raster layers, raster symbols, transparency cannot be printed in this printing
mode. Default is Vector Print mode.

Raster Print: (bitmaps, full Map content): When you want to print the full content of the map view
(including raster/vector layers and raster symbols) Raster Print mode is recommended to use.

Raster Print Resolution (DPI): You can customize the resolution of the printable map depending on
print quality. Default is 200 dpi.
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Remember printing mode: Saves and reloads the last selected vector or raster printing mode.

 OK  - Sends the printable content to the selected Printer.

 Cancel  - Closes the panel (to select an other record/feature).

Printed Point Measuring Report
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5.4 Print Area reports

You can print an area measurement report to the selected data record or selected feature through
the Print Setup and the Print Area Report panel. You can access to this command in the Menu of
the Record panel: Menu > Area report.

 = new feature Basic Advanced Professional

Availability of the "Area report" feature in
different editions

Select data table and data record; open the Menu

Area report option in the Menu
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Print Area report panel

The Print Area report panel
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Title: Customizable textual field that will be placed on the printed report as Title. Default Title is
'Area Measuring Report'.

Content: Customizable textual field. Default is 'I. General Information'.

Customizable part of the Area Report: Customizable textual fields. You can print data values to
any data fields of the selected record by using the data field name between percents: %FieldName
%.

Customizable parts of the Area Report



285Printing maps and reports

© 2015 DigiTerra Information Services Ltd.

Map draft: Customizable textual field. Default is 'II. Area Measuring Map with Vertices'.

Coordinates: Customizable textual field. Default is 'III. Area Measuring report with Vertices'.

Marked point: Enter the ordinal number of the vertex you want to mark on the map draft with a flag
symbol.

Marked vertex

When you open the Print Area Report panel the ordinal numbers and the lengths
labels between vertices becomes visible.

Ordinal numbers and lengths of a selected area feature
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Print through Metafile: Prints through Metafile. This option is recommended to use for some
special older printers.

Vector Print: (points, lines, polygons, labels): Uses the Windows graphics device interface (GDI)
at the printing. When you want to print only vector layers/symbols Vector Print mode is
recommended to use. Raster layers, raster symbols, transparency cannot be printed in this printing
mode. Default is Vector Print mode.

Raster Print: (bitmaps, full Map content): When you want to print the full content of the map view
(including raster/vector layers and raster symbols) Raster Print mode is recommended to use.

Raster Print Resolution (DPI): You can customize the resolution of the printable map depending on
print quality. Default is 200 dpi.

Remember printing mode: Saves and reloads the last selected vector or raster printing mode.

 OK  - Sends the printable content to the selected Printer.

 Cancel  - Closes the panel (to select an other record/feature).

Printed Area Report
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6 Settings

 Settings
Opens the Settings panel. The Settings panel is used to configure various aspects of DigiTerra
Explorer that may be customized to each user but which are seldom changed. You can access the

Settings panel by tapping the   Settings option in the File menu (1) or in the toolbar (2) in case of
using the desktop version.

The Settings panel consists of the following tabs, that are described detailed in this section:
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Map
Record
GNSS
NTRIP
Send Command
Antenna
Logger
Rangefinder
Cable locator
Camera control
Media
System
Messages
Layout

The Settings panel
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6.1 Map

The Map tab contains the following controls:

The Map tab

 

[ ] Startup Map: Displays the PATH to the map project that DigiTerra Explorer opens at startup.
When this check-box checked the PATH is clickable as a button to open the Open map file panel to
change the preset map project. Default is unchecked.

Default Startup map file: Sample.exp

Path:
Desktop version: $DOCUMENTS\DigiTerra Explorer\Maps\Sample_City\Sample.exp
Mobile version: $SDCARD\Maps\Sample_City\Sample.exp

Please not when using the Startup Map option in DigiTerra Explorer the Startup
options panel not appears at startup.

Precision: Controls the precision of the displayed map view coordinates. Working with lower map
precision is useful if your mobile device's free program memory is nearly equal or lower than the
used program memory of vector layers you wish to add in your mapping project. 

Free program memory in Windows Mobile
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Selectable values

Projected: 1 m projected coordinates, precision is 1 meter
Projected: 1 dm projected coordinates, precision is 1 decimeter (0.1 meter)
o Projected: 1 cm projected coordinates, precision is 1 centimeter (0.01 meter) - default value

for local projection systems
Projected: 1 mm projected coordinates, precision is 1 millimeter (0.001 meter)

Geographic: 10 m geographic coordinates, precision is 10 meters
Geographic: 1 m geographic coordinates, precision is 1 meter
Geographic: 1 dm geographic coordinates, precision is 1 decimeter (0.1 meter)
o Geographic: 1 cm geographic coordinates, precision is 1 centimeter (0.01 meter) - default

value for WGS reference systems

Until you have not saved the current mapping project and it does not contains a
layer the precision can be changed.

Autosave: Controls the saving of edited vector layers, text and tabular formats. Default is After
Creation.

The vector geometry and its attributes will be saved automatically when they are
created.

Rendering quality: provides a way to switch to an alternative rendering mode for your data to
make your map draw faster if necessary. 
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Default values

240x320 screen resolution and in the Desktop version: 100%
480x640 screen resolution: 50%

The rendering quality can be changed at runtime without needs to restart the
application.

Full-Screen: Enables the full-screen display mode to increase the workspace.

Full-screen mode is turned on (first screenshot) and turned off

  

Full-screen mode in the Desktop version
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 = new feature Basic Advanced Professional

Availability of the "Full-Screen" option in
different editions

Coordinate display: Controls the coordinate display on the map and on the Pan frame in the
Desktop version as.

1. Current GNSS position in the bottom right corner
2. Last GNSS position at the same location
3. Queried map position in the top right corner
4. Current cursor position on the Pan frame

1. Current GNSS position in the bottom right corner

2. Last GNSS position at the same location
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3. Queried map position in the top right corner

4. Current cursor position on the Pan frame
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Raster smoothing: Enables bi-linear interpolation raster pixels in the map view so the raster layer
will not be pixels picture

Speed dependent scale: Changes the current scale on the basis of the actual speed.

 = new feature Basic Advanced Professional

Availability of the "Speed dependent scale"
option in different editions

Pan frame: Active navigation frame around the map view with the frequently used tools. Untick the
check-box if you don't wish to use it.

Continuous drawing: provides a way to switch to an alternative rendering mode for your data to
make your map draw faster if necessary.

Default values

Unchecked in the Mobile version
Checked in the Desktop version

Map Grid: displays a map grid based on the current map projection on the map view. The size of
each grid cell is automatically calculated, based on the current map scale.

Map Grid on the map view
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Background colour: Opens the colour palette to set the background colour of the map view (default
is white).

The "Background colour" colour palette and the selected grey background colour on the map view

   

 = new feature Basic Advanced Professional

Availability of the "Background colour"
option in different editions
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Night colour: Opens the Night colour dialog to set or turn off the tint colour of the night screen.

The Night colour panel

Night colour

 OK  - Opens the Night colour colour palette.

 Turn off  - Turns off the current night colour (black colour switches the night colour off also).

Before and after the applied "yellow" night colour
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 = new feature Basic Advanced Professional

Availability of the "Night colour" option in
different editions

6.2 Record

The Record tab contains the following controls:

The Record tab

 Code dictionary  - Displays the PATH to the code dictionary that is used in the current map
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project. There is a default code dictionary in DigiTerra Explorer for every newly created mapping
projects called General.cdt that you can use globally to store every code sets in it you are using
instead of creating a new code dictionary file next to the map project. The left button opens the Code
dictionary file panel to change the code dictionary you are using in the mapping project.

The default code dictionary file, General.cdt is unchecked. That means it is not in use. So if you
want to use it in your map project tick the check-box before the PATH and DigiTerra Explorer will
immediately use it. ie the new codes and code sets will be added into this file and the attributes
display based on the code dictionary if there is a reference to a given code set in the data field
name.

Path to the default code dictionary:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Maps\General.cdt

Mobile version: $SDCARD\Maps\General.cdt

 = new feature Basic Advanced Professional

Availability of the "Code dictionary" feature
in different editions

The path of the project's code dictionary file stored in the DigiTerra Explorer Map
project file (.EXP). If you are using separate code dictionary in the project
DigiTerra Explorer saves it next to the project file once you have added the first
code set to a data field and closed the Record panel.

New record: Once the geometry capture of a new feature finished DigiTerra Explorer proceeds to
attribute data capture and opens a panel with the attributes automatically.

The default panel is the Form view, that can be modified as:

No panel: Does not appear the dialog after recording geometry
Form view: Opens the Form view panel
List view: Opens the Record panel = List view
Tree view: Opens the Tree view panel. Useful when working with related attribute tables.

Info tool: Controls the operation of the  Identify command.

The default option is the Tooltip, that can be modified as:

Tooltip: the queried attributes display as tooltip on the map view
Form view: the queried attributes display in the Form view panel
List view: the queried attributes display in the Record panel = List view
Tree view: the queried attributes display in the Tree view panel

Measurement units: You can choose the date format, length, area, speed unit and the
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coordinate format for degrees from drop-down lists as:

Date format
 
o Year Month Day (default)

Month Day Year
Day Month Year

Length unit

o Meter (default)

Hectometer
Kilometer
Millimeter
Centimeter
Decimeter
Inch
Feet
Feet (Clarke)
Feet (Gold Coast)
Feet (Sears)
Feet (US)
Yard
Yard (Indian 1937)
Yard (Indian)
Yard (Sears)
Fathom (1.8288 m)
Fathom (Wien) (1.89m)
Mile
Nautical mile

Area unit

o Square meter (default)

Acre
Are
Hold
Hectare
Square millimeter
Square centimeter
Square decimeter
Square inch
Square kilometer
Square foot
Square yard
Square fathom
Square fathom (Wien)
Square mile
Square nautical mile

Speed unit
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o m/s (default)

km/h
f/s
mph
knot

Coordinate format

o D.ddddddd (default)

D-M.mmmmm
D-M-S.sss
D.ddddddd°
D°M.mmmmm
D°M'S.sss

These settings above are used in conjunction with the Creation time, GNSS Time,
Area (custom), Perimeter (custom), Length (custom), Distance to last object
(custom), Speed (custom), Latitude, Longitude data field default values on the
Data field panel.

The map display unit is metric in the software. The default map unit is meter.

6.2.1 Tooltip

The Tooltip displays on the map when using the  Identify tool on a queryable vector layer
according to the Settings > Record > Info tool = Tooltip setting

Tooltip
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Tooltip setting on the Settings > Record tab

6.2.2 Form view

The Form view panel displays in the following two cases:

1. When using the  Identify tool on a queryable vector layer according to the Settings > Record
> Info tool = Form view setting

2. Once captured the point, line, polygon feature's geometry according to the Settings > Record >
New record = Form view setting

Form view panel
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 OK  - Approves all changes and saves the data record. Active button as default.

 Cancel  - Cancels the changes you typed on the Form then DigiTerra Explorer saves those record
values that has been captured by automatically using default attribute field values

 Delete  - Erases the current record and the related geometry (if exists)

Related Form view settings
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6.2.3 List view

The List view panel = Record panel displays in the following four cases:

1. When using the  Identify tool on a queryable vector layer according to the Settings > Record
> Info tool = List view setting

2. Once captured the point, line, polygon feature's geometry according to the Settings > Record >
New record = List view setting

3. Opening it manually from the Query >  Tables command or from the Pan frame >  Record
button in the button in left hand side at the bottom

4. Changing from Tree view to List view on the Record panel > Menu > List view option

List view

Related List view settings



304 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

Changing from Tree view to List view

6.2.4 Tree view

The Tree view panel displays in the following three cases:

1. When using the  Identify tool on a queryable vector layer according to the Settings > Record
> Info tool = Tree view setting

2. Once captured the point, line, polygon feature's geometry according to the Settings > Record >
New record = Tree view setting

3. Opening it manually from the Query >  Tables command or from the Pan frame >  Record
button in the button in left hand side at the bottom
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Tree view

Related Tree view settings

Changing from Tree view to List view



306 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

6.3 GNSS

The GNSS tab is used to configure communication settings for your GNSS receiver or use
GNSS signal simulation, as well as

displays the current projection of the map view to inform you about the real-time coordinate
transformation that applies to the incoming GNSS positions
allows you to configure how the GNSS position to be displayed on the map view

usage of geoid undulation here with the  button
quality thresholds
alerts for the data capture
MGRS coordinate usage
enabling/disabling SBAS (on some devices only)
turning on/off the static navigation (on some devices only)
controls the data collection for post processing and

Other GNSS data capture related settings can be found on the GNSS Survey panel.

Please note that the controls of the GNSS tab are slightly differ on Trimble
handhels.

The GNSS tab
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Projection: Displays the current spatial reference system of the map view. The projection button
clickable so it also opens the Select Projection panel to change the projection of the map view.

Please note that the projection of an existing map view with layers can be
changed with caution!

Display: Control the display of the GNSS position on the map view

Display position: Shows the current GNSS position on the map view
o Follow position: Shows the GNSS position within the current map view. Default setting.

Tight following: Shows the GNSS position in the centre of the map view
Follow and rotate: Shows GNSS position in the centre of the map view and also rotates it into
the calculated GNSS heading. In case of higher speed the GNSS position gets to the lower part of
the map view.

 Geoid File: This command allows you to define a Geoid Separation File. Opens a dialog to
display the current geoid separation file or replace it to an other one.

Quality settings:

3D Fixed Only: The GNSS position can be processed if the current GNSS position is a fix 3D
position. The default is unchecked.

Fix quality: The GNSS position can be processed if the current GNSS position is a differential
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corrected GNSS position. The default is unchecked. The following values can be selected:

DGNSS Only
PPS Only
RTK Float or Fixed
RTK Fixed Only

max. PDOP: The GNSS position can be processed if the current PDOP value less or equals or is
less than the maximum PDOP. Default max. PDOP is 4.

Alarm: beeps when the GNSS is active. The Alarm option is used to play alert sound (beep) that
notifies you about various GNSS quality that occur when your GNSS receiver is communicating with
DigiTerra Explorer. This check-box is ticked as default.

- max. PDOP exceed: The current PDOP value from the GNSS receiver exceeds the maximum
PDOP value.
- Not a DGNSS fix: "DGNSS Only" is checked on the GNSS tab, and the current position fix from
the GNSS receiver is not a DGNSS fix.
- Not a 3D fix: "3D Fixed Only" is checked on the GNSS tab, and the current position fix from the
GNSS receiver is a two dimensional fix.

GNSS serial port settings

The serial port parameters are used to specify communication settings for your auxiliary serial port.
For most serial devices, it should not be necessary to specify the Parity, Databits and Stopbits
additional serial communication settings. Advanced serial port parameters and GNSS signal

simulation can be set in the Port settings panel by tapping on the  button.

Port: Choose the COM port that your GNSS receiver is connected to on your device. The default is
COM6 (commonly used ports are COM2, COM4, COM6, COM7 and COM8).
Baud: Choose the baud rate (data transfer speed) of your GNSS receiver’s output. The default is
4800 (commonly used Baud rates are 4800, 9600, 57600 or 115200).

 - Searches and set the GNSS port settings

Tap to search for a connected GNSS if you do not know which port on your device your GNSS is
connected to. You need to make sure that your GNSS is connected and turned on (if necessary) so
the Search GNSS tool can detect your GNSS. The Port, Parity, Baud, Databits and Stopbits
dropdown lists will be updated as the Search GNSS tool searches for a connected GNSS. Once a
GNSS has been detected you will be prompted to choose the GNSS and use the corresponding
settings.

Raw file: Starts capturing phase data on L1 frequency for postprocessing. The RAW files can be
postprocessed with Magellan MobileMapper Office and Magellan MobileMapper 6 Office (for
Magellan MobileMapper 6 receiver) desktop softwares. Displays only on Magellan MobileMapper 6,
Ashtech MobileMapper 10 and on Ashtech MobileMapper 100 devices. Please note, that only ESRI
Shape file can be selected as target layer once enabled the RAW data logging on this tab.
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Mm6GNSS.dll version 2.5.4.0 is required in the /BIN folder to start RAW data logging. Please don't
delete it or replace it with an older version of this DLL.

 = new feature Basic Advanced Professional

Availability of the "Raw file" logging
feature in different editions

On Thales/Magellan/Ashtech devices you need to enter the purchased
GPSDifferential Code when you start the Raw data collection at the first time.

MGRS: Turns on/off the Military Grid Reference System coordinate display on the map view and on
the Target dialog. There is more information about this feature on our website here: http://
www.digiterra.hu/en/newsevents/64-digiterra-explorer-news/207-military-grid-reference-system-in-
digiterra-explorer.html

SN: On/Off: Turns on/off the Static navigation mode in SiRF GPS receivers. This option is
accessible in the Desktop version as default. In the Mobile version it is controlled by the device
configuration file.

SBAS: Turns on/off the SBAS mode in SiRF GPS receivers. This option is accessible in the
Desktop version as default. In the Mobile version it is controlled by the device configuration file.

http://www.digiterra.hu/en/newsevents/64-digiterra-explorer-news/207-military-grid-reference-system-in-digiterra-explorer.html
http://www.digiterra.hu/en/newsevents/64-digiterra-explorer-news/207-military-grid-reference-system-in-digiterra-explorer.html
http://www.digiterra.hu/en/newsevents/64-digiterra-explorer-news/207-military-grid-reference-system-in-digiterra-explorer.html
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6.3.1 Port settings

The GPS serial port panel contains the following controls:

The GPS serial port panel

[ ] Simulation - Enables to use and play NMEA logfiles.

NMEA logfiles can be captured in DigiTerra Explorer on the Logger tab.

 dtGpsSim.log  - Clickable button to select a logfile. Default filename is dtGpsSim.log that can be
played next to the application's main EXE file: DTExp7.exe.

Parity: Choose the parity of your GPS/GNSS receiver. The default is No parity.
Databits: Choose the number of data bits of your GPS/GNSS receiver. The default is 8 bits.
Stopbits: Choose the number of stop bits of your GPS/GNSS receiver. The default is 1 stopbit.

6.3.2 Trimble GNSS settings tab

If you are using DigiTerra Explorer on Trimble devices the GNSS settings tab appears with basically
different controls. The GNSS settings tab has two modes: I.Trimble Pathfinder Tools based (SiRF
or TSIP) and II. NMEA. The default is the first one. These GPS port reading modes can be switched
on the GNSS Status panel with the button in the bottom right corner on Trimble devices only.

Supported Trimble GPS/GNSS receivers:

You can use DigiTerra Explorer with the GPS Pathfinder Tools SDK to control and configure any of
the following Trimble receivers:

GeoExplorer ® series handhelds (combined GPS receivers and Windows Mobile powered devices):
GeoXH ™ handheld
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GeoXM ™ handheld
GeoXT ™ handheld

Juno ™ series handhelds (combined GPS receiver and Windows Mobile powered device)
Juno ST handheld
Juno SB handheld
Juno SC handheld

Trimble Nomad ™ series handhelds (combined GPS receivers and Windows Mobile powered
devices)
Trimble Nomad G series handhelds (combined GPS receivers and Windows Mobile powered
devices)
Trimble Nomad 800/900GL handheld
Trimble Nomad 800/900GLC handheld
Trimble Nomad 800/900GLE handheld
Trimble Nomad 800/900GX handheld
Trimble Nomad 800/900GXC handheld
Trimble Nomad 800/900GXE handheld

GPS Pathfinder Pro series receivers:
GPS Pathfinder ProXH ™ receiver
GPS Pathfinder ProXT ™ receiver
GPS Pathfinder Pro XRS receiver
GPS Pathfinder ProXRT receiver

GPS Pathfinder receivers:
GPS Pathfinder XB receiver
GPS Pathfinder XC receiver

Trimble Recon ® GPS XB edition

Trimble Recon GPS XC edition

Switching between NMEA and SiRF protocoll on Trimble Juno/Nomad
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Video tutorial to about the GPS mode switching: http://www.youtube.com/watch?
v=gPHm3Ae5cws

GPS Settings tab on Trimble devices

PP base distance: base distance for postprocessing. Default value is less than 25 km. Use this
property to set or obtain the estimated distance to the base station that will be used during
postprocessing. If you will use more than one base station (during H-Star processing), specify the
estimated distance to the closest base station.

http://www.youtube.com/watch?v=gPHm3Ae5cws
http://www.youtube.com/watch?v=gPHm3Ae5cws
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SSF file: Starts writing into an SSF file for postprocessing when the GPS active. Displays only on
Trimble devices. The SSF file can be postprocessed with Trimble Pathfinder Office desktop software.

Setup box:

 GPS settings  - Opens the GPS settings panel

 Antenna settings  - Opens the Antenna settings panel

GPS is disconnected / GPS is connected: DigiTerra Explorer displays here the status of the GPS
connection

 Connect  - Establishes a connection to a GPS receiver. If the GPS receiver is already connected,
this command is not available. When you connect to the GPS receiver, the settings from the
software are sent to the GPS receiver to configure its operation.

 Disconnect  - Disconnects the software from the GPS receiver. If the GPS receiver is already
disconnected, this command is not available.

 Status  - Opens the Status panel

6.3.2.1 Trimble GPS settings

This panel is English as default and cannot be localized to other languages.

Trimble GPS Settings panel - General tab

Port: Displays the available GPS serial ports. Select a COM port here before connecting to the GPS
receiver. If you specify the wrong port, your application cannot communicate with the GPS receiver.
The default port setting is COM1.
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Masks

DOP Type: Default: PDOP. Use this property to specify whether to use a maximum PDOP or a
maximum HDOP value to control whether the GPS receiver is computing positions. A low DOP value
indicates that the visible satellites are widely separated in the sky, which gives better position
information. When the DOP value rises above the maximum setting, the application stops logging
positions.

When using a Juno SB, Juno SC, or Juno ST handheld, a GPS Pathfinder XB
receiver, or a GPS Pathfinder XC receiver, or the Trimble Yuma rugged tablet
computer, Trimble recommends that you set the DOP type to PDOP and then set
the MaximumPDOPMask property to 99

Max. PDOP: Default: 6.0. Use this property to view and set the maximum Position Dilution of
Precision (PDOP) for the satellite constellation. If the Trimble GPS receiver detects a higher PDOP
value for the current satellite constellation, the receiver stops computing positions until the PDOP
drops to or below the value of this property.

The PDOP value indicates the quality of a GPS position. It takes account of the location of each
satellite relative to the other satellites in the constellation, and their geometry in relation to the GPS
receiver.

Specify a lower maximum PDOP to collect fewer, more precise positions. However, decreasing the
maximum PDOP too far below the value recommended for your GPS receiver significantly decreases
the time during which you can calculate positions, and does not significantly increase accuracy.

Specify a higher maximum PDOP to collect more, less precise positions. However, increasing the
maximum PDOP can seriously degrade position quality.

Legal values for this property are 1-99. A PDOP value of 4 or less gives excellent positions. A PDOP
of between 4 and 8 is acceptable. A PDOP of 8.0 or more is poor. The default maximum PDOP is 6.

When using a Juno SB, Juno SC, or Juno ST handheld, a GPS Pathfinder XB
receiver, or a GPS Pathfinder XC receiver, or the Trimble Yuma rugged tablet
computer, set the maximum PDOP to 99.

Max. HDOP: Default: 4.0. Use this property to view and set the maximum Horizontal Dilution of
Precision (HDOP) for the satellite constellation. If the Trimble GPS receiver detects a higher HDOP
value for the current satellite constellation, the receiver stops computing positions until the HDOP
drops to or below the value of this property.

 When using a Juno SB, Juno SC, or Juno ST handheld, a GPS Pathfinder XB
receiver, or a GPS Pathfinder XC receiver, or the Trimble Yuma rugged tablet
computer, Trimble recommends that you do not use this property. Instead, set the
DOP Type property to PDOP and then set the Max. PDOP property to 99.

Specifying a maximum HDOP can give greater productivity than filtering the solutions with a
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maximum PDOP. Setting a maximum PDOP rejects some positions that have an acceptable HDOP
value, because their VDOP (Vertical Dilution of Precision) value is unacceptable. When you use a
maximum HDOP, these positions are accepted.

Use the HDOP setting when vertical precision is not particularly important, and your position yield
would be decreased by excluding positions with a high vertical component in the PDOP value (for
example, if collecting data under canopy).

Legal values for this property are 1-99. The maximum HDOP should typically be set to
approximately two-thirds of your normal PDOP setting. An HDOP value of 4 or less gives excellent
positions.

Min. Elevation: Default 15°. Use this property to view and set the maximum Position Dilution of
Precision (PDOP) for the satellite constellation. If the Trimble GPS receiver detects a higher PDOP
value for the current satellite constellation, the receiver stops computing positions until the PDOP
drops to or below the value of this property.

The PDOP value indicates the quality of a GPS position. It takes account of the location of each
satellite relative to the other satellites in the constellation, and their geometry in relation to the GPS
receiver.

Specify a lower maximum PDOP to collect fewer, more precise positions. However, decreasing the
maximum PDOP too far below the value recommended for your GPS receiver significantly decreases
the time during which you can calculate positions, and does not significantly increase accuracy.

Specify a higher maximum PDOP to collect more, less precise positions. However, increasing the
maximum PDOP can seriously degrade position quality.

Legal values for this property are 1-99. A PDOP value of 4 or less gives excellent positions. A PDOP
of between 4 and 8 is acceptable. A PDOP of 8.0 or more is poor. The default maximum PDOP is 6.

When using a Juno SB, Juno SC, or Juno ST handheld, a GPS Pathfinder XB
receiver, or a GPS Pathfinder XC receiver, or the Trimble Yuma rugged tablet
computer, set the maximum PDOP to 99.

Min. SNR: Default: 39. Use this property to view and set the minimum signal-to-noise ratio (SNR)
value of each satellite tracked by the Trimble GPS receiver. The SNR is a measure of the quality of
the signal from a satellite. When the SNR of a satellite falls below the minimum value, the receiver
stops using that satellite to calculate GPS positions.

If you lower the minimum SNR, the GPS receiver uses satellites with weaker
signals. While this may increase the GPS coverage you can obtain in
environments where the GPS signal is weakened (such as forests), it can reduce
accuracy.

Applications created using version 2.00 and later of the GPS Pathfinder Tools SDK store and display
SNR values as Carrier-to-Noise ratio (C/No) values, measured in decibel-Hertz (dBHz). Applications
created using previous versions of the SDK stored and displayed signal-to-noise ratio (SNR) values
as Amplitude Measurement Unit (AMU) values.
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The typical SNR of a satellite at 30° elevation is between 47 and 50 dBHz. The quality of a GPS
position degrades as the SNR of one or more satellites in the constellation falls below 39 dBHz.

Legal values for the Minimum SNR property range from 12 to 47 dBHz. Typical Minimum SNR Mask
values for most supported Trimble GPS receivers are 33 to 43 dBHz.

 When using a Juno SB, Juno SC, or Juno ST handheld, a GPS Pathfinder XB
receiver, or a GPS Pathfinder XC receiver, or the Trimble Yuma rugged tablet
computer, Trimble recommends that you set the minimum SNR to 12 dBHz.

The Minimum SNR Mask only applies to L1 data. If a satellite is outputting L1 and
L2 signals, and the SNR of the satellite’s L1 signal meets the required minimum
SNR, then the  L2 signal from the same satellite is always used.

Min. Satellites: Default: 4 (for three-dimensional positions). Use this property to view and set the
minimum number of GPS satellites that must be tracked by the Trimble GPS receiver before a GPS
position is calculated. If the receiver detects a lower number of satellites in the sky, it stops
calculating positions until the number of qualified satellites (that meet the other property
requirements) meets or exceeds the value of this property.

The minimum number of satellites required to calculate a three-dimensional position is four, which is
the default setting. If you want to collect high-accuracy data, the minimum number of satellites
required to calculate a three-dimensional position when the GPS receiver is moving is five (for
example, when logging an area or line feature).

Apply Velocity Filter: Default: Off. Use this property to enable or disable the position velocity filter
in the connected Trimble GPS receiver. Velocity filtering smooths the positions from the GPS
receiver as they are generated, using velocity information. This filter reduces the effects of multipath
on positions computed by the GPS receiver.

Files collected with the Velocity Filter property enabled cannot be differentially
corrected using Trimble postprocessing software unless H-Star data or carrier
phase measurements are logged.

Velocity filtering is not appropriate in all environments, and should only be applied in situations
where hostile GPS conditions are expected to degrade position accuracy. When used on
predominantly good data, the filtering may decrease the accuracy of the data. Trimble recommends
that you apply velocity filtering during differential correction. This gives you the flexibility to reprocess
the data with and without velocity filtering, and then choose the best result.

When using a Juno SB, Juno SC, or Juno ST handheld, a GPS Pathfinder XB
receiver, or a GPS Pathfinder XC receiver, or the Trimble Yuma rugged tablet
computer, velocity filtering is unavailable.
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Use GLONASS (if available): Default: On. Use this property to enable or disable tracking of
GLONASS satellites in the connected GPS receiver. If the connected receiver is not GLONASS-
capable, the setting for this property has no effect and only GPS satellites are tracked.

Tracking GLONASS satellites as well as GPS satellites can improve productivity by reducing the
time required to achieve real-time or postprocessed decimeter or subfoot solutions and increasing
the amount of data collected (increased yield), particularly in tough environments such as around tall
buildings and under heavy tree canopy.

Trimble GPS Settings panel - Real-time tab

Real-time Settings
Use the Real-time Settings form to select the real-time differential GPS sources that you use, if any,
and to configure how your system communicates with each source.

Note – Data collected using a Recon GPS CF Card receiver cannot be differentially corrected, either
in real time or using postprocessing.

To open the Real-time Settings tab, do one of the following:
In the GPS Settings panel, tap Real-time.

In any screen in the Real-time section, tap the Setup button. 

DigiTerra Explorer always uses the highest priority real-time source available, according to your list
of preferences. If the source it is currently using becomes unavailable, the software switches to the
next choice. Whenever DigiTerra Explorer acquires a higher priority real-time source, it switches
back to this source. For example, the software will not use your second choice if your first choice is
available.

It is important that you set up all of the choices correctly, so that when DigiTerra Explroer software
switches between choices it can continue to receive corrections.

Source types
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Selectable source types

Default: None to both Source Types

None: The application will not use a real-time DGPS correction stream

Beacon: The application will use real-time DGPS corrections from a marine radio beacon, received
by the GPS receiver's integrated beacon receiver

Com Satellite: The application will use real-time DGPS corrections from a satellite differential
correction service, received by the GPS receiver's integrated communication satellite receiver

SBAS: The application will use real-time DGPS corrections from a Satellite Based Augmentation
System (SBAS), received by the GPS receiver's integrated SBAS receiver

Receiver Port: The application will use real-time DGPS corrections from an external real-time
correction source connected to a port on the GPS receiver

Direct Dial: The application will use real-time DGPS corrections from an external real-time
correction source connected to the field computer using a direct dial modem

Serial Port: The application will use real-time DGPS corrections from an external real-time
correction source connected to a serial port on the field computer

Internet: The application will use real-time DGPS corrections from an external real-time correction
source connected to the field computer using an Internet connection
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6.3.2.2 Trimble Antenna settings

This panel is English as default and cannot be localized to other languages.

Trimble Antenna settings

Height: the height of the antenna above the ground

Please, enter "0" on the GNSS Survey panel when using the Height
parameter on the Trimble Antenna Settings panel, anyway the measured
height offsets with the default value of the Antenna height (on the GPS Survey
dialog.)

GNSS Survey Up/Down offset
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Type: the type of antenna that is being used

Measure Height To: the physical point on the antenna that was used when measuring the height
(the "measurement method")

Trimble postprocessing software uses "Measure Height To" information to compensate for the
antenna height when displaying positional information, which gives more accurate elevation readings.
For example, if an antenna height of 2.0 meters is specified, the postprocessing software
automatically subtracts 2.0 meters from all GPS position and feature elevations, and displays the
true ground elevation rather than the elevation at the antenna.

DigiTerra Explorer determines the list of available antennas and measurement methods. If the
application is connected to a GPS receiver, only the antenna types supported by the connected
receiver are shown. If the application is not connected to a GPS receiver, all antenna types are
shown.

When the user clicks the OK button, the new antenna settings are applied. If an SSF file is open, an
SSF Survey Station record is also written. The Survey Station record allows the postprocessing
software to determine the antenna settings, and to apply the appropriate offset to all subsequent
elevations in the file.

6.3.2.3 Trimble Status

This panel is English as default and cannot be localised to other languages.

Trimble Status panel
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Receiver: Shows the type of the receiver
GPS: Shows the used/viewed number of satellites; and the GPS status codes:

Calculating Positions
Waiting For GPS Time
High PDOP
Waiting For Satellites
High HDOP

Position: Shows the coordinates of the current position.
Altitude: Shows the current altitude in meter.
Carrier: Shows the current status of carrier logging, and the length of time that carrier phase or H-
Star data has been recorded since lock on the required number of satellites was obtained.

Est. Accuracy: This property shows the estimated accuracy of the GPS position in meters. The
estimated accuracy has a confidence level of 68%, which means that 68% of the time the actual
position should be within the estimated distance of the measured position. The estimated accuracy
reflects the accuracy of the positions that are being collected in real-time, whether they are
autonomous positions, or real-time differentially corrected positions. To differentiate it from the PPA,
the estimated accuracy is sometimes referred to as the Current Estimated Accuracy (CEA).

PPA: The Predicted Postprocessed Accuracy (PPA) value can provide an estimate of
postprocessed accuracy, but only when logging H-Star data. It does indicate the accuracy that
might be achieved after postprocessing.

DOPs: Shows the current HDOP and PDOP values

Antenna: Retrieves the current status of the antenna. The Status value indicates whether the
antenna is disconnected, or whether the Trimble GPS receiver is using its internal antenna, or is
connected to an external antenna. (Not all GPS receivers report the antenna status.) 

Battery: Indicates the current battery level. In addition, this event can notify your application of a
battery level change as soon as the change occurs. The battery level of the receiver is checked at
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least once every 30 seconds. If the battery voltage has changed by more than 0.1 volts, or if the
percentage remaining has changed by more than 1.0%.

DGPS Status: Indicates the current DGPS statuses
No DGPS Source Selected - A real-time differential correction source is not selected.
DGPS Operating - A real-time differential correction source is selected and corrected positions are
being received.
DGPS Not Operating - A real-time differential correction source is selected but corrected positions
are not being received.

Averaged SNR: Shows the averaged SNR value to all used satellites

6.3.3 The geoid undulation

DigiTerra Explorer calculates heights in two ways:

1. Height above ellipsoid. This is the default. 
2. Height above Mean Sea Level if a geoid undulation value is specified by using a geoid

undulation file.

About the height calculation please also have a look at this tutorial at http://
forum.digiterra.hu/viewtopic.php?f=59&t=308

To specify appropriate value of the Upward offset field on the GPS Survey panel for calculating the
height value it is necessary to understand how DigiTerra Explorer calculates heights

GPS receivers output the height of the GPS antenna, in meters, via the GGA sentence of the NMEA
protocol. This height is relative to Mean Sea Level. Many GPS receivers also output the geoid
undulation, in meters, via the same GGA sentence. The geoid undulation is the distance between
the geoid and ellipsoid. DigiTerra Explorer then calculates the sum of the GPS antenna height
(relative to Main Sea Level) and the geoid undulation to produce the ellipsoidal height (Height Above
Ellipsoid) which is potentially stored as the height value. So from the GGA message, DigiTerra
Explorer calculates Height Above Ellipsoid using the following formula:

Height Above Ellipsoid = Main See Level Height ± Geoid undulation value

This Height Above Ellipsoid value is based on the datum used by the GPS receiver, which is
typically WGS84. The default unit for Height Above Ellipsoid value is meter. When the TSIP protocol
is used on Trimble devices, DigiTerra Explorer requests the Height Above Ellipsoid height from the
GPS. Consequently, no calculation of the Height Above Ellipsoid is needed by DigiTerra Explorer.

To store accurate height values, it is necessary to provide DigiTerra Explorer with additional
information to be used for calculating the height values. Upward offset: Since the height reported by
the GPS is actually the height of the GPS antenna, it is necessary to let DigiTerra Explorer know
the height of the GPS antenna above the ground. DigiTerra Explorer then subtracts the antenna
height from the GPS height to determine the height value for the GPS position at ground level. The
default Upward offset (antenna height) is -1.5 meter.

Geoid undulation
The geoid undulation file provides the geoid separation value (distance between the geoid and
ellipsoid) to the current Latitude, Longitude GPS position. DigiTerra Explorer subtracts the geoid

http://forum.digiterra.hu/viewtopic.php?f=59&t=308
http://forum.digiterra.hu/viewtopic.php?f=59&t=308
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undulation from the ellipsoidal height to determine the height for the heights value. The resultant
height is the Main Sea Level, or orthometric height. The Geoid undulation is negative where the geoid
lies below the ellipsoid.

The geoid undulation file built based on the official Earth Gravitation Model's (EGM2008) 2.5 Minute
Geoid Heights (has been publicly released by the U.S. National Geospatial-Intelligence Agency
(NGA) EGM Development Team.)

The EGM2008 Model

GGA String
 
GGA - Global Positioning System Fix Data, Time, Position and fix related data for a GPS receiver.   

Field Number:  
1)   Universal Time Coordinated (UTC) 
2)   Latitude 
3)   N or S (North or South) 
4)   Longitude  
5)   E or W (East or West) 
6)   GPS Quality Indicator,  

0 - fix not available,  
1 - GPS fix,  
2 - Differential GPS fix 
    (values above 2 are 2.3 features) 
3 - PPS fix 

http://earth-info.nga.mil/GandG/wgs84/gravitymod/egm2008/egm08_wgs84.html
http://earth-info.nga.mil/GandG/wgs84/gravitymod/egm2008/egm08_wgs84.html
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4 - Real Time Kinematic 
5 - Float RTK 
6 - estimated (dead reckoning) 
7 - Manual input mode 
8 - Simulation mode 

7)   Number of satellites in view, 00 – 12 
8)   Horizontal Dilution of precision 
9)   Antenna Altitude above/below mean-sea-level (geoid) 
10) Units of antenna altitude, meters 
11) Geoidal separation, the difference between the WGS-84 earth ellipsoid and mean-sea-
level (geoid), "-" means mean-sea-level below ellipsoid 
12) Units of geoidal separation, meters 
13) Age of differential GPS data, time in seconds since last SC104 type 1 or 9 update, null field
when DGPS is not used 
14) Differential reference station ID, 0000-1023 
15) Checksum 
 
Relation to Geoid Undulation
 
H = h - N

H:   Ellipsoid height  
h:   Orthometric height (Field 9) (mean-sea-level height) 
N:   Geoidal separation (Field 11) 
 
What you read in field 9 is an orthometric height (h) corrected by global geoidal 
separation (N) in meters, based on the official NATO's standard mean-sea-level algorithm 
(5-degree grid of height).  
 
To calculate the ellipsoid height (H) use this formula: 

H = h - N (NATO)
(H = Field 9 - Field 11)

Now use the interpolated geoidal separation to calculate the correct ellipsoid height (h). 
 
h = H + N (EGM2008 interpolated)

The EGM2008 geoid undulation file can be downloaded to DigiTerra Explorer from the following link: 
http://www.digiterra.hu/downloads/DigiTerra_Explorer/geoidUnd.rar. Must be copied the
uncompressed files to the \Geoids path.

The geoidund.rar contains the following files:

geoidUnd.dat
geoidUnd.ers
geoidUnd.hdr

Custom raster grids (more accurate) can be used by replacing the geoidUnd.dat file with the new
raster's header file: geoidUnd.hdr. In case of using a custom grid file you have to copy or calculate
the next values based on the geoidUnd.ers file (header file values = ERS file values):

http://www.digiterra.hu/downloads/DigiTerra_Explorer/geoidUnd.rar
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EastMin = Eastings
EastMax = Eastings + NrOfCellsPerLine * Xdimension
EastSize = Xdimension
NorthMin = Northings - NrOfLines * Ydimension
NorthMax = Northings
NorthSize = Ydimension

The original geoidUnd.ers (ERS file values):

DatasetHeader Begin

DataFile = "geoidUnd.dat"

DataSetType = ERStorage

DataType = Raster

ByteOrder = LSBFirst

Commnet = "Geoid undulation 2.5 x 2.5 min global"

CoordinateSpace Begin

Datum = "WGS84"

Projection = "Geographic"

CoordinateType = EN

Rotation = 0:0:0.0

CoordinateSpace End

RasterInfo Begin

CellType = IEEE4ByteReal

CellInfo Begin

Xdimension = 0.04166666666666667

Ydimension = 0.04166666666666667

CellInfo End

NrOfLines = 4321

NrOfCellsPerLine = 8642

RegistrationCoord Begin

Eastings = -0.04166666666666667

Northings = 90

RegistrationCoord End

NrOfBands = 1

RasterInfo End

DatasetHeader End

The original geoidUnd.hdr (header file values):

// Geoid Undulation Matrix

// Format: 4 or 8 byte floating point, little endian encoding

// Data Order: rows from eastmin to eastmax, columns from northmax to northmin

EastMin=-0.04166666666666667

EastMax=360

EastSize=0.04166666666666667

NorthMin=-90

NorthMax=90

NorthSize=0.04166666666666667

Header=0

DataSize=4

Dimension=1

NullValue=0
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6.3.4 Using geoid files

Geoid Separation File: This option will incorporate the geoid undulation in determining the
orthometric elevation of the measurement. The definition of the geoid model as currently adopted by
the National Geodetic Survey is the equipotential surface of the Earth's gravity field which best fits, in
a least squares sense, global mean sea level. Orthometric elevation measurements are used in
survey calculations.  In order to convert ellipsoid heights (He) as measured by GPS into orthometric
elevations (Eo), you must provide for a correction between the GPS-measured ellipsoid (reference
ellipsoid) and a constant level gravitational surface, the geoid.  This correction is the geoid
undulation (Ug).

How to use Geoid Separation Files with DigiTerra Explorer
1. Copy the Geoid Separation File(s) to the following directory:

Default Geoid Directory

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Geoids

Mobile version: $SDCARD\Geoids

2. Tap on the  Geoid File button on the Settings panel > GPS tab
3. Tap on the  New  button on the appeared message box to open the Geoid File panel

Geoid file selection message box
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 Deactivate  - Deactivates the geoid file usage

 Cancel  - Closes the geoid file selection message box

4. Select a geoid file

Geoid File selection panel

Successfully loaded geoid file
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Supported geoid file formats:

.DAT files

.BIN files

.GSF files

.GGF files

.GEO files

You can download several geoid separation files here: http://
resources.ashtech.com/GEOIDS

The selected geoid separation file can be applied on the Calculate panel in
determining the orthometric elevation of the calculated position.

6.4 NTRIP

The DGPS tab is an NTRIP Client and available only in DigiTerra Explorer Professional edition. The
program handles the HTTP communication to receive streams from an NTRIP Caster. After
downloading a source table, setting up the session parameters and connect to the receiver on the
GPS Status dialog with the Connect button or by opening the GPS Survey panel, the software
connects to the NTRIP Caster and writes the received GNSS data stream to a defined serial port
until the session is stopped.

Receiving a stream is continuously indicated by the "Received data" control. In addition, the total
amount of received bytes is displayed as long as a session continues. Handling instructions as well
as error messages are shown on the message boxes. The program keeps the last session

http://resources.ashtech.com/GEOIDS
http://resources.ashtech.com/GEOIDS
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parameters, containing i.e. IP Address, Port, Username, Password, selected Mount point and COM-
port settings.

This tab is accessible in the Professional edition in the Desktop version as default. In the Mobile
version it is controlled by the device configuration file.

 = new feature Basic Advanced Professional

Availability of the "DGPS"  tab in different
editions

The DGPS tab contains the following controls:

The DGPS tab

For Trimble Mapping & GIS products, please read the Trimble GPS settings topic to set up a
real-time correction.

On Spectra products (MobileMapper 100 series, Promark 120 series) you have to
use the on-board DGNSS Configuration software.

The DGPS tab contains the following controls:

Max age: Real-Time correction Age Limit. 50 second or 150 second are good values to work with
in most cases. If for any reason, the reception of DGPS/DGNSS corrections is of poor quality, you
can increase this time limit up to 250 second without significantly impairing the position accuracy
normally achieved with DGPS. The default is 20 second.

Usage of the Max age property:

Use this property to set the maximum age of RTCM data that will be used. RTCM is a format for
real-time differential correction messages. RTCM are the initial letters of the Radio Technical
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Commission for Maritime Services. When a DGPS source is in operation, the GPS receiver gets a
stream of RTCM data. This data stream contains the corrections that improve the accuracy of the
GPS position. If the RTCM data is current, then maximum accuracy is achieved. If the DGPS data
stream is interrupted, the data already saved in the receiver ages. It is still useful, but the accuracy
begins to degrade as time goes on. If the data is too old, it is not useful.

This property allows you to trade off accuracy for yield. Choose a small value, for example 5
seconds, to ensure that all DGPS positions have the maximum accuracy. However, some positions
may not be corrected when the DGPS data stream is interrupted for more than 5 seconds. Choose a
larger value, for example 50 seconds, to allow DGPS positions to be computed with older data. In
this case, if the DGPS data stream is interrupted for 40 seconds, DGPS corrections continue to be
applied but the accuracy of these positions is not as good.

DigiTerra Explorer sends NMEA GGA sentence based on the selected Max age value. e.g. if you
selected 20 sec the GGA will be sent in every 20 seconds to the service provider if it is necessary to
receive corrections in the selected stream.

Broadcaster settings:

IP Address and port of an NTRIP Caster, Username and Password are broadcaster information.

Broadcaster settings

Address: NTRIP Caster IP Address or Host name
Port: Port number of the NTRIP Caster's IP Address or Host name. In most cases you can use 80
or 2101 as port number. The default is 2101.
Username:  Used-ID for the NTRIP Caster
Password: Password for the NTRIP Caster

Mount point selection and Output settings:

Select Mount point and Output

Mount point: Tap on the  Choose...  button to open the Source table panel with the available
streams
Received data: Displays the total amount of received RTCM data in bytes as long as a session
continues
Serial COM-Port settings: Tap on this button to open the Output's Serial port settings panel
Apply: This button is active only when the software is connected to the receiver and you changed
the currently used Mount point. Tap on this button to apply changes.
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6.4.1 Source table

Once you have entered the connection settings of an NTRIP Caster within the DGPS dialog, you find
details about its data streams in the this panel. Select the stream in the Source drop-down list you
are looking for. The dialog also shows details about the Network the stream belongs to.

Source table

Select Network: Select a Network to filter the list of the selectable streams
Select Stream: Select a mount point
 
Stream details: Shows the details of the selected NTRIP mount point

 Refresh  - Updates the list of the available mount points

 Cancel  - Cancels the selected mount point and closes the Source table panel

 OK  - Selects the current mount point and closes the Source table panel

6.4.2 Serial port settings

This dialog enables you to define the serial COM port output option to forward a DGNSS or RTK data
stream as received from an NTRIP Caster to the serial connected GNSS receiver. Details defining
the COM-port communication are to be entered through this dialog.

NTRIP Serial COM port settings
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In the most cases you need to apply the same connection settings as on the GPS serial port
settings dialog.

COM port: Select a COM port to forward the received NTRIP data stream. The default is COM1
Baudrate: Select a baudrate. The usage of a high baud-rate is recommended (e.g. 19200 or higher)
if supported by your hardware.
Parity: Choose the parity of your GPS receiver. The default is No parity.
Databits: Choose the number of data bits of your GPS receiver. The default is 8 bits.
Stopbits: Choose the number of stop bits of your GPS receiver. The default is 1 stopbit.

 Cancel  - Cancels the port configuration and closes the dialog.

 OK  - Enables the defined port configuration and closes the dialog.

6.5 Command

The Send command tab is a serial command line interface tool to any GNSS receivers that connects
via serial COM port to DigiTerra Explorer and supports this feature. You can type serial commands /
use serial command files using with your GNSS receiver to set or report internal settings.

This should be done only in consultation with your GNSS receiver's dealer. See the GNSS receiver's
operations manuals for a complete list of GNSS receiver commands.

Coming serial command files with DigiTerra Explorer are located in the following paths:

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Scripts\

Mobile version: $SDCARD\Scripts\

 = new feature Basic Advanced Professional
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Availability of the "Send Command"  tab in
different editions

The Send Command tab contains the following controls:

The Send Command tab

Command combo box: type the command here you want to send to the connected receiver then
tap on the Send button. This combo also lists the previously sent serial commands as a drop-down
list. Saved commands are stored in the GNSSCommandHistory.txt file.

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\GNSSCommandHistory.txt

Mobile version: $SDCARD\Bin\GNSSCommandHistory.txt

Target Device: list the operation modes of the sending command

<General>: General mode, can be used with most of the receivers
Altus: Recommended for Altus receivers
Hemisphere: Recommended for Hemispehere receivers

Report window: list the sent commands and reports the response coming from the receiver

 Startup Commands  - You can select a Command File here that will be sent to the receiver upon
serial port connection

 Close Commands  - You can select a Command File here that will be sent to the receiver when
disconnecting from the receiver

 Clear  - Clears the report window

 Command File  - Select a Command File here and tap on the Send button to send it to the receiver
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 Save Log  - Saves the content of the Report window into a .LOG file

6.6 Antenna

The Antenna tab is used to configure the receivers external Antenna.

 = new feature Basic Advanced Professional

Availability of the "Antenna"  tab in
different editions

The Antenna tab contains the following controls:

The Antenna tab

External antenna: Enables to use external antenna

Antenna:  The entire list of supported antennas is available for selection if the External antenna
check-box is checked. To select/change an antenna tap on the large  Please select!  button and
select in the tree by manufacturer on the Select Antenna panel. The chosen antenna model can now
be seen on the place of the  Please select!  button.

Selecting an external antenna
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L1 Offset: Vertical Phase Center Eccentricity for L1. This value in mm refers to the vertical distance
between the top of the pole (or the base of the antenna) and the L1 phase center of the selected
antenna. The L1 Offset is = 0 mm if there is no selected external antenna.

Rod height: Height of the rod in meters. The Rod height is = 0 m if the there is no selected
antenna. Default Rod height = 2 m.

Antenna height = Rod height + L1 Offset. It is global variable (for all layers) and its value
will be deducted from the HAE (Height Above Ellipsoid).
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About the height calculation please also have a look at this tutorial at http://
forum.digiterra.hu/viewtopic.php?f=59&t=308

Please note, that the Antenna height is not applied on the GNSS Survey dialog as
in version 6, but you can still apply different Up/Down offset values there for any
layer.

6.7 Logger

The Logger tab contains the following controls:

Please note that the GNSS logfile button inactive in the trial edition.

 = new feature Basic Advanced Professional

Availability of the "Logger"  tab in different
editions

The Logger tab

 GNSS log:  - You can save the projected GPS coordinates into a GPS tracklog file when the GPS
active. Tap on the  GPS log:  button to set the path of the GPS tracklog file. The GPS logfile is
turned off as default.

NMEA: Stores NMEA 0183 sentences in the selected GPS tracklog file when the GPS active. The

http://forum.digiterra.hu/viewtopic.php?f=59&t=308
http://forum.digiterra.hu/viewtopic.php?f=59&t=308
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default is unchecked.

GNSS position: Sets the type of geometry for processing of last added GPS tracklog file.

Points: Creates points from every GPS position with ID, Date data fields.
Lines: Creates lines between GPS positions with ID, Date, Length, Speed data fields.
Polyline: Connects the GPS positions and create one polyline from it. Data fields are: Label,
Date, Length, Area.
Polygon: Connects the GPS positions and create one polygon from it. Data fields are: Label,
Date, Length, Area.

Move/Stand separation in the GNSS log:
Determination of standing status for GPS log statistics.

Time interval (±sec):  Set the time interval to select nearest points for speed calculation. It must be
larger than the sampling frequency in the GPS tracklog file! The default time interval is ±5 sec.
Speed limit (km/hour): Set the limit to delineate the standing (less) or movement (more). The
default speed limit is 2 km/hour.

Spatial analysis with the overlay layer:
Connecting GPS positions to polygons or nearest vector feature:

Polygon edge size (m): The program does not connect those positions to the area, where the
distance between the outline of the area and the position is closer than the defined polygon edge
size. The default edge is 5 m wide.
Proximity threshold (m): The minimum distance where the algorithm will interpret the current
position of the GPS tracklog as nearest position. The default proximity threshold is  0 m.

1. Identifier field: Select the data field to identify the connected feature in the Feature field of the
GPS log statistics. Default value is nothing.
2. Identifier field: Select an other data field to identify the connected feature in the Feature field of
the GPS log statistics. Default value is nothing.

6.8 Rangefinder

The Rangefinder tab contains the following controls:

 = new feature Basic Advanced Professional

Availability of the "Rangefinder"  tab in
different editions

The Rangefinder tab
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Rangefinder serial port settings:

The Serial Port Parameters are used to specify communication settings for your auxiliary serial port.
For most serial devices, it is usually not necessary to specify the Parity, Databits and Stopbits
additional serial communication settings.

Port: Choose the COM port that your Rangefinder is connected to on your device. The default is
COM8.
Parity: Choose the parity of your Rangefinder. The default is No parity.
Baud: Choose the baud rate (data transfer speed) of your Rangefinder’s output. The default is 4800.
Databits: Choose the number of data bits of your Rangefinder. The default is 8 bits.
Stopbits: Choose the number of stop bits of your Rangefinder. The default is 1 stopbit.

 Connect  - Connects to the Rangefinder.

 Disconnect  - Disconnects the Rangefinder.

Rangefinder debug: shows NMEA sentences when the Rangefinder is active.

6.9 Cable locator

The Cable locator tab contains the following controls:

 = new feature Basic Advanced Professional

Availability of the "Cable locator"  tab in
different editions

The Cable locator tab
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Serial port settings

The Serial Port Parameters are used to specify communication settings for your auxiliary serial port.
For most serial devices, it is usually not necessary to specify the Parity, Databits and Stopbits
additional serial communication settings.

Port: Choose the COM port that your Cable locator is connected to on your device. The default is
COM8.

Parity: Choose the parity of your Cable locator. The default is No parity.

Baud: Choose the baud rate (data transfer speed) of your Cable locator’s output. The default is
4800.

Databits: Choose the number of data bits of your Cable locator. The default is 8 bits.

Stopbits: Choose the number of stop bits of your Cable locator. The default is 1 stopbit.

Protocols settings

Protocol: Choose one from the following protocols

Leica Digicat 200 - or newer Digicat cable locators
3M Dynatel
SebaKMT vLocPro2
RD8000 - Radio Detection RD8000
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Video tutorials: SebaKMT vLocPro2; Radio Detection RD8000

Buttons

 Connect  - Connects to the Cable locator

 Disconnect  - Disconnects the Cable locator

 Create New Measurement Layer  - Creates a point feature layer with the following attributes:

You can capture the following attributes with 3M Dynatel
ID
Count
Date
PosX
PosY

You can capture the following attributes with Leica Digicat 200 or newer Digicat cable locators
ID
Device
SerialNumber
SoftwareID
Date
Calibration
SelfTest 
Battery
Mode
Signal
Unit
Depth

You can capture the following attributes with SebaKMT vLocPro2
ID
Date
PosX
PosY
Command
Frequency
Depth (mm)
Current (mA)
Locate Current Direction

You can capture the following attributes with Radio Detection RD8000
ID
Date
PosX
PosY
Mode

http://forum.digiterra.hu/viewtopic.php?f=59&t=323
http://digiterraexplorer.com/rd8000-cable-locator
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Frequency (HZ)
Depth (m)
Fault find signal (dB microvolts)
Locate current (A)
Phase (degrees)
Signal strength
Gain

Cable locator debug: shows NMEA sentences when the Cable locator is active.

6.10 Camera control

The Camera control tab is used to control a digital camera to take a picture by using camera control
commands and store the position of the taken picture in the edited point layer.

 = new feature Basic Advanced Professional

Availability of the "Camera control"  tab in
different editions

The Camera control tab contains the following controls:

The Camera control tab

Camera control serial port settings:

The Serial Port Parameters are used to specify communication settings for your auxiliary serial port.
For most serial devices, it is usually not necessary to specify the Parity, Databits and Stopbits
additional serial communication settings.

Port: Choose the COM port that your Camera is connected to on your device. The default is COM8.
Parity: Choose the parity of your Camera. The default is No parity.
Baud: Choose the baud rate (data transfer speed) of your Camera’s output. The default is 4800.
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Databits: Choose the number of data bits of your Camera. The default is 8 bits.
Stopbits: Choose the number of stop bits of your Camera. The default is 1 stopbit.

 Connect  - Connects to the Camera.

 Disconnect  - Disconnects the Camera.

Camera control command: Sends this command to the camera (to take a picture). The default
command is A.
Geometry distance: Sends the camera control command to the camera (to take a picture) when
the geometry distance is less or equal with the geometry distance between the nearest geometry
and the current GPS position in the active layer. The default distance is 1000 m.

6.11 Media

The Media tab is used to display an button to those features where the attribute record stores JPEG
photo, that is associated with the selected feature. The file name and the path of the digital JPEG
image is stored in a field associated with the selected feature’s geometry. A feature can have
multiple JPEG photos associated with it, but each photo file name needs to be stored in a unique
field or in a related child table.

The associated photo can be changed by either tapping on the file name on the Record dialog to
open the Document panel > Start Digital Camera button for capturing a new photo or by using the
Open document button to choose an existing photo on your device.

The Media tab contains the following controls:

The Media tab (Mobile version)

The Media tab (Desktop version)
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Show attached picture button on the map: Camera button displays on the map view if a JPEG
file attached in the geometry's attribute record

 Media path  - You can set the default media path where the software will store the transferred
JPEG pictures or AVI videos in case you are using a Ricoh Caplio digital camera.

To use the Media path feature please follow these steps:

1. Go Settings > System and Select the folder with the Media path button where the photos will be
saved
2. After these settings Create a New layer
3. Then open the Record panel to edit the Attribute table
4. Add a new Document (N) type field – by using this field the software will copy the image file next
to the layer and store it to the the current record

This solution can be used for:
selected feature
active record
active form

5. Take a picture with the camera

Photo filename prefix: you can change the first part of the default image file name captured with
the built-in camera. The second part is the continuous file number.

Use this app for opening .BMP files: Enables you to replace the default image viewer in the
desktop version. Default application for this setting is mspaint.exe.

 = new feature Basic Advanced Professional

Availability of the "Media path" option in
different editions



344 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

6.12 System

The System tab contains the following controls:

The System tab (Mobile and Desktop version)

   

 Menu   - The Menu option allows you to use a customized DigiTerra Explorer menu automatically at
startup. The default menu files are located in different paths in the Desktop and in the Mobile version.
Tap on the [Menu] button to select a custom menu then restart the software.

Default menu file: Default.mnu

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Default.mnu

Mobile version: $SDCARD\BIN\Default.mnu

 = new feature Basic Advanced Professional

Availability of the "custom menu" option in
different editions

 Toolbar  - The Toolbar option allows you to load a customized DigiTerra Explorer toolbar
automatically at startup. Tap on the [Toolbar] button to select a custom toolbar then restart the
software.

Default toolbar file: Default.tbr

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Default.tbr

 = new feature Basic Advanced Professional

Availability of the "custom toolbar" option
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in different editions

The used commands can be found in Menu and Toolbar definitions topic for menu
(.mnu) and toolbar definition file (.tbr).

 Install Trimble SDK  - Installs the Trimble SDK CAB components from the $SDCARD\2577\Trimble\
folder on the Mobile version. This button active only on Trimble Pathfinder Tools SDK related devices.

 = new feature Basic Advanced Professional

Availability of the "Pathfinder Tools SDK"
feature for Trimble receiver in different
editions

 Symbols  - The Symbols option allows you to load a customized symbols file at startup.

Default symbol file: Symbols.bmp

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Maps\Symbols.bmp

Mobile version: $SDCARD\Maps\Symbols.bmp

 = new feature Basic Advanced Professional

Availability of the "custom symbol" option
in different editions

The path of the used Symbols file stored in the DigiTerra Explorer Map file (.EXP)
and reloaded automatically (if exists) when open the DigiTerra Explorer Map file. If
you use a customized Symbols file, suggested to store it in the same directory
with the DigiTerra Explorer Map file.

Pen tolerance (pix): You can set the editing tolerance in pixels. The default pen tolerance is 8
pixels.

Open FieldWork panel on startup: Starts DigiTerra Explorer automatically with the FieldWork
panel at startup. Default is unchecked.

Automatically check for updates at startup: Updates DigiTerra Explorer automatically when new
updates are available. Default is unchecked.

Program execution log: On - Logs the required parameters for support issues. Full - fully detailed
log. Default is Off.

Attachment size: Enabled size of the attachment, that you can send with the E-mail > Send E-mail
function. Values: -, 3, 5, 10, 20 MB; default is 5 MB. 

 = new feature Basic Advanced Professional
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Availability of the "Attachment size" option
in different editions

File loading limit: Default is 8 MB.

6.13 Messages

The Messages tab is used to configure the appearance of the listed Message boxes that notify you
about various events in DigiTerra Explorer. On this dialog you can enable or disable them. When
checked, the selected alert message will be active.

The Messages tab contains the following controls:

The Messages tab
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6.14 Layout

The Layout tab contains the following controls:

The Layout tab

Classic layout: DigiTerra Explorer uses the Windows API® controls

Explorer 7 layout: DigiTerra Explorer uses the DigiTerra GUI controls

Classic and Explorer 7 layouts
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6.15 Path

The Path tab contains the following controls:

The following buttons displays the default folders on the current device which can be changed by
pressing the proper button

Geoids -  Changes the path of the geoid files

Updater work folder - Changes the path where the updater download temporarily data

Maps

My Mapping Projects - Changes the path of the default Mapping Projects

Background Maps Cache - Changes the path of the Background Maps cache. It is important to
change this folder if you have not enough free space in the main memory on a handheld but you have
an SD Card to store large amount of data.

Logs -  Changes the logging folder

7 Feature Properties

The following feature types can be used with DigiTerra Explorer (depending on the selected vector
layer format):

Point feature geometry
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Multipoint feature geometry

Line/polyline feature geometry
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Multiline feature geometry

Polygon feature geometry
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Multipolygon feature geometry: island(s) and outer parts

  

8 Layer Properties

Layer properties can be managed on the Layers panel. It is used to configure various options that
are specific to each layer in the map view.

Accessing:

Layer Manager icon at the top left side on the Pan frame
Accessing to the Layers panel on the Pan frame
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Layer Maganer command in the File > Layers sub-menu
Accessing to the Layers panel in the Menu

Layer Manager icon in the Toolbar (Desktop) (in the Desktop version)
Accessing to the Layers panel on the Toolbar

The Layers panel
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The following type of layers can be managed on the Layers panel:

Vector (2D, 3D, TIN)
Raster
Text and tabular files

8.1 Overview

The Layers panel shows all the layers of the current map view, including vector and raster layers,
individual text (text file layer) and related data tables. It is used to manage the layers in the map
view and set various layer properties.

The layers in the map view are drawn in reverse order, from the bottom of the layers list to the top
On the Layers panel
o the order of the layers can be changed

o the visibility of the layers can be turned on or off

o layers can be activated for the Identify and Snapping command

o layers can be activated (or locked) for editing or set the point info layer property for point feature

layers
o layers can be selected for removing

o displays the layer type (vector, raster, textual, tabular) and the feature type (point, line, polygon)

o displays the layer name

o new layers can be created to the map view

o existing layers can be added to the map view

o selected vector layers can be merged

o active layer can be exported into different file formats

The Scale, Source: Vector, Raster, TIN, Classes, and Labels panel can be opened to view and
change various properties for the active layer.

Layers panel
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A - Buttons: New Layer, Add Layer, Layer operations (Remove, Merge), Export layer, Display scale
range, Layer properties, Layer classification, edit classes, Labeling
B - The OK button applies any changes to the current map view and closes the Layers panel. The
changes are not saved unless you explicitly save the changes with the Save project command. 
C - Layer visibility
D - Identify: identify and snapping commands and printable legend
E - Edit
F - Select
G - Layer buttons
H - Layer name (it can be changed on the Source panel)
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8.2 Buttons

The Layers panel contains the following buttons:

Buttons of the Layers panel

 New Layer
Opens a pop-up menu with the following options:
o Database: Opens the New db Layer panel to create a new geodatabase layer

o File: Opens the Create layer file panel to create a new vector layer

New Layer - pop-up menu

More details about the relevant commands to this button can be found in the Layers sub-menu topic.

 Add Layer
Opens a pop-up menu with the following options:
o Database: Opens the Add db Layer panel to add a geodatabase layer to the map view

o File: Opens the Append layer panel file to add one or more layers to the map view

Add Layer - pop-up menu
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More details about the relevant commands to this button can be found in the Layers sub-menu topic.

 Layer operations
Opens a pop-up menu with the following options:
o Remove: Removes selected layers from the list

o Merge: Merges selected layers from the list. The merged layers can be saved into a new vector

layer file.

Layer operations - pop-up menu

Only the selected vector layers can be merged into MAP, DGN, DXF and MIF
multi feature vector format: more than one feature type i.e. point, line and polygon within
one layer

 Layer export
Opens a pop-up menu with the following options:
o Database: Opens the Save db Layer panel to save (export) the active layer as a geodatabase

layer
o File: Opens the Save as file panel file to export the active layer into another file format or to

save it with a different new name.

Add Layer - pop-up menu
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More details about the relevant commands to this button can be found in the Layers sub-menu topic.

 Display scale range
Opens the Scale panel. Sets the display scale range of the layers.

 Layer properties
Opens different Source paneles by data source type as:
o Vector layers, text and tabular files

o Raster layers

o TIN layers

to display and edit the properties of the data source.

 Layer classification, edit classes
Opens different paneles by data source type as:
o Vector layers --> Classes panel. The Classes panel lists all the thematic classes to the active

DigiTerra Explorer vector layer as well as the symbology defined for the layer.
o Raster layers --> Raster Options panel

o TIN layers --> DEM Options panel

 Labeling
Opens the Labels panel. Labels a vector layer with the contents of the selected attribute field. Sets
label properties.
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8.3 List handling
The list handling area is marked with red line in the Layers panel

Layer Visibility

 Tapping toggle turns the visibility for all layers on/off.

 Turns on/off the visibility of the active layer. Drag: turns on/off the visibility collectively.

When checked, the layer is drawn on the DigiTerra Explorer map, provided that the map scale is
within the range specified on the Scale panel of the Layers panel.

When unchecked, the layer will not be drawn.

The layer visibility settings can be stored in DigiTerra Explorer Map file (.EXP) or
DigiTerra Map Pack file (.DMP) formats.

Identifying

 Tapping toggle turns identify and snapping commands and printable legend on/off for all layers.

 Turns on/off the identify and snapping commands and printable legend of the active layer. Drag:
turns on/off the identify option and snapping collectively.

When checked, the layer is active for querying with the Identify and with the Search tool.
When checked, the snapping is used to the layer (and between layers) when creating or editing
features. 

When unchecked, the layer is not active for Identify and for the Search tool.
When unchecked, the snapping is not used to the layer (and between layers) when creating or
editing features.
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The layer identify settings can be stored in DigiTerra Explorer Map file (.EXP) or
DigiTerra Map Pack file (.DMP) formats.

Editing

 Locks all layers.

 Designates a layer for editing. Only one layer can be edited at the same time.

When checked the layer is active for editing. When unchecked the layer is not active for editing.

Edited layer

Editable layer on the map
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Layers without a corresponding Edit button are not editable in DigiTerra Explorer.

Layers are not editable due to one of the following reasons:
1. Editing of the layer type is not supported in DigiTerra Explorer (image layers).
2. The layer is read-only. Vector layers can be read-only if the file permissions are set as read-only. 

  Locked layer
Unlock a locked layer: tap on the  button and select the Edit option from the displayed "Lock /
Edit / Point info" menu.

 Not unlockable layer: raster layers and protected DMP layers

Lock: locks the active layer
Edit: edits the active layer
Point info:   can be set to a point feature layer which collects attributes for vertices during a
GPS measurement in a line or polygon feature layer

Tutorial: http://forum.digiterra.hu/viewtopic.php?f=48&t=235

Lock / Edit / Point info menu

http://forum.digiterra.hu/viewtopic.php?f=48&t=235


361Layer Properties

© 2015 DigiTerra Information Services Ltd.

The layer edit settings can be stored in DigiTerra Explorer Map file (.EXP) or
DigiTerra Map Pack file (.DMP) formats.

Selecting for removing or merging

 Tapping toggle  marks on all layers for removing or merging

 Marks the selected layer for removing or merging. Drag: collective mark

Layer buttons

 Sorts layers by layer type.

Default order:
Text file or data table without
geometry.
The layer contains points.
The layer contains lines.
The layer contains polygons
The layer contains points, lines,
polygons: DXF, DGN only
Raster image layer.

Layer buttons for the common layer types in the Layers panel
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Feature type for DGN and DXF layers

 Sorts layers by name.

Name area

The default is the displayed source name for new layers added to the map in the list. The
displayed name can be renamed on the Source panel.
Tap: designate active layer
Second (double) tap: opens the Classes panel
Drag: change the display order of the layers
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List handling on the name area

The layer order can be stored in DigiTerra Explorer Map file (.EXP) or DigiTerra
Map Pack file (.DMP) formats.

8.4 Source: Vector layer

The Source panel is used to configure some options that are specific to each layer in your map. You
can access the Source panel by tapping the Source button in the Layers panel. This panel contains
the same controls for vector layers, text and tabular files. The layer properties for raster layers can
be found in the next topic. 

Open the Source panel to the selected vector layer
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The Vector - Source panel

Name: The layer's name can be edited which will be displayed in the Layers panel. The default
name of the layer is equal with the Source name.

Source: Displays the data source of the layer. DigiTerra Explorer stores relative path to the
DigiTerra Explorer Map file (.EXP).

Link field: In Tree view the records of the related table connect to the parent table by the value of
this selected data field. The default is "<nothing>".

X position field: Select the data field which stores the X (horizontal) coordinates of the point. The
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default is "<nothing>"
Y position field: Select the data field which stores the Y (vertical) coordinates of the point. The
default is "<nothing>"

X position field and Y position field can be applied with a text file layer to create a
point feature layer

DigiTerra Explorer can display the selected X,Y positions from a text or tabular file
as a point layer on the map.

Transparency

The Transparency feature is used to specify the transparency settings for the vector layer. The layer
transparency can be specified for the vector and raster layers.

Use the slider to specify the amount of transparency for the entire layer. Transparency can range
from 0% (i.e. opaque, or no transparency) to 100% (i.e. completely transparent).
The default is 0%, i.e. opaque or no transparency.

Storing 3D coordinates: Enables to store 3D coordinates (X,Y,Z) in the edited layer when using
the supported vector layer formats. 3D geometry (X, Y, Z) can be a point and also a vertex in a
polyline or polygon feature. When using the GPS Survey panel DigiTerra Explorer stores the Z
coordinate as a measured value.

o On the Source dialog of the layer you can enable to store Z coordinates in the geometry to an

existing vector layer
o On the New layer panel (at layer creation) you can enable to store Z coordinates in the

geometry to the new vector layer
o Height (Z) coordinates of the geometry can be viewed on the Geometry panel

o Height (Z) coordinates of the geometry can be edited on the Existing Vertex panel

The Storing 3D coordinates option is enabled after adding supported vector
layers only when there is minimum one point, polyline or polygon feature geometry
with Height value in the geometry.

Vector information: Displays the number of fields, records, the geometry precision and the amount
of allocated memory

This layer is in SRS: Active only when the .dtproj file exists next to the layer. Please not that the
.dtproj file will be removed when you uncheck this option.
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 OK  - Saves the modification you have made on this panel and closes the panel.

 Undefined  - Opens the Select Projection dialog to set the known projection of the layer then
displays the selected projection on this button. When adding a new layer to the map view DigiTerra
Explorer assumes that its spatial reference system (SRS) is identical with the map view's SRS.
When you select the known SRS to the layer on this panel DigiTerra Explorer on-the-fly transforms it
into the map view's SRS and writes a .dtproj file next to the layer file. When the .dtproj file exists
next to the layer it is Identified and you can see its projection parameters on this button.

 Cancel  - Closes the Source panel

The source settings of the vector layers can be stored in the DigiTerra Explorer
Map file (.EXP) or DigiTerra Map Pack file (.DMP) formats.

8.5 Source: Raster layer

The Source panel is used to configure some options that are specific to each layer in your map. You
can access the Source panel by tapping the Source button in the Layers panel.

Open the Source panel to the selected raster layer

The Raster - Source panel to a raster layer 
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Name: The layer's name can be edited which will be displayed in the Layers panel. The default
name of the layer is equal with the Source name.

Source: Displays the data source of the layer. DigiTerra Explorer stores relative path to the
DigiTerra Explorer Map file (.EXP).

Georeferencing data: Can be edited by manually or with the raster orientation tool.

Horizontal: horizontal components of the georeferencing

1, 0, 786000
1: easting component of the pixel's x coordinate 
0: easting component of the pixel's y coordinate 
78600: easting offset (number of columns(x))

Vertical: vertical components of the georeferencing

0, -1, 156000
0: northing component of the pixel's x coordinate
-1: northing component of the pixel's y coordinate
156000: northing offset (number of rows(y))

Save World file: Saves the world file to the active raster layer based on the horizontal and vertical
parameters of the raster layer. (A world file is a plain text computer data file used by geographic
information systems to georeference raster map images.)

The generic meaning of world file parameters are:

Line 1: A: pixel size in the x-direction in map units/pixel
Line 2: D: rotation about y-axis
Line 3: B: rotation about x-axis
Line 4: E: pixel size in the y-direction in map units, almost always negative[3]
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Line 5: C: x-coordinate of the center of the upper left pixel
Line 6: F: y-coordinate of the center of the upper left pixel

You will find more information about the world file here: http://en.wikipedia.org/wiki/
World_file

Raster information: Displays the uncompressed image size (number of columns(x) and rows(y) of
pixels), the compressed file size, compression rate, cell size (x,y) in meter and the number of bands
with pixel depth/bit depth.

This layer is in SRS: Active only when the .dtproj file exists next to the layer. Please not that the
.dtproj file will be removed when you uncheck this option.

 OK  - Saves the modification you have made on this panel and closes the panel.

 Undefined  - Opens the Select Projection dialog to set the known projection of the layer then
displays the selected projection on this button. When adding a new layer to the map view DigiTerra
Explorer assumes that its spatial reference system (SRS) is identical with the map view's SRS.
When you select the known SRS to the layer on this panel DigiTerra Explorer on-the-fly transforms it
into the map view's SRS and writes a .dtproj file next to the layer file. When the .dtproj file exists
next to the layer it is Identified and you can see its projection parameters on this button.

 Cancel  - Closes the Source panel

The source settings of the raster layers can be stored in the DigiTerra Explorer
Map file (.EXP) or DigiTerra Map Pack file (.DMP) formats.

http://en.wikipedia.org/wiki/World_file
http://en.wikipedia.org/wiki/World_file
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8.6 Source: TIN layer

This panel for TIN layers is available only in the Desktop version.

Source panel for TIN layers

This layer is in SRS: Active only when the .dtproj file exists next to the layer. Please not that the
.dtproj file will be removed when you uncheck this option.

 OK  - Saves the modification you have made on this panel and closes the panel.

 Undefined  - Opens the Select Projection dialog to set the known projection of the layer then
displays the selected projection on this button. When adding a new layer to the map view DigiTerra
Explorer assumes that its spatial reference system (SRS) is identical with the map view's SRS.
When you select the known SRS to the layer on this panel DigiTerra Explorer on-the-fly transforms it
into the map view's SRS and writes a .dtproj file next to the layer file. When the .dtproj file exists
next to the layer it is Identified and you can see its projection parameters on this button.

 Cancel  - Closes the Source panel

An overview is available about 3D related features at http://forum.digiterra.hu/
viewtopic.php?f=59&t=310

 = new feature Basic Advanced Professional

Availability of this TIN "Source" panel in
different editions

http://forum.digiterra.hu/viewtopic.php?f=59&t=310
http://forum.digiterra.hu/viewtopic.php?f=59&t=310
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8.7 Raster Options
Raster options panel

Brightness - The Brightness feature is used to specify the brightness settings for the raster layer.
Use the slider to specify the amount of brightness for the entire layer. Brightness can range from -
100% to +100%. The default is 0%.

Contrast - The Contrast feature is used to specify the contrast settings for the raster layer. Use the
slider to specify the amount of contrast for the entire layer. Contrast can range from -100% to
+100%. The default is 0%.

Transparency - The Transparency feature is used to specify the transparency settings for the raster
layer. The layer transparency can be specified for the raster and vector layers. Use the slider to
specify the amount of transparency for the entire layer. Transparency can range from 0% (i.e.
opaque, or no transparency) to 100% (i.e. completely transparent).
The default is 0%, i.e. opaque or no transparency.

Colour transparency:

R - Red value of the RGB colour model (0-255)
G - Green value of the RGB colour model (0-255)
B - Blue value of the RGB colour model (0-255)

Transparent - Sets the transparency of the defined RGB colour in the entire raster layer

Examples:

White: 255, 255, 255
Black: 0, 0, 0
Red: 255, 0, 0
Blue: 0, 0, 255
Yellow: 255, 255, 0



371Layer Properties

© 2015 DigiTerra Information Services Ltd.

More examples can be found here: http://www.tayloredmktg.com/rgb

8.8 DEM Options

This panel for TIN layers is available only in the Desktop version.

Source panel for TIN layers

An overview is available about 3D related features at http://forum.digiterra.hu/
viewtopic.php?f=59&t=310

 = new feature Basic Advanced Professional

Availability of the "DEMO options" panel in
different editions

8.9 Scale

The Scale panel is used to specify the minimum and the maximum display scales of the layer.

The display scale for the layer's symbols and labels can be specified on the Labels panel. The
display scale and the label scale can be specified for the layer's thematic classes on the Class
panel.

Scale panel

http://www.tayloredmktg.com/rgb
http://forum.digiterra.hu/viewtopic.php?f=59&t=310
http://forum.digiterra.hu/viewtopic.php?f=59&t=310
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Select: Selects all layers, or clears the selection.
Auto: Sets the scale range of each layer on the basis of its data density.
Show always: Displays the selected layer at all scales.

When added a new layer to the DigiTerra Explorer map the default setting is show
layer at all scales.

List: Select layers. Drag: multiple selection. Value in brackets: average occupied area of one
geometry in square kilometers.

Minimum scale
Selected layer cannot be seen under this scale. 1:N Chooses the current map scale for layer's
minimum scale. The default is no limit.

Type the minimum scale at which the layer will be displayed or tap to 1:N choose the current map
scale. When it displays the "no limit" value, the layer is always displayed. In other cases, the layer
is not displayed when the map scale is larger than the scale specified in this field. For example, if
this field is set to 10000, the layer is displayed at a map scale of 1:10001 but not at a map scale of
1:9999.

Maximum scale
Selected layer cannot be seen over this scale. 1:N Chooses the current scale for layer's maximum
scale. The default is no limit.

Type the maximum scale at which the layer will be displayed or tap to 1:N choose the current map
scale. When it displays the "no limit" value, the layer is always displayed. In other cases, the layer
is not displayed when the map scale is smaller than the scale specified in this field. For example, if
this field is set to 10000, the layer is displayed at a map scale of 1:9999 but not at a map scale of
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1:10001.

Country: Set the minimum scale of the selected layer to 1:500 000.
County: Set the maximum scale of the selected layer to 1:1 000 000.
District: Set the maximum scale of the selected layer to 1:500 000.
City: Set the maximum scale of the selected layer to 1:100 000.

The layer's display scale settings can be stored in DigiTerra Explorer Map file
(.EXP) or DigiTerra Map Pack file (.DMP) formats.

8.10 Snapping

The  Identify option is used in the Layers panel to specify which layers will be used to snap to
when creating or editing features. Snapping is also used by tools such as Identify, Select, Measure,
GPS Guidance, Navigate to Target and most special tools in the Tools menu.

The snapping tolerance (pen tolerance) can also be set on the System tab of the Settings panel. The
default snapping tolerance value is 8 pixel on the map view.

The snapping algorithm will be snapped to edge and to vertex of the feature.

Snap to vertex

Snap to edge
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9 Labelling

The Labels panel is used to specify display settings for labels and symbols of a point, line, or
polygon vector layer. If any labeling or symbol scale is defined in the DigiTerra Explorer Map file
(.EXP) or in the DigiTerra Map Pack file (.DMP), it is displayed on this panel; otherwise, the default
settings are used.

The Labels panel

Reference scale of the layer's label text and symbols

Labels: Turns on/off the labels.
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When selected, text labels will be displayed. The default is selected. 

Labels maximum display scale:
Sets the maximum scale for labels. 1:N Chooses the current map scale for label's maximum
scale.

Symbols: Turns on/off the symbols.
When selected, symbols will be displayed. The default is selected. 

Symbols maximum display scale:
Sets the maximum scale for symbols. 1:N Chooses the current map scale for symbol's maximum
scale.

Type the reference scale for the layer’s label text and symbols or tap 1:N to choose the current map
scale. When blank, labels and symbols drawn at the specified symbol and font size. When not
blank, the label and symbol size is based on the reference scale of the layer.

The default is blank. 

The label scale can be also specified for the layer's thematic classes on the
Class panel.

1.label field: Select the first data field of the active layer's attribute table for labelling. The default
is the "Label" data field of the active layer's attribute table if the field exists.
2.label field: Select the second data field of the active layer's attribute table for labelling. The
default is "<nothing>".
3.label field: Select the third data field of the active layer's attribute table for labelling. The default
is "<nothing>".

Font: Choose the font to be used for labeling features.
Size: Type the font size numerically or select a data field which stores the font size (if the field
exists) of the labels to specify the font size of the label text. The default font size is 8.

Font size settings
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Fore: Choose the foreground colour of the label. The default foreground colour is black.
Back: Choose the frame and outline colour of the label. The default background colour is white.

Bold: Bold font style switch. The default is unchecked.
Italic: Italic font style switch. The default is unchecked.
Underline: Underline font style switch. The default is unchecked.
Automatic align: Hides the overlapping labels. The placement of the labels is use an overlapping
technique in order to a better labelling. The default is checked.

Switch off Automatic align if the labels are not displayed properly. 

Label placement for point, line and area feature

Outline: Outlines the font with the selected background colour. The default background colour is
opaque.
Frame: Draws a boundary box around the label with the background colour. The default background
colour is opaque.
Scaling: The font size is given in real (map) unit. When you specify a reference scale, the label text
and symbol size change as you zoom in or out.
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Vertices: Displays the vertex's ordinal number and lengths between vertices in [meter] for the
selected point line or area feature. The default is unchecked.

Ordinal numbers and lengths of a selected area feature

The layer's labelling can be stored in DigiTerra Explorer Map file (.EXP) or
DigiTerra Map Pack file (.DMP) formats.

9.1 Default label settings

The default label settings are the followings for a layer:

Default label settings of a layer on the Labels panel
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9.2 The default "Label" data field

The following data field name used as default label field: "Label".

Default attribute table of a newly created layer on the Record panel

9.3 Label color

Foreground colour picker

Choose a colour on the palette and fine-tune it using the RGB sliders or the  #  numeric colour
settings panel for the foreground colour of the label.

Foreground colour panel
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Foreground colour = #0000FF (RED)

Frame and background colour picker

Choose a colour on the palette and fine-tune it using the RGB sliders or the   #   numeric colour
settings panel for the frame and outline colour of the label.

Background colour panel
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Outline: Background colour=#FFFFFF (white)

Frame: Background colour=#FFFFFF (white)
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Numeric colour settings panel

10 Thematic classification

The thematic classification on the Classes panel is used to define line colour, fill colour, symbology,
linetype, filltype for vector layers or thematic classes of a vector layer. You can access the
Classes panel by double-tapping the layer name on the Layers panel or by tapping on the Layer
classification button after you selected a layer in the Layers panel.

Thematic classes on the Classes panel
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Thematic classes on the map view
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10.1 The Classes dialog box

The Classes panel contains the following controls:

The Classes panel

Field: Select a data field from the vector layer's attribute table to classify. After selection the
classes are created on the basis of the type of the field.

Method: Select the classification method.

No classification: Sorts every item to the "<other>" class.
Unique values: Creates classes by the unique values of the data field.
Modulo: Creates classes by the modulo operator.
Natural breaks: The classes contains same amount of items. The class borders pick up the
values of the field.
Equal quantities: The classes contains same amount of items.
Equal interval: Creates classes with the same interval between the minimum and
maximum values of the field.
Given interval: Creates given number of classes between the minimum and maximum
values of the field.
Normal distribution: Creates classes with the same interval between the mean-2*deviation
... mean+2*deviation of the field. The central class will contain the items with average values.

 Menu 
Palette: Opens the colour Palette panel to select a colour palette and apply it to the thematic
classes.

The Colour Palette panel

http://en.wikipedia.org/wiki/Modulo_operation
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Applied Orange palette on thematic classes

New class: Inserts a new class.
Delete class: Deletes the selected class.
Load: Opens the Load classes File panel to load classes and thematic settings from a CLS file.
Save: Opens the Save classes File panel to save classes and thematic settings into a CLS file.

 Set  - Sets the number of classes. Sets the interval in case of Given interval method.
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10.2 List handling on the Classes dialog box

The following list handling used on the Classes panel:

The list handling area is marked with red line on the Classes panel

Line colour

Tap on the row: Opens the Line colour colour palette to set the line colour.

The Line colour palette

Tap on the   header: Sets the line colour of all classes under the current (active) class to the
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line colour of the current (active) class.
Drag: Drag the current line colour and set this line colour to all marked classes.

Fill colour

Tap on the row: Opens the Fill colour colour palette to set fill colour.

The Fill colour palette

Tap on the  header: Sets the fill colour of all classes under the current (active) class to the fill
colour of the current (active) class.
Drag: Drag the current fill colour and set this fill colour to all marked classes.

Symbol

Tap on the row: Opens the Symbol panel to select symbol. There is no drawing in case of null
symbol (Bitmap 0) selection.

The Symbol panel
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Tap on the  header: Sets the symbol of all classes under the current class to the symbol of
the current class.
Drag: Drag the current symbol and set this symbol to all marked classes.

Linetype

Tap on the row: Select linetype. There is no drawing in case of null linetype (Bitmap 0) selection.

The Linetype panel

Tap on the  header: Set the linetype of all classes under the current class to the linetype of
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the current class.
Drag: Drag the current linetype and set this linetype to all marked classes.

Filltype

Tap on the row: Select filltype. There is no filling in case of null filltype (Bitmap 0) selection.

The Filltype panel

Tap on the  header: Set the fillpattern of all classes under the current class to the fillpattern
of the current class.
Drag: Drag the current fillpattern and set this pattern to all marked classes.

Texture

Tap on the row: Opens the Texture selection context menu to select texture. There is no filling in
case of "None" selection.

The Texture selection context menu
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Selected "Forest" texture to one thematic class and the thematic class on the map view

   

Tap on the  header: Sets the texture of all classes under the current class to the texture of
the current class.
Drag: Drag the current texture and set this texture to all marked classes.

The raster textures cannot be used when the vector smoothing is turned on



390 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

Value

Tap on the row: Opens the Class panel to set the value range, label, Display scale and the label
scale of the selected class.

Settings of the thematic class

Class panel

Value: Cell value of the selected data field to the thematic classification.
Label: Shows the textual value of the code dictionary (if exists) and the number of features in this
class as default. Displays in the legend of the printed map.
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Display scale: Enables you to define a display scale to the current thematic class. Default is "1:0",
displays the thematic class at all scales.
Label scale: Enables you to define a label scale to the current thematic class. Default is "1:0",
displays the labels of the thematic class at all scales.

11 Attribute Properties

In this topic you can find reference type information about attribute data related information as:

o tables,

o fields,

o records,

o values,

o data types,

o rules,

o code dictionaries,

o attribute handling related functions

their paneles and controls.

Fundamentals of database definitions

There are five main elements to any table in a database, and each of these have (somewhat
inevitably) a number of names:

1. Table (also known as Attribute Table, Data Table)
2. Field (also variously known as Column)
3. Record (also known as Row)
4. Value (also known as Attribute)
5. Field name (also known as the Attribute name)

Table
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11.1 The Record dialog box

The Record panel contains the following controls:

Record panel (Mobile and Desktop)

 1  - Header: "Record 1/176" means that you are viewing the 1st record of the total 176 records.
"(geom)" means that the current attribute table 176 features with vector geometry

 2  - Lists all attribute tables of the vector feature layers you are using in the map project

 3  -  Menu  button: opens the menu

 4  - Horizontal scroll bar:

o Drag the scroll box to move forward or backward in the attribute table

o Click the scroll arrows to move forward or backward in the attribute table

 5  - Buttons:

o  - displays the linked feature of the selected record on the map

o  - activates the Target tool and sets the Target position to the selected feature of the

record

o  - activates the GNSS resurveying function

 6  - Field names: Lists all data field from the attribute table in the left column. Tap on the data
field name to open and edit the field definitions on the Data field panel

 7  - Attribute values: Lists all values to the current record in the right column. Tap on the value
to edit as:
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o Opening the Attribute editor to edit data

o Read only attribute

o Opening the Enum panel to use a code from the code dictionary

 8  - [+] Opens the New data field panel to create a new data field

 ok  /  x  -  Approves and saves all changes you made then closes the panel and proceeds to save
the code dictionary if you defined codes to a data field the very first time

11.1.1 Menu

This menu is accessible from the Record panel when tapping/click on the  [Menu]  button in the
top right corner:

Opens the New data field panel to add a new data field to the current attribute table.
Equivalent with the [+] button on the Record panel at the bottom

Adds a new record to the current attribute table. It can be used only when working
with a data table without geometry in DBF, TAB, TXT file formats

Deletes the current record with its geometry

Deletes all or only the filtered records. This change cannot be undone!

Opens the Filter panel to filter attribute records

Opens the Sort panel to sort attribute records

Switches the Record panel to List view. The default view is List view.

Switches the Record panel to Tree view. It is useful when working with linked attribute
tables.

Opens the Geometry panel to display properties of the current attribute record's feature

Displays the linked feature of the selected record on the map

Activates the Target tool and sets the Target position to the selected feature of the
record, equivalent with the Target button on the Record panel

Activates the GNSS resurveying function, equivalent with the GNSS resurveying
button on the Record panel

Copies all content of the current table or only the filtered records to the clipboard

Opens the Datatable export file panel to export the content of the attribute table into
different file formats: ANL, GRN, TXT, CSV

Opens the Field statistics panel

Opens the Print Report panel to print the content of the current table or the filtered
records. Available in the Desktop version only.

Opens the Print Point Report panel to print an area report with a map attachment to the
active record. Available in the Desktop version only.

Opens the Print Area Report panel to print an area report with a map attachment to the
active record. Available in the Desktop version only.
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Please note that the Point report and Area report options in the menu are
printing related functions. The "Point report" disabled when the current data table
is a polygon or line feature layer's attribute table. The "Area report"  will be
disabled when the current data table is a point or line feature layer's attribute table.

11.1.1.1 Filter dialog box

The Filter panel is accessible through the Record panel by going into the Menu and selecting
Filter option. This panel is designed to quickly formulate an expression to filter the attributes and to
control the display of the linked features in a layer. Furthermore the filtered records and their features

can be exported into an other layer on the Layers panel with the  Layer export button.

Filter panel

[ Clear Filter Conditions ] - Erases the current Filter Conditions. Once you have tapped/clicked on
this button all records will display in the Record panel and also all linked features will be displayed in
the current layer.

1-3 Data field drop-down lists: Lists all data fields from the current attribute table to select and
create a filter definition. Altogether three expression can be combined to define a filter.

Relation: Lists the available operators to select a relation operator between the data field and the
value:

o "=" Equal

o "<>" Not Equal

o "<" Less

o "<=" Less or equal
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o ">" Greater

o ">=" Greater or equal

o "[+]" Field contains the given string

o "[-]" Field does NOT contain the given string

Value drop-down lists: Lists unique values in the selected data field to select an existing value from
the list or enter the filter value.

Logical operators: And, Or

[ OK ] - Applies the filter definition on the selected attribute table

[ Cancel ] - Ignores changes and closes the panel

11.1.1.2 Sort dialog box

The Sort panel is accessible through the Record panel by going into the Menu and selecting Sort
option. This panel is designed to sort the attribute values in the selected data fields. The Sort panel
contains the following controls:

Sort panel

[ Clear Sorting Conditions ]  - Erases the current Sorting Conditions. You can see the sorted
records in the Record panel

1-3 Data field drop-down lists: Lists all data fields from the current attribute table to select and sort
attribute values in the selected data field. Altogether three data fields can be combined to sort.

Descending order: Controls the switch between ascending and descending order. Tick the check-
box to use descending order. The default order is ascending when the check-box is unchecked.

[ OK ] - Applies the sorting definition in the attribute table
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[ Cancel ] - Ignores changes and closes the panel

11.1.1.3 Geometry dialog box

The Geometry panel is accessible through the Record panel by going into the Menu and selecting
Geometry option and also with the Query menu > Measure tools. This panel is designed to display
geometric data of the attribute record's feature and also to display geometric data for the on-screen
measuring tools. The Geometry panel contains the following controls:

Geometry panel

o Angle: Azimuth of the start point and the endpoint defined section in the feature, measurement
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o Length: Length of the geometry in current length unit. The second value means the length

between two last vertices in the current length unit
o Perimeter: Perimeter of the geometry in current length unit

o Area: Area of the geometry in current area unit

o Vertex: ID of the vertex

o Easting: Easting coordinate of the vertex

o Northing: Northing coordinate of the vertex

o Height: Height of the vertex

Using clipboard on the Geometry panel in the Desktop version
Select the vertices in the list then use [Ctrl]+[C] to copy and then [Ctrl]+[V] to paste the selected
values into e.g. a text editor

Selected vertices
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Pasted vertices in Notepad

11.1.1.4 GNSS Resurveying

The GNSS Resurveying designed for:

A.) Updating the geometry of an existing point, line or polygon feature to the selected attribute
record with the GNSS menu > Survey panel using GPS

B.) Surveying geometry to a separate data table or TXT file with the GNSS menu > Survey panel
by creating a vector feature layer using GPS

o separate TXT file  - > the result will be a MAP - DigiTerra layer with a TAB - DigiTerra file

o separate DBF file -> the result will be a SHP - ESRI Shape layer with an SHX file, null-

geometries are allowed
o separate TAB file - > the result will be a MAP - DigiTerra layer to the existing TAB file, null-

geometries are allowed

Using the GNSS Resurveying function
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1. Let's say we have an data table (a TEXT file, a DBF or a TAB file) with important descriptive data
but without any geographical information. If we know where they are on the field and additionally
would like to link geometries to the records, GNSS Resurveying is the tool in our hand to do this
painlessly.

2. Add this TEXT file to the Layers panel with the  Add Layer command
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3. Open the Record panel to start the data capture. "Record 1/10" means the you have 10 records
without geometry and you are at the first record, which is the current record. Use the scroll bar to

find the proper record you want to start with then tap / click on the  GNSS Resurveying
button.

4. The GNSS Survey panel appears. Select feature type from the Type drop-down list, then you can
start collecting GPS data with the RED button.
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5. Once the geometry of the feature have been measured the GNSS Survey panel closes and the
Record panel appears again with the same record where the GNSS Resurveying started.

6. Select the next record to link geometry or update the existing geometry of the selected feature.
Then tap / click on the GNSS Resurveying button to continue.
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11.1.1.5 Copied datatable

Copied and pasted data table looks like this in a text editor:

11.1.1.6 Datatable export

The Datatable export file panel is accessible through the Record panel by going into the Menu and
selecting Export option to export all or only the filtered content of the data table into the selected file
format. Default file format is CSV.

Datatable export

In case of selecting CSV export format the CSV export panel appears to select the separation
character that will be stored in the exported CSV. Default character is coma (,).

CSV export
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11.1.1.7 Field statistics dialog box

Shows a table of the basic statistical values of the field in All (without classes) or by Thematic
Classes when using thematic classification.

Field statistics

  

Name: Shows the name of the data field in the current attribute table

 - Shows the previous data field

 - Shows the next data field

Statistical list: Shows a table of the basic statistical values: Class, Num, Sum, Mean, Dev, Min,
Max

[ OK ] - Closes the panel

[ Cancel ] - Closes the panel
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11.1.2 The Data field dialog box

The Data field panel contains the following controls:

The Data field panel

 - Shows the previous data field

 - Shows the next data field

 - Moves the data field upwards in the Record panel

 - Deletes the current data field

 - Refreshes the data field values when using a geometry type data field default value

 - Moves the data field downwards in the Record panel

Name: Shows the editable name of the data field.
Alias: Shows the editable alias name of the data field. Default alias name is equal with the data field
name. The alias data field name will be displayed on the Form view.

The data field alias name can be stored in DigiTerra TAB file format and can be
stored in DigiTerra Explorer Map (.EXP) file in case of using other file formats.

Default: Shows the data field default value that will be used in case of record creation or creating/
changing geometry

Null: Field value will be zero/empty
Copy last value: Field value will be the copy of the previous record value
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Copy nearest: Field value will be the copy of the nearest feature's record value
Increment last value: Field value will be the increased value of the previous record

Creation time: Field value will be equal to the creation time (the stored value depends on the
operation system's time settings)
GPS time: Field value will be the GPS Universal time

Area of Geometry (m2): Field value will be the area of the geometry in square meter on
geometry creation/modification
Area of Geometry (ha): Field value will be the area of the geometry in hectare on geometry
creation/modification
Area of Geometry (ac): Field value will be the area of the geometry in acre on geometry
creation/modification
Area (custom): Field value will be the area of the geometry in current area unit on geometry
creation/modification

Perimeter of Geometry (m): Field value will be the perimeter of the geometry in meter on
geometry creation/modification
Perimeter of Geometry (km): Field value will be the perimeter of the geometry in kilometer
on geometry creation/modification
Perimeter (custom): Field value will be the perimeter of the geometry in current length unit on
geometry creation/modification

Length of Geometry (m): Field value will be the length of the geometry in meter on geometry
creation/modification
Length of Geometry (km): Field value will be the length of the geometry in kilometer on
geometry creation/modification
Length (custom): Field value will be the length of the geometry in current length unit on
geometry creation/modification

Distance to last object (custom): Field value will be
- the distance between two point features
- the distance between two line features (distance calculated between the center positions of
the middle sections in the line feature)
- the distance of the center's positions between two polygon features in current length unit
on geometry creation/modification

Azimuth Angle: Field value will be the angle of the geometry on geometry creation/modification
GPS heading: Field value will be the angle of the current GPS direction

Speed (m/s): Field value will be the current calculated GPS speed in m/s
Speed (custom): Field value will be the current calculated GPS speed in current speed unit

Easting coordinate: Field value will be the X coordinate of the geometry on geometry
creation/modification
Northing coordinate: Field value will be the Y coordinate of the geometry on geometry
creation/modification
Latitude: Field value will be the Latitude coordinate of the geometry on geometry creation/
modification
Longitude: Field value will be the Longitude coordinate of the geometry on geometry
creation/modification
Altitude: Field value will be the height of the geometry = Mean Sea Level (MSL) if a geoid
separation value is specified
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Height above ellipsoid: (HAE) Field value will be the height above the ellipsoid

Satellites in use: Field value will be the number of used satellites
Satellites in view: Field value will be the number of viewable satellites
PDOP value: Field value will be the PDOP value
Horizontal error: Field value will be the horizontal RMS error (horizontal positioning error)
Vertical error: Field value will be the vertical RMS error (horizontal positioning error)
DGPS fix rate: Field value will be the ratio of the DGPS fix positions (in percent) proportion to
uncorrected positions
PPS fix rate: Field value will be the ratio of the PPS fix positions (in percent) proportion to
uncorrected positions
FloatRTK rate: Field value will be the ratio of the FloatRTK positions (in percent) proportion to
uncorrected positions
FixRTK rate: Field value will be the ratio of the FixRTK positions (in percent) proportion to
uncorrected positions
Differential Correction Age: Field value will be the differential correction age
Correction type: Field value will be the ratio of differentially corrected positions (in percent)
proportion to corrected positions (e.g. 70% Autonomous, 30% DGPS)
Measure reliability: Reliability value calculated by the PDOP values
Measure limit: Reliability limit calculated by the measured area

Measure identifier: Field value will be a unique identifier of the primary measured feature during
the GPS data capture. Required when you collect attributes for vertices in a   point info layer
Unique identifier (GUID): Field value will be a GUID unique identifier of the primary measured
feature during the GPS data capture. Required to use it in multi-user environment instead of the
Measure identifier default field value. Required when you collect attributes for vertices in a   point
info layer

Username: Field value will be the logged in user to the LOGIN module. (The LOGIN module is an
optional module to DigiTerra Explorer, can be purchased additionally.)

The following default values are display only on Ashtech MobileMapper 6:

MM6 Temperature: Field value will be the value of the Magellan MobileMapper 6
Temperature sensor
MM6 Air pressure: Field value will be the value of the Magellan MobileMapper 6 Air
pressure sensor
MM6 G-sensor-X: Field value will be the value of the Magellan MobileMapper 6 G-sensor X
coordinate
MM6 G-sensor-Y:  Field value will be the value of the Magellan MobileMapper 6 G-sensor Y
coordinate
MM6 G-sensor-Z: Field value will be the value of the Magellan MobileMapper 6 G-sensor Z
coordinate
MM6 E-compass-X: Field value will be the value of the Magellan MobileMapper 6 E-compass
X coordinate
MM6 E-compass-Y: Field value will be the value of the Magellan MobileMapper 6 E-compass
Y coordinate
MM6 E-compass-Z: Field value will be the value of the Magellan MobileMapper 6 E-compass
Z coordinate
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The data field default value can be stored in DigiTerra TAB file format and can be
stored in the DigiTerra Explorer Map (.EXP) file in case of using other file formats.

Type: Shows the data type of the field.

Logical: 1 byte length logical (true/false) value
Byte: 1 byte length integer value. Value range: 0..255
Short integer: 2 byte length integer value. Value range: -32768..32767
Long integer: 2 byte length integer value. Value range: -2147483648..2147483647
Float: 4 byte length real value provides up to 7 decimal digits
Double: 8 byte length real value provides up to 15 decimal digits
Date: 4 byte length date with minute precision
Time: 8 byte length date with 1/10000 second precision
Text: Character field without size limit

The maximum character size to Text field type is 254 character in DBF file format
(to ESRI Shape files).

Document: This type stores a path or URL of an object (image, sound, document) by using the
Document panel

Width: Shows the number of the characters to the field name in case of fixed record size formats
(DBF, TAB)

The maximum field name width is 11 character in DBF file format (to ESRI Shape
files)

Decimal places: Number of decimals to display real values

Rule: Verification procedure after each modification of the field value

None: No verification
Read only: The cell value cannot be modified. Recommended for calculated fields
Not null: The cell value cannot be null
Unique value: The cell value cannot be repeated, must be unique in the table
Range: The cell value must be in a given range (between minimum and maximum)
Valid value: The cell value must be an existing value of the data field

Code filter: Filters the selectable codes from the code dictionary based on the geometry or data
filed names
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A detailed tutorial available about using code filters at http://forum.digiterra.hu/
viewtopic.php?f=59&t=313

The data field alias name can be stored in DigiTerra TAB file format and can be
stored in DigiTerra Explorer Map (.EXP) file in case of using other file formats.

List: Shows the defined code set of the code dictionary to the current data field

11.1.3 New data field

11.1.4 Attribute editor

Data values: Tap on to displayed cell value to modify the value or select a new value form the
Code dictionary.

http://forum.digiterra.hu/viewtopic.php?f=59&t=313
http://forum.digiterra.hu/viewtopic.php?f=59&t=313
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11.1.5 Enum dialog box

11.2 Default attribute table

The default attribute table for newly created layers consists of the following data fields:

Default attribute table of a created new layer on the Record panel

Field definitions:

ID - Increment last value, Long interger (4)
Label - Null, Text (N)
Date - Creation time, Date (4)
Length - Length (custom), Float (4)
Area - Area (custom), Float (4)



411Attribute Properties

© 2015 DigiTerra Information Services Ltd.

You can use predefined attribute table templates instead of the default attribute
table when you create a new layer.

11.3 Attribute table template

Attribute table templates are predefined data table structures which can be selected when you
create a new layer to provide data field settings/structure in the new layer's attribute table. Their
undoubted advantage is to speed up the data capture process when you create a new layer on the
field to start the data collection as soon as possible. The file format of the attribute table template is 
DigiTerra TAB, the sample templates are located in the \Templates directory.

There are two ways to create attribute table templates:

1. On the New layer panel by using the New template button,
2. and with the New Layer tool in the File menu (or on the Layers panel) by creating a DigiTerra TAB

file into the \Templates directory and customizing the data fields on the Record panel and on the
Data field panel.

Creating a template on the New layer panel

  

Adding data fields to the new attribute table template
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On the Layers Manager by creating a TAB - DigiTerra file into the Template Path. 

11.4 Code dictionary

A code dictionary is a description of the attributes and thematic classes to a particular mapping
project. It is used in the field to control the collection of attributes. It is also used when you create a
thematic classification based on a particular data field and the usable line colour, fill colour, symbol
type, linetype, filltype can be controlled by the definitions of the code dictionary to the created
thematic classes. A code dictionary includes a list of attributes that describe the feature and the
thematic class. The code sets in the code dictionary not contain the actual information collected in
the field (positions and actual attribute values occurrence of a feature).



413Attribute Properties

© 2015 DigiTerra Information Services Ltd.

It is important to understand code dictionary and how it is used in the field to control mainly the
attribute collection. A code dictionary prompts you to enter information on the data capture form as a
pick-list. It can also limit what you enter to ensure data integrity and compatibility with your GIS
system. Although a code dictionary is not always required for field work, having one does make both
data collection and processing (thematic mapping) faster and easier.

The code dictionaries you create depend on your intended applications. Since different users have
differing collection requirements, each user or group of users can design code dictionaries to suit
their needs. You may have a code dictionary that specifies information about agricultural farm
classes and productivity, while another user may have a code dictionary that details information
about utility lines and services. Different users can obtain more useful information about their
respective features with their own customized code dictionary.

The code dictionary is primarily text file (.CDT) next to the DigiTerra Explorer Map file (.EXP) that
contains code sets and their elements for relevant data fields of the attribute table. Values of a code
set can be displayed in a drop-down list on the data capture form if the relevant data field
name in the current attribute table is equal with the name of the code set.

Using the code dictionary's code sets on the data capture form of the current record
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General steps for defining a code dictionary are:

1. Tap on New project on the Startup options panel

2.  Add or  create a new vector layer to the map view

The Layers panel w ith the Add and the Create layer buttons

3. Open the Record panel

The Record panel w ith a marked data field
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4. Open the Data field panel or add a new data field to the data table in the  Menu  , and then tap on
the [+] button in the code list to open the Code editing panel

The Data field panel w ithout code set

Code sets can be defined only to the following data field types:

Byte: 1 byte length integer value. Value range: 0..255.
Short integer: 2 byte length integer value. Value range: -32768..32767.
Long integer: 2 byte length integer value. Value range: -2147483648..2147483647.
Text: Character field without size limit.
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5. Add the codes to the code set you wish to use by entering their Code and Name, then tap on the
Insert button (Description, Default colour, Default symbol are optionally)

The Code editing panel

6. Close the Code editing panel by using the Close button on the panel. The defined codes now are
displayed in the code list.

Defined code set in the code list

7. Close the Data field panel by tapping on the OK button
8. Then close the Record panel. The Saving Code dictionary file panel appears.
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The Saving Code dictionary file panel

9.  Select a dictionary where you wish to store your project with its code dictionary and layers, and
then enter the name of the code dictionary (the default name is General.cdt) and Save it.

10. Now the code dictionary file is enabled on the Settings panel > Record tab > Code dictionary

The enabled code dictionary file on the Record tab

11. Before you exit DigiTerra Explorer Save the Map, now the DigiTerra Explorer Map (.EXP) file
contains the path of the code dictionary and load it automatically when you open the project.

Code dictionary in the DigiTerra Explorer Map (.EXP) file
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Editing the Code Dictionary (.CDT) file in a text editor

By using code dictionary during the attribute capture process you can customize the selectable
values of a data field. When you edit a .CDT file in a simple text editor (e.g. in Notepad) pay
attention to the following:

Enter the name of the data fields after the ’#’ or ’$’ signs in the row. The fields' name should not
contain space, dot and comma characters. DigiTerra Explorer will not display the codes next to '#' or
'$' signs in Form view mode. The codes can be displayed in List view or Tree view modes only.  The
same code set can be used for several fields if you separate fields' name by comma.

The ’#’ sign defines a numerical, the „$’ sign a textual code set. The codes will be followed by the
possible values (description) and then the connected colour, items are separated by tabs. Colours
must be entered by using 0x followed by colour code. The specification will be closed by an empty
row, or a row that does not start with numerical value. Until the next ’#’ or ’$’ signs optional
comments can be placed.

Numerical code set:

# SoilSurface
1 < 20 cm 0xc0ffc0
2 20 - 40 cm 0x9bff9b
3 40 - 70 cm 0x67ca67
4 70 - 100cm 0x349534
5 > 100 cm 0x006000
9 Water or N/A 0x8080FF

The data type of a field that uses a numerical code set can be numerical or textual. In case of using
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the Text(N) textual field type to a numerical code set, the data field will store the textual
content of the code set. In case of using any numerical field type the data field will store the
numeric code only.

Numeric field types for code sets:
Byte: 1 byte length integer value. Value range: 0..255.
Short integer: 2 byte length integer value. Value range: -32768..32767.
Long integer: 2 byte length integer value. Value range: -2147483648..2147483647.
Float: 4 byte length real value provides up to 7 decimal digits.
Double: 8 byte length real value provides up to 15 decimal digits.

Numeric code sets can be stored as textual and even as numerical data. In
that special case when a code set starts with "0" -zero and the data field type is
numeric, the form will be filled as default with the related value of the "0" code.

Example code set:

# SoilSurface
0 < 20 cm 0xc0ffc0
1 20 - 40 cm 0x9bff9b
2 40 - 70 cm 0x67ca67

The "SoilSurface" field code set on the form view of the current record

Textual code set:

$ TreeSpecies
POT Populus tremula 0x80ffff
ACP Acer pseudoplatanus 0x90c060
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PIM Pinus mugo 0xff80c0
ULG Ulmus glabra 0xffc0e0
SAS Salix spec. 0x70a0d0

The data type of the field that use the textual code set must be textual, numeric field types cannot
be used for textual code sets!

The "TreeSpecies" field code set on the form view of the current record

General steps for editing an item of a code set in List view/Tree view modes are

1. Open the Record panel and tap on the value you wish to edit
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2. Tap and hold the stylus on the code you want to edit, the Code editing panel appears

In case you tapped under the code list in the code set dialog, the Code editing
panel will appear without codes.

3. Edit the selected code in the Code editing panel

Context menu of the code set editor
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Add new code: Opens the Add code, name panel to type the space separated code and name.
Edit code: Opens the Edit name panel to edit the name of the selected code.
Delete code: Deletes the selected code.

The path of the current code dictionary can be stored (and reloaded) in DigiTerra
Explorer Map file (.EXP) format. Suggested to store the code dictionary in the
same directory with the project file and the layers.

11.5 Related tables

DigiTerra Explorer supports to create mapping projects with related attribute tables. The use of
related tables is necessary for example to collect different data from several tree species in one
forest compartment, collect different data from several geological rock samples in one place etc. To
do this you need a primary (parent) table and one (or more) related (child) table with one key data
field in each attribute table to link the child table to the parent table.

Parent table definitions:

Parent table w ith three key data fields

In the parent table an integer data field type and Increment last value data field
default value must be used to the key field. The Read only rule is suggested to
use to any key field.

Field definitions of the key fields in the parent table
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Child table definitions:

Child tables w ith the same key fields.
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In the child tables the same data field name and field type must be used as in
the parent table. The only difference is the default value: Copy last value. The
Read only rule is suggested to use to any key field in the child tables as well.

Field definitions of the key fields in the child tables.
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You must select the key field as a link field in each child table on the Source panel to build the
relations between the parent table and its child tables.

Selected link fields of the child tables on the Source panel.
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Before you start the data collection with the related tables set the Tree view for
the displayed new record in the Settings panel > Record tab and save your
mapping project as a DigiTerra  Explorer Map (.EXP) file.

Selected Tree view option on the Record tab for data collection in related tables.
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Tree view mode during the data capture

The Record panel appears in Tree view after the geometry creation.

   

Tap on the name of the child table that marked with (Add) to add new the records in the child table.
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New added record in the child table.

11.6 Document dialog box

Document panel is used to capture a picture with the builtin camera of the Mobile device and store
the path of the picture in a document field type data field. Document panel is also used when you
want to add an OLE object (file) to a datafield by manually, open or clear the linked document.

The Document panel contains the following controls:

Document panel
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Document file: Shows the name of the linked file.

 Open document  - Opens the linked document in the associated viewer/application.

 Select document  - Opens the Document File panel to select an OLE object.

 Start Digital Camera  - Starts the builtin camera and opens the associated Image Capture
application to take a picture. The created picture will be saved beside the layer file.

Image Capture dialog on Magellan MobileMapper 6

 Clear document  - Clears the path of the previously linked document.
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 Close  - Closes the dialog.

12 Projections and Datums

This section discusses how DigiTerra Explorer handles projections. DigiTerra Explorer contains cc.
3130 projections and 12 projection types for field mapping, that can be customized easily in the
Custom Projection panel or in the editable Grid.txt file, that can be found in the following directories:

Projection parameters file: Grid.txt

Path:

Desktop version: $INSTDIR\Grid.txt

Mobile version: $SDCARD\BIN\Grid.txt

The projection setting is one of the most important parameter of the DigiTerra Explorer mapping
project, that you have to set up for every new map on the New map panel by tapping on the
displayed name of the projection button.

Projection button: Shows the current projection. Tap on this button to open the Select projection
panel to select an other projection.

 OK  - Creates the new empty mapping project.

More details about the New map dialog can be found in the Projects sub-menu topic

The selected projection can be changed on the Settings panel > GPS tab >
Projection to empty mapping projects. The projection setting can be changed in
existing mapping projects because DigiTerra Explorer can reproject into another
projection. Please use the Reprojection tool for this purpose.

12.1 The Select Projection dialog box

The Select projection panel contains the following controls:

The Select projection dialog displays the selectable projections in a tree view menu. Region >
Country > Grid > Projection.

The Select projection panel: Region > Country > Grid > Projection
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Projections tab:

 New  - Opens the New projection panel to create a new projection

 Modify  - Opens the Custom projection panel to customize the selected projection

 Delete  - Deletes the selected projection

 Calculate  - Opens the Calculate panel to calculate differences between two projections to one
reference point in WGS84

 OK  - Closes the panel

EPSG tab:

Search box: Enter the EPSG code you want you use as the projection of the map view

 Search  - Searches the EPSG code and lists the results in the list below

Result list: Lists the results. You can select an EPSG code here and use it as the projection of the
map view.

 Modify  - Opens the Custom projection panel to customize the selected projection

 OK  - Closes the panel

Please, note that these projections below cannot be modified or deleted:
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Romania
- RS70 DT -> Poly2
- TransDatRo-1930 -> ETRS89
- TransDatRo-1970 -> ETRS89

Hungary
- Egyseges Orszagos Vetulet DT -> Poly1

United Kingdom
- British National Grid DT ->Poly3
- OSTN02+OSGM02 -> ETRS89
- Northern Irish Grid DT -> Poly5

Ireland
- Irish National Grid DT -> Poly4

12.2 New projection dialog box

This panel enables you to define a new projection. After you have entered the basic information to
the new projection, DigiTerra Explorer opens the Custom Projection panel to define the detailed
parameters of the projection.

New Projection panel
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12.3 The Custom Projection dialog box

The Custom projection panel consists of the following controls to customize the selected projection:

Datum tab

Add favorites: adds the selected projection to the Favorites

Datum tab:

Type of: Select a projection type (algorithm).

Geographic
Stereographic projection
Mercator
Transverse Mercator
Oblique Mercator
Hotine Oblique Mercator
Lambert conformal conic
Hungarian stereographic
Hungarian cylindrical
Hungarian Unified projection
Swiss cylindrical
Romania TransDat 2009

Projection tab:

Projection tab
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Datum parameters

Spheroid (a, 1/f): Semi-major Axis, Inverse Flattening ratio.

Offset (dx, dy, dz): Offset DX, DY, DZ to WGS84 parameters in meter.
Rotate (rx, ry, rz): Rotate RX, RY, RZ to WGS84  parameters in arc seconds.
Scale (s): Scale Factor in ppm.

Projection parameters

Ref. longitude (la0): Origin Longitude in degree.
Ref. latitude (fi0): Origin Latitude in degree.
1st latitude (fi1): First Latitude in degree.
2nd latitude (fi2): Second latitude in degree.
Scale (m): Scale Factor.
Unit scale: Unit scale value (indicates the unit value in meter).
Origin (fe, fn): False easting, False nothing.

The modified Datum and Projection parameters are stored in in DigiTerra
Explorer Map (.EXP) / DigiTerra Map Pack (.DMP) files and in the user.db3 file

On the Source Datum tab you can define the GPS Datum when using Real Time Corrections with
different Source Datum (not WGS 84)

Source Datum tab
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12.4 The Calculate dialog box

The Calculate panel calculates differences between two projections based on one reference point
with WGS84 coordinates. This panel can be accessed on the Select Projection panel.

The Calculate panel

The Calculate panel contains the following controls:

 GPS  - Takes over the current GPS coordinates to the reference position.

Latitude: Enter the Latitude coordinate of the reference point in WGS84.
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Longitude: Enter the Longitude coordinate of the reference point in WGS84.
Height above ellipsoid: Height above the ellipsoid.

 Calculate: projected  - Calculates the projected coordinates by using geographical coordinates

Projection: Shows the current projection.

Easting coordinate: Indicates the easting coordinate of the WGS84 reference point in the current
projection.
Northing coordinate: Indicates the northing coordinate of the WGS84 reference point  in the
current projection.
Height coordinate: Indicates the height of the WGS84 reference point in the current projection.

 Calculate: geographic  - Calculates the geographical coordinates by using projected coordinates

dx: Indicates the horizontal difference between the current and the previously selected projection to
the same reference point (with WGS84 coordinates).
dy: Indicates the vertical difference between the current and the previously selected projection to the
same reference point (with WGS84 coordinates).

 OK  - Closes the Calculates panel to select an other projection on the Select projection panel.

 The default geoid undulation file can be used in the calculations on the calculate
dialog if it is exists in the \BIN directory in the Mobile version (SD Card) or in the
installation directory in the Desktop version.

13 Supported data formats

DigiTerra Explorer supports the following file formats

Map and mapping project formats
Vector layer formats
Raster layer formats
Text and tabular formats

13.1 Project file formats

 = new feature Basic Advanced Professional

Supported map and mapping project formats

DigiTerra Explorer Map (.EXP)

DigiTerra Map Pack (.DMP)

OpenGIS KML Map file (.KML)

OpenGIS KMZ Map file (.KMZ)

OpenGIS GML Map file (.GML)

ArcPad Map file (.APM) with ArcPad Layer Definition
file(.APL)
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Hungarian Digital Base Map (.DAT)

SQLite 3 Geodatabase file (.DB3)

 New Map - Supported map and mapping project formats
EXP, DMP, KML, KMZ, GML

 Open Map - Supported map and mapping project formats
EXP, DMP, KML, KMZ, GML, APM, DAT

DigiTerra Explorer Map or DigiTerra Explorer Project file (.EXP)
Default, textual file format of the DigiTerra Explorer mapping project. For detailed information send an
e-mail to support@digiterra.hu

Embedded .DMP(s) in .EXP project file:
DigiTerra Map Pack (.DMP) file can be saved as DigiTerra Explorer Map (.EXP) file with additional
new raster and vector layers. This feature could be a good solution if you have a .DMP as
background map that you don't want to modify or it is protected, but want to use new raster and/or
vector layers on the map view of the opened .DMP.

To create this embedded .DMP project open a .DMP file and add some existing raster and/or vector
layers (or create some new vector layers) to the map view and finally save the entire project into an
.EXP file.

OpenGIS KML Map file or Keyhole Markup Language file (.KML):
KML is an XML grammar and file format for modeling and storing geographic features such as points,
lines, images, polygons, and models for display in Google Earth, Google Maps and other
applications. You can use KML to share places and information with other users of these
applications. You can find example KML files on the KML Gallery and Google Earth Community site
that describe interesting features and places. For detailed information please see the source of this
definition: https://developers.google.com/kml/documentation

OpenGIS KMZ Map file or Zipped Keyhole Markup Language file (.KMZ):
A KMZ file consists of a main KML file and zero or more supporting files that are packaged using a
Zip utility into one unit, called an archive. The KMZ file can then be stored and emailed as a single
entity. A NetworkLink can fetch a KMZ file from a web server. When the KMZ file is unzipped, the
main .kml file and its supporting files are separated into their original formats and directory structure,
with their original filenames and extensions. In addition to being an archive format, the Zip format is
also compressed, so an archive can include only a single large KML file. Depending on the content
of the KML file, this process typically results in 10:1 compression. Your 10 Kbyte KML file can be
served with a 1 Kbyte KMZ file. For detailed information please see the source of this definition: 
https://developers.google.com/kml/documentation/kmzarchives?hl=en

OpenGIS GML Map file or Geography Markup Language Encoding Standard (.GML):
The OpenGIS® Geography Markup Language Encoding Standard (GML) The Geography Markup
Language (GML) is an XML grammar for expressing geographical features. GML serves as a
modeling language for geographic systems as well as an open interchange format for geographic
transactions on the Internet. As with most XML based grammars, there are two parts to the grammar
– the schema that describes the document and the instance document that contains the actual
data. A GML document is described using a GML Schema. This allows users and developers to
describe generic geographic data sets that contain points, lines and polygons. However, the
developers of GML envision communities working to define community-specific application schemas

mailto:support@digiterra.hu
https://developers.google.com/kml/documentation/
https://developers.google.com/kml/documentation/kmzarchives?hl=en
http://en.wikipedia.org/wiki/GML_Application_Schemas
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that are specialized extensions of GML. Using application schemas, users can refer to roads,
highways, and bridges instead of points, lines and polygons. If everyone in a community agrees to
use the same schemas they can exchange data easily and be sure that a road is still a road when
they view it. Clients and servers with interfaces that implement the OpenGIS® Web Feature Service
Interface Standard read and write GML data. GML is also an ISO standard (ISO 19136:2007). See
also the GML pages on OGC Network: http://www.ogcnetwork.net/gml.

ArcPad Map File (*.APM):
An ArcPad map file, or map, stores a list of the map layers for your ArcPad session. A map lists all
of your feature layers together with their display settings, including the extent of your map, color,
and projection environment.

ArcPad Layer Definition File (*.APL):
Layer definitions are stored in a file associated with a shapefile, with the same filename as the
shapefile but with the extension .apl. Layer definition files provide a way of developing
customizations that are delivered and loaded with data. Layer definition files may also contain
custom symbology exported from ArcGIS Desktop.

Hungarian Digital Base Map (.DAT):
See details about the DAT standard here: http://fish.fomi.hu/termekekhonlap/adathaz/termekek/
szabalyzatok/dat_szabvany.htm, http://www.agt.bme.hu/tantargyak/bsc/bmeeoafasj6/katinfo1.pdf

SQLite 3 Geodatabase file (.DB3):
SQLite version 3 file geodatabase format is able to store complete map projects with all geometry
layers, their attribute tables and code dictionaries in one geodatabase file. The raster sources
currently not yet supported in this format. The vector geometry can be stored in Well-known text
(WKT), Well-known binary (WKB) and DigiTerra DTGeom binary (encrypted, native, rapid) formats.
For detailed information about SQLite version 3 format see http://www.sqlite.org/version3.html.

13.2 Vector layer formats

 = new feature Basic Advanced Professional

Supported native vector layer formats (read & write)

DigiTerra (.MAP)

ESRI Shape (.SHP)

Zipped ESRI Shape (.ZIP)

Mapinfo Interchange (.MIF/MID)

Microstation (.DGN) - up to version 7

AutoDesk (.DXF)

GPS logfile (.LOG)

Coordinates (point) (.CRD)

Coordinates (shape) (.DAT)

Atlas GIS (.BNA)

Triangulated Irregular Network (.TIN)

An overview is available about 3D related features at http://forum.digiterra.hu/
viewtopic.php?f=59&t=310

http://www.opengeospatial.org/standards/wfs
http://www.opengeospatial.org/standards/wfs
http://www.iso.org/iso/iso_catalogue/catalogue_tc/catalogue_detail.htm?csnumber=32554
http://www.ogcnetwork.net/gml
http://fish.fomi.hu/termekekhonlap/adathaz/termekek/szabalyzatok/dat_szabvany.htm
http://fish.fomi.hu/termekekhonlap/adathaz/termekek/szabalyzatok/dat_szabvany.htm
http://www.agt.bme.hu/tantargyak/bsc/bmeeoafasj6/katinfo1.pdf
http://www.sqlite.org/version3.html
http://forum.digiterra.hu/viewtopic.php?f=59&t=310
http://forum.digiterra.hu/viewtopic.php?f=59&t=310
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About the Atlas GIS BNA file format usage you can find a valuable tutorial to
create polygon features from a text file at http://forum.digiterra.hu/viewtopic.php?
f=59&t=300

UNICODE enabled file formats:

ESRI Shape with .CPG file
DigiTerra .MAP format (the Unicode data can be stored in the .TAB format)

Height (Z coordinate values) can be stored in the following file formats:

in DigiTerra Map, ESRI Shape and DXF file format the Height (Z coordinate) can be stored in all
feature type

About the height calculation please have a look at this tutorial at http://
forum.digiterra.hu/viewtopic.php?f=59&t=308

13.3 Raster layer formats

 = new feature Basic Advanced Professional

Supported raster layer formats

JPEG file (.JPG)

JPEG2000 file (.JP2)

Er-Mapper Wavelet (.ECW)

Tagged Image file (.TIF)

DigiTerra Raster (.RAS)

ESRI Raster (.BIL)

ERDAS (.LAN)

Er-Mapper (.ERS)

Portable Nework Graphics (.PNG)

Paintbrush (.PCX)

Compressed ARC Digitized Raster Graphics
(.LF1, .TF1 - CADRG)

Lizardtech MrSID (.SID) - available only in the
desktop version

Windows (.BMP)

The following compression algorithms are supported in the Tagged Image file (.TIF) format: CCITT3
(), PackBits. Supported TIFF tag compressions: 1, 3, 32773
Not supported compression methods (TIFF tag compressions) : CCITT4 (4), LZW (5), JPEG (6, 7),
Deflate (8)

http://forum.digiterra.hu/viewtopic.php?f=59&t=300
http://forum.digiterra.hu/viewtopic.php?f=59&t=300
http://forum.digiterra.hu/viewtopic.php?f=59&t=308
http://forum.digiterra.hu/viewtopic.php?f=59&t=308


440 DigiTerra Explorer Reference Guide

© 2015 DigiTerra Information Services Ltd.

When you open a TIFF raster layer with an unsupported compression method,
the following error message appears on the screen: Attention! Unsupported TIFF
compression: LZW. In some cases you will see only the number of the TIFF tag
compression method. See more information at: http://www.awaresystems.be/
imaging/tiff/tifftags/compression.html

13.4 Text and tabular formats

 = new feature Basic Advanced Professional

Supported text and tabular formats

AGROCOM Agro-Map (point) (.ANL)

AGROCOM Agro-Map (area) (.GRN)

dBase (.DBF)

DigiTerra (.TAB)

Report (.HTML)

CSV files (.CSV)

Text files (.TXT)

Leica Total Station Data file (.MDT)

Text file layer as point feature layer (sample)

ID Easting Northing
1 639176.501 111264.30
2 639227.625 111071.60
3 638935.501 111102.60

13.5 Other file formats

ESRI Map Projection Metadata File (.PRJ): recommended but not mandatory that shapefiles
have associated map projection files in ESRI softwares. DigiTerra Explorer will write this file for
every newly created or exported ESRI shape (.SHP) layer.

ESRI Code Page File (.CPG): associated to ESRI Shape (.DBF) files, that stores the used
character set of the layer's attribute table. In DigiTerra Explorer the created new ESRI Shape file's
code page is ANSI. 

New layer dialog to an ANSI encoded Shapefile

http://www.awaresystems.be/imaging/tiff/tifftags/compression.html
http://www.awaresystems.be/imaging/tiff/tifftags/compression.html
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However DigiTerra Explorer can also handle UTF-8 and UTF-16 (UNICODE) encoding also,
depending on the CPG file's content.

For ArcGIS, Geopublisher and AtlasStyler SLD Editor, just create a .CPG file (with same base
filename (prefix) as all other files included in the Shapefile format cluster) and fill it with the name
of the encoding: ANSI.  e.g. create an ESRI_Shape-Layer_Name.cpg with a text editor like
Notepad and insert 4 characters "ANSI" and save it. If you then open the Shapefile in ArcGIS,
Geopublisher or AtlasStyler, they will read the textual contents of the DBF in that charset.

CPG file's content in Notepad

DigiTerra code dictionary file (.CDT): require for use code sets to the attribute data collection.
The default code dictionary (General.CDT) can be used for newly created mapping projects.

DigiTerra Explorer classes - symbology definition file (.CLS): the symbology definition file
can be exported to each classified vector layer of a map view on the Classes dialog > Menu > with
the Save option. You can import the symbology definition from a .CLS file on the Classes dialog
> Menu > with the Load option when you specify the symbology for a layer in DigiTerra Explorer.
Once you've defined the symbology for a layer, it's easy to reuse that same symbology definition
in any other layers.

Export symbology definition file
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Import symbology definition file

 

Geoid Separation Files

14 Device configuration file

The device configuration file is available only in the Mobile version.

Path:

Mobile version: $SDCARD\BIN\deviceSizeConf.txt
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This file needs to be copied next to the DTExp.exe file. It contains the font size option to the menu,
a multiplier factor to the menu size and the last parameter is responsible to hide or show the SIP
button (keyboard button). It can be applied if the "OEM information" can be found on the device's
operating system. You can check the OEM info on the About panel in
DigiTerra Explorer, under the System information.

//Device name
:OEM_INFO or :"Part of OEM_INFO" within quotation marks
:OS version (optional, Required(!) if "Processor" parameter used)
:Processor (optional)
CHARACTER SIZE (the default is 16)

MENU SIZE MULTIPLIER FACTOR usually it is: 
"1" if the resolution of the screen is 320x240 QVGA and 
"2" if it is a 640x480 VGA display

HIDE SIP BUTTON 
HIDE_SIP=1 - HIDE
HIDE_SIP=0 - SHOW

SHOW DGPS TAB on the Settings panel
DGPS=0 - HIDE
DGPS=1 - SHOW

ENABLE STATIC NAVIGATION
SN=0 - DISABLE
SN=1 - ENABLE

SATELLITE-BASED AUGMENTATION SYSTEMS
SBAS=0 - OFF
SBAS=1 - ON

Example:

//Topcon GRS-1
:Topcon
:5.2.20269
:A5 N1 T2577 L4 R6
16
1
HIDE_SIP=1
DGPS=0
SN=0
SBAS=0

15 Menu and Toolbar definitions

Commands used in menu (.MNU) and toolbar (.TBR) definition files:

Default menu file: Default.mnu

Path:
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Desktop version: $DOCUMENTS\DigiTerra Explorer\Default.mnu

Mobile version: $SDCARD\BIN\Default.mnu

Lines begin with '/', '%', '!', ';' characters are comments.
Lines begin with '#' character creates a new menu
Lines begin with '{' character creates a new submenu, nested sub-menus not supported
Lines begin with '}' character closes the previous submenu
Lines begin with '-' character or 'separator' adds a horizontal line
COMMAND - Adds a fix command or tool
Every line can contain one menu item: tool, command or separator

Default toolbar file: Default.tbr

Path:

Desktop version: $DOCUMENTS\DigiTerra Explorer\Default.tbr

Lines begin with '/', '%', '!', ';' characters are comments.
Lines begin with 'separator' adds a vertical dividing line between commands
COMMAND - Adds a fix command or tool
Every line can contain one menu item: tool, command or separator

Command Description

ABOUT
 About

ADDDBLAYER
 Add db Layer

ADDLAYER
 Add Layer

AREA
 Polygon

AREADIV
 Polygon division

AREAFREE
 Free Polygon

AREAJOIN
 Polygon Join

AREASEP
 Polygon Delineation

BGMAP
 Background Map

BOOK
 Bookmark

BOTANY
 Botany (Extension)

BUFFER
 Buffer zone

CHANGELAYER
 Change Layer

CIRCLE
 Circle

DELETE
 Remove

DICT
 Language

DIVIDE
 Divide

DROPBOX_DOWNLOAD
 Download
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DROPBOX_UPLOAD
 Upload

ELLIPSE
 Ellipse

ERASE
 Erase

EXIT
 Exit

EXPLODE
 Explode

FIELDWORK
 FieldWork

FIND
 Search

GENERALIZE
 Generalize

GPSMEAS
 GPS Survey

GPSPOS
 GPS position

GPSSET
 GPS Status

GPSSTAT
 GPS Statistics

HELP
 Help

INFO
 Identify

INSERT
 Insert

LAYERS
 Layers

LINE
 Line

LINEFREE
 Free Line

LOADDBMAP
 Open db project

LOGGER
 GPS Log analysis

MEAS
 Measure

MEASFREE
 Free measure

MEASRAD
 Radius measure

MERGE
 Merge

MOVE
 Move

NEW
 New Map

NEWDBLAYER
 New db Layer

NEWLAYER
 New Layer

NEWPART
 New part

OPEN
 Open Map

PAN
 Pan
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PLAN
 Plan view

POINT
 Point

PRINT
 Print

PROJECTTRAFO
 Reprojection

RASTRAN
 Raster orientation

RECMAIL
 Receive E-mail

RECORD
 Tables

RECT
 Rectangle

ROTATE
 Rotate

ROTATEOBJ
 Rotate

ROWGUIDE
 GPS Guidance

SAMPLING
 Sampling

SAVE
 Save project

SAVEDBLAYER
 Save db Layer

SAVELAYER
 Save Layer

SAVEDBMAP
 Save db project

SCALE
 Scale

SCALEOBJ
 Scale

SCROLL
 Scroll

SELPOINT
 Select by point

SELLINE
 Select by line

SELAREA
 Select by polygon

SELRECT
 Select by rectangle

SELCIRCLE
 Select circle

SENDMAIL
 Send E-mail

SETTING
 Settings

SURVEY
 Survey

SYNC
 Synchronization

TARGET
 Navigate to Target

TINGENERATE
 Generate TIN

TREESURVEY
 Tree surveying (Extension)
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UNDO
 Undo

VERTEX
 Edit

VIEWREFRESH
 Refresh map view

WEBMAPGE
 Show in Google Maps

WEBMAPBING
 Show in Bing Maps

WINDOW
 Zoom Window

ZOOM
 Dynamic Zoom

ZOOMACT
 Active Layer

ZOOMALL
 Full Extents

ZOOMLAST
 Last View

ZOOMNEXT
 Next View

ZOOMSEL
 Selected Feature

Nesting commands used in menu definition file:

Command Description

Drawing Adds the Drawing sub-menu

Dropbox Adds the Dropbox sub-menu (used in the Mobile version only)

Edit vertex Adds the Edit vertex sub-menu

E-mail Adds the E-mail sub-menu

Help Adds the Help sub-menu (used in the Mobile version only)

Layers Adds the Layers sub-menu

Maps Adds the Projects sub-menu

Select Adds the Select sub-menu

Zoom to Adds the Zoom to sub-menu
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Cable locator tab     338

Cached TMS     65

Cached WMS     65

Cached WMTS     65

Calculate dialog box     435

calculate differences between two projections     435

Calculates the covers between paths in a Field work
GPS Tracklog     223

Camera control command     342

Camera control settings     341

Camera control tab     341

category (A,B,C,R)     258

CDT file     418

Change Layer     91

Change Layer tool     91

Changing the font size in the menu     30

Changing the line type     155
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Child table     423

Circle     132

City scale setting     373

Class dialog box     390

Classes dialog box     383

Classification field     383
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Clear document     429
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Code dictionary     412

Code Dictionary (.CDT) file     418

Code dictionary setting     297

Code editing dialog box     416

code set editor     421

colour palette     378

Colour Palette dialog box     383

colour picker     378

Colour transparency in raster layers     370

Contrast in raster layers     370

control points on the map     228

coordinate display setting     292

Coordinate format     300

Copy     267

Correction Data     328

Country scale setting     373

County scale setting     373

Cover analysis     218

create a new directory     267

Create an attribute table template     411

Create circle     132

Create Crown Map     262

Create ellipse     135

Create freehand line     124

Create freehand polygon     127

Create Layer     68

Create line feature     118

Create new geodatabase layer     74

Create point feature     114

Create polygon feature     121

Create rectangle     130

Create Shadow Map     265

Creating an attribute table template     73

Creating Project template     43

Crosshair     170

Crown definition     259

Crown profile     265

Crown shape     259

CSV export     403

Custom menu     25

Custom menu file     344

Custom Projection dialog box     433

custom snapping tolerance     345

custom symbol file     345

Custom toolbar     25

Custom toolbar file     344

Customization     19, 25

Cut     267

Cutting layer     263

- D -
Data dictionary     412

Data field alias, Alias     405

Data field default value     405

Data field dialog box     405

Data field name     405

Data field statistics     404

Data fields for labelling     375

Data table template     411

Data values     409

Database connection     48, 49

Datat field type     408

Datatable export     403

Date format     299
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Datum parameters     434

Deactivate GPS receiver     211

Default "Label" data field     378

Default attribute table     410

Default label settings     377

Default media path     343

defining an auxiliary coordinate system for surveying  
  231

defining base line for surveying     231

Delete     267

Delete code     422

Delete data field     405

delete layer from geodatabase     74

Delete mark on layer     361

Delete picture's path     429

Delete thematic class     384

Deletes marked layers     356

demo     112

Designate the active layer on the Layers dialgo box    
363

Desktop version     19

device configuration file     442

deviceSizeConf.txt     442

DGNSS     328

DGPS     213, 328

DGPS dialog box     329

DGPS Only     308

DGPS settings     328

DGPS tab     328

DigiTerra Explorer classes files     440

DigiTerra Web Updater     13

Disable Auto Zoom     203

Display     307

Display coordinates     292

display point layer from textfile     364

Display scale of the current class     391

Display scale range for layers     357

display unit     300

Display vertices as labels     377

Distance Intersection     234

District scale setting     373

Divide dialog box     236

Divide tool     236

dividing methods     237

Dividing selected polyline/polygon feature     236

DMP file format     55

Document dialog box     428

Document file     429

Document type field     408

Download     96

dragging     170

Drawing sub-menu     123

Dropbox     98

Dynamic pan     179

Dynamic Zoom     172

- E -
ecompas     231

edit classes     357

Edit code     422

Edit layer     359

Edit menu     113

Edit menu in the Mobile version     114

Edit project name     40

Edit vertex     159

Edit vertices     159

Edited layer     168

Editing a code set     420

Editing context menu     268

Editing the Code Dictionary (.CDT) file in a text editor
    418

EGM2008 geoid Modell     323

Ellipse     135

E-mail sub-menu     106

Empty geodatabase layer     74

Enable/disable SBAS     309

Erase     166

error ellipse     214

ESRI map projection metadata files     440

Evaluation     112

Existing Vertex dialog box     161

Exit     112

Explode     153

Exploding features     153

Exploding multifeature layer     85

ExplorerSystem.txt     110

Export raster     93

Export symbology definition file     441

Export/Save layer as     356

Exporting multifeature layer     85

external antenna     334
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- F -
Feature properties     348

Feature's Fill colour     386

Feature's line colour     385

Field statistics     404

Field work dialog box     221

FieldWork     221

File context menu     267

File dialog box     266

File dialog box in the Mobile version     266

File loading limit     346

File menu     32

fill a polygon by using raster mosaic     388

Fill colour     386

Fill colour palette     386

filltype     388

Filltype dialog box     388

Filter dialog box     394

Fix quality     307

Fix RTK     213

Flip Line     155

Flipping the vertex orderof a selected polyline     155

Floated RTK     213

Font size settings     375

Foreground colour picker     378

Form view     298

Frame and background colour picker     379

Free line     124

Free measure     196

Free polygon     127

Freehand measure     196

Full-Screen mode     291

Fundamentals of database definitions     391

- G -
General steps for defining a code dictionary are    
414

Generalize dialog box     163

generalize the existing geometry     162

Generalize tool     162

Generate TIN     93

geoid separation file     326

geoid undulation     322, 326

Geoids directory     326

Geometry dialog box     396

Geometry distance     342

georeferencing a raster layer     227

Georeferencing data     367

Getting Started     9

GGA sentence     323

GGA string     323

Glonass satellites     211

GNSS Resurveying     398

GNSS solution type     210

Google Maps     61

GPS (GNSS) Status information on the map view    
212

GPS baud rate     308

GPS COM port     308

GPS databits     310

GPS guidance     224

GPS guidance dialog box     225

GPS log     336

GPS Log analysis     216

GPS Log analytics' settings     336

GPS Log analyzer dialog box     216

GPS menu     197

GPS parity     310

GPS port search     308

GPS position loading mode for tracklogs     337

GPS position's display modes     307

GPS quality filters     307

GPS serial port     310

GPS serial port settings     308

GPS Skyplot     209

GPS solution type     210

GPS State     209

GPS State dialog box     209

GPS statistics     214

GPS status information     210

GPS stopbits     310

GPS survey     198

GPS Survey dialog box     199

GPS, GNSS settings     306

GPS, GNSS tab     306

GPS/GNSS solution types on the map view     213

Graphical User Interface     19

Grid.txt path     430

GUI     19
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- H -
HDOP     210

height     334

Height above ellipsoid     322

Height above Mean Sea Level     322

Help     109

Help menu     266

Help menu in the Desktop version     266

Help sub-menu     108

hexadecimal colour code     381

horizontal components of the georeferencing     367

HRMS     213, 214

- I -
Identify     185

Identify option     358

Identify property     358

Identify tool     185

image     342

Image Capture dialog     429

Import symbology definition file     442

Information query property     358

Input panel     40

Insert Point dialog box     117

Insert vertex     157

Installation     10

Installation to desktop computer     12

Installation to mobile devices     10

Instance height     232

interface     19

Internet     328

Introduction     8

Inverse selection     188

- J -
JPEG     342

- L -
L1 Offset     334

Label color     378

Label of the current class     390

Label scale of the current class     391

Label scaling     376

Label tipography     375

Labeling button     357

Labelling     374

Labels dialog box     374

Labels maximum display scale     375

Language     108

Laser rangefinder     231

Last View     178

Layer classification     357

Layer export     356

Layer icons     361

Layer Manager     353

Layer properties     351, 357

Layer Visibility     358

Layers     91

Layers dialog box overview     353

Layer's Name     364

Layers panel     353

Layer's Scale     371

Layer's Source name     364

Layers sub-menu     66

Leica Digicat     339

Length unit     299

license tab     111

license upgrade     16, 111

Licensing     16

Line     118

line colour     385

line colour of a thematic class     385

Line colour palette     385

Line/polyline feature geometry     349

linetype     387

Linetype dialog box     387

Link field     364

link OLE object     429

link OLE object (file) to data field     408

List handling on the Classes dialog box     385

List handling on the Layers dialog box     358

List view     298

Load classes from .CLS file     384

Load classes into .CLS file     384

lock     359

Lock / Edit / Point info menu     360

Locked layer     360



Index 453

© 2015 DigiTerra Information Services Ltd.

Logger tab     336

logging NMEA     336

Look for updates on startup     345

- M -
Main table     422

make a layer editable     168

Map and mapping project formats     436

Map precision     289

Map scale     181

Map settings     289

Map tab     289

Map Template     46

MapSync     98

marked layers for deletion     355

max. PDOP     308

Maximum scale     372

Mean     202

Measure     195

Measure angle     195

Measure area     195

Measure distance     195

Measure position     195

media path     342

media path to Ricoh Caplio 500SE     343

Menu     344

Menu and Toolbar definitions     443

Menu bar     30

menu bar in the Desktop version     32

menu bar in the Mobile version (Windows Mobile)    
31

Merge     151

merged layers     356

Merges marked layers     356

merges vector layers     356

Merging features     151

Merging projects     47

message box     346

MGRS tutorial     207

Minimum scale     372

Mobile Atlas Creator     61

Mobile version     19

Modify sub-menu     138

mosaic     388

mount point     328

move     140

Move/Stand separation in the GPS log     337

multi feature layer     200

Multifeature geometry     151, 153

Multiline feature geometry     350

Multipoint feature geometry     349

Multipolygon feature geometry: island(s) and outer
parts     351

multiselection     186

Multi-stem factor     263

- N -
Name are on the Layers dialog box     362

Navigate by coordinates     206

Navigate to Target     202

Navigate to target by coordinates     206

Navigate to target by MGRS identifier     206

Navigate to target by waypoints     205

Network     328

New db Layer     74

New Layer     67, 68

New Layer button on the Layers dialog box     355

New layer dialog box     70

New part     149

New project     34

New record     298

New template fiel dialog box     72

New vertex dialog box     164

New work layer dialog box     168

Next view     178

Night colour of the map view     296

NMEA     211

NMEA GGA     323

NMEA log     336

No panel     298

Not unlockable layer     360

NTRIP     328, 331

NTRIP broadcaster settings     330

NTRIP Serial COM port     332

NTRIP Serial COM port baudrate     332

NTRIP Serial COM port databits     332

NTRIP Serial COM port parity     332

NTRIP Serial COM port stopbits     332

NTRIP serial port settings     331

Number of Stems     263
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Numeric colour settings     381

Numerical code set     418

- O -
Offline data sources     65

Offset values dialog box     142

Offsetting GPS positions     201

OLE file     429

Online data sources     62

Online updater     13

Open captured picture to data field     429

Open db project     48

Open document     429

Open FieldWork panel on startup     345

Open Map     47

Open project     34, 47

Opening the Code editing dialog box     415

Operating system     9

Other file formats     440

Overlay analysis     218

Overview     8

Overview of the Layers dialog box     353

- P -
Palette for thematic classes     383

Pan     179

Pan frame     294

Pan, Panning     179

Parent table     422

Password protected project     55

PDOP     210

Pen tolerance     345

Plan view     180

Point     114

Point feature geometry     348

point info     359

Point info layer     360

Polar survey     232

Polar survey from start point     235

Polygon     121

Polygon Delineation tool     248

polygon dividing methods     246

Polygon division dialog box     246

Polygon edge size (m)     337

Polygon feature geometry     350

Polygon Join tool     250

Postprocessing base distance     312

PP base distance     312

PPS Only     308

Previously used templates     71

Print Area Report dialog box     283

Print Area report through Metafile     280, 286

Print area reports     282

Print Label     273

Print legend     273

Print map     107

Print Map dialog box     272

Print Point report dialog box     278

Print point reports     277

Print Report     274

Print Report dialog box     275

Print Setup dialog box     270

Print through Metafile     274

Print Title     273

printable area     272

Printing     270

Printing attributes     274

Printing maps     272

Printing scale     272

Printing the current map view     270

Product ID     16

Program execution log     345

Project template     34

Project templates     43

Projection     307

Projection parameters     434

Projection parameters file     430

projection type     433

Projections and Datums     430

Projects sub-menu     46

Proximity analysis     218

Proximity threshold (m)     337

- Q -
Quality settings     307

Queried map with displayed attributes on the map
view     185

Query menu     184

Quick Measure     34
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- R -
Radio Detection RD8000     339

Radius measure     197

Radius measure, Measure by radius     197

rangefinder debug     338

Rangefinder settings     337

Rangefinder tab     337

raster export     93

Raster information     368

Raster layer formats     439

Raster layer properties     366

Raster layer's name     367

Raster layer's source name     367

Raster orientation     227

Raster Print     274

Raster Print (Area Report)     280, 286

Raster Print Resolution (DPI)     274

Raster Print Resolution (DPI) (Area Report)     280,
286

Raster smoothing     294

raster symbol     386

raster transformation     227

Rasterization     93

RAW file (MMCE, MMCX, MM6)     308

Receive E-mail     107

Recent Project templates     34

Recent Projects     34

Recent Projects sub-menu in the Desktop version    
60

Recommended hardware     9

Record dialog box     195, 392

Record dialog box: menu     393

Record panel     195

Record settings     297

Record tab     297

Rectangle     130

Rectangular survey     232

Reference scale of the layer's label text and symbols
    374

Refresh map view     183

Registration     16

Related tables     422

Relation to Geoid Undulation     324

Remember printing mode     274, 281, 286

Remove vertex, delete vertex     158

Removes marked layers     356

Rename     267

Report option in the Menu     275

required components for DropBox     102

Required software components     9

re-rendering     183

RGB transparency examples for raster layers     370

RMS     214

Root area     262

Root definition     262

Rotate     143, 179

Rotate and tilt the map view     179

Rotation angle dialog box     145

RTCM output     331

RTK Fixed Only     308

RTK Float or Fixed     308

- S -
Sampling dialog box     242

sampling methods     242

Sampling tool     238

Sampling wizard     239

Save as     84

Save as DMP     55

Save db project     58

Save dialog box     55

Save geodatabase project     58

Save Map     53

Save Map Pack     55

Save project     53

Save system information     110

Save World file     367

Saving Position Statistics     216

SBAS     328

SBAS satellites     211

Scale     146

Scale dialog box     371

Scaling factor dialog box     148

Scaling selected feature     146

Scoll     179

Scroll     179

Search     194

Search tool     194

Seba vLocPro2     339
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Select all features     188

Select by circle     193

Select by coordinates     189

Select by GPS     189

Select by line     190

Select by point     189

Select by polygon     191

Select by rectangle     192

Select features by circle     193

Select features by layer     188

Select features by line     190

Select features by point     189

Select features by polygon     191

Select features by rectangle     192

Select Mountpoint     331

Select NTRIP Network     331

Select NTRIP Stream     331

Select OLE document     429

Select projection     307

Select Projection dialog box     430

Select Stream     331

Select sub-menu     186

select symbol     386

Select template     71

Selected active layer     363

Selection settings dialog box     187

Selectiong the active layer     363

Send E-mail     107

separation character     403

Set classes     384

set layer's scale     371

set link field     364

set relation data field     364

Set scale     181

Set scale to layer     357

Set Tree view for data collection in related tables    
426

Settings     287

Shadow calculation     264

Show always     372

Show attached picture icon on the map     343

Show in Bing Maps     182

Show in Google Maps     182

Signal/Noise ratio     211

simplifying the geometry     162

Skyplot     209, 211

Snap to edge     373

Snap to vertex     373

Snapping     345, 373

SNR     211

Software registration     16

Software update     13

Sort dialog box     395

Sorting layers by layer type     361

Sorting layers by name     362

Source dialog box to raster layer     366

Source table     331

Spatial analysis with the overlay layer     337

Spatial bookmark     177

Speed dependent scale     294

Speed limit (km/hour)     337

Speed unit     299

Splitting Polyline     162, 164, 165

SSF file (for Trimble receivers only)     313

Staking out points     202

Start Digital Camera     429

Startup options     23, 34

Static Navigation On/Off for Sirf GPS receiver     309

Stem diameter     262

Storing 3D coordinates     71

Storing 3D coordinates in an existing layer     365

Supported data formats     436

Survey dialog box     231

Survey tool     230

Symbol dialog     386

Symbol dialog box     386

Symbol palette     386

Symbols file     345

Symbols maximum display scale     375

Symbols.bmp     345

Synchronization     96

system info     109

System requirements     9

System settings     344

System tab     344

- T -
Tables     195

take a picture     429

taking picture     342

Target dialog box     206
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Text and tabular formats     440

Textual code set     419

Texture     388

Texture selection context menu     388

The Source dialog box     364

Thematic classes on the Classes dialog box     381

Thematic classes on the map view     382

Thematic classification     381

tileset generation     93

Time interval (±sec)     337

TMS     62

Toolbar     30

Tools menu     225

Tracklog     217, 336

Transparency     365

Transparency in raster layers     370

Tree height     265

tree quality assestment     258

Tree surveying     253

tree surveying extension     252

tree surveying module     252

Tree view     298

Tree view mode     427

Trial versio     112

Trimble Antenna settings     319

Trimble General GPS settings     313

Trimble GPS settings tab     310

Trimble GPS Status     320

Trimble Realtime settings     313

Trunk height     265

try out     112

Type of geometry     70

- U -
Undo     167

UNICODE     70

UNICODE enabled file formats     439

Units     298

update     109

Update DigiTerra Explorer online     110

Upload     96

Use attribute table template     71

User Interface     19

Using customized toolbar file in the Desktop version  
  344

Using Project template     43

UTF-8     70

- V -
Value of the current class     390

VDOP     210

Vector information     365

Vector layer formats     438

Vector layer properties     363

vector layer's transparency     365

Vector Print     274

Vector Print (Area Report)     280, 286

vector symbol     386

vertex ordinal number and length between vertices    
377

vertical components of the georeferencing     367

View menu     170

View scale     181

VRMS     213, 214

- W -
WMS     62

WMTS     62

workspace     19

Workspace customization     25

World file     367

- X -
X position field     364

- Y -
Y position field     365

- Z -
Zoom extents     175

Zoom to Active Layer     175

Zoom to extents     175

Zoom to Full Extents     175

Zoom to GNSS position     173

Zoom to GPS position     173

Zoom to Selected Feature     176
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Zoom to sub-menu     174

Zoom to the active layer     175

Zoom to the selected feature     176

Zoom Window     172
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